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About This Manual
This manual describes the Xilinx/Synopsys Interface (XSI) program,
a tool used for implementing Field Programmable Gate Array
(FPGA) designs using either Synopsys FPGA Compiler, FPGA
Compiler II, or the Design Compiler synthesis tools.
This manual does not cover use of Synopsys FPGA Express with the
XSI program.
Before using this manual, you should be familiar with the operations
that are common to all Xilinx software tools: how to bring up the
system, select a tool for use, specify operations, and manage design
data. These topics are covered in the Development System Reference
Guide. Other publications you can consult for related information are
the LogiBLOX Reference/User Guide, and Libraries Guide.

Additional Resources
For additional information, go to http://support.xilinx.com. The
following table lists some of the resources you can access from this
page. You can also directly access some of these resources using the
provided URLs.
Resource

Description/URL

Tutorial

Tutorials covering Xilinx design flows, from design entry to verification
and debugging
http://support.xilinx.com/support/techsup/tutorials/index.htm

Answers
Database

Current listing of solution records for the Xilinx software tools
Search this database using the search function at
http://support.xilinx.com/support/searchtd.htm

Application
Notes

Descriptions of device-specific design techniques and approaches
http://support.xilinx.com/apps/appsweb.htm
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Resource

Description/URL

Data Book

Pages from The Programmable Logic Data Book, which describe devicespecific information on Xilinx device characteristics, including readback, boundary scan, configuration, length count, and debugging
http://support.xilinx.com/partinfo/databook.htm

Xcell Journals

Quarterly journals for Xilinx programmable logic users
http://support.xilinx.com/xcell/xcell.htm

Tech Tips

Latest news, design tips, and patch information on the Xilinx design
environment
http://support.xilinx.com/support/techsup/journals/index.htm
The Synopsys documentation set also provides vital information for
using the XSI program.

Manual Contents
This manual covers the following topics.

ii

•

Chapter 1, Introduction to the Xilinx/Synopsys Interface,
provides information on the XSI Design Flow, FPGA Compiler,
FPGA Compiler II, and Design Compiler. This chapter also
includes a list of additional documentation.

•

Chapter 2, Getting Started, shows you how to verify your software installation, modify your Synopsys startup file, and run
Synlibs to set the link and target libraries.

•

Chapter 3, Synthesizing Your Design, includes design information on wire-load models, IOB configuration, clock buffers,
memory, boundary scan, the Global Set/Reset net, the Xilinx
DesignWare library, timing specifications, compiling, area
reports, debugging, implementing, and saving your designs.

•

Chapter 4, Using Core Generator and LogiBLOX, provides information about using Core Generator and LogiBLOX to create
high-level modules for your designs.

•

Chapter 5, Simulating Your Design, describes how to perform
RTL and timing simulation.

•

Chapter 6, Using Files, Programs, and Libraries, describes the
files, programs, and Xilinx-supplied libraries you need to translate your HDL design using FPGA Compiler or Design Compiler.
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•

Appendix A, XSI Library Primitives lists the primitives you can
synthesize or instantiate in a VHDL or Verilog HDL file.

•

Appendix B, Targeting Virtex Devices, describes how to apply the
XSI design flow to Virtex devices.
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Conventions
This manual uses the following typographical and online document
conventions. An example illustrates each typographical convention.

Typographical
The following conventions are used for all documents.
•

Courier font indicates messages, prompts, and program files
that the system displays.
speed grade: -100

•

Courier bold indicates literal commands that you enter in a
syntactical statement. However, braces “{ }” in Courier bold are
not literal and square brackets “[ ]” in Courier bold are literal
only in the case of bus specifications, such as bus [7:0].
rpt_del_net=
Courier bold also indicates commands that you select from a
menu.
File → Open

•

Italic font denotes the following items.
•

Variables in a syntax statement for which you must supply
values
edif2ngd design_name

•

References to other manuals
See the Development System Reference Guide for more information.
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•

Emphasis in text
If a wire is drawn so that it overlaps the pin of a symbol, the
two nets are not connected.

•

Square brackets “[ ]” indicate an optional entry or parameter.
However, in bus specifications, such as bus [7:0], they are
required.
edif2ngd [option_name] design_name

•

Braces “{ }” enclose a list of items from which you must choose
one or more.
lowpwr ={on|off}

•

A vertical bar “|” separates items in a list of choices.
lowpwr ={on|off}

•

A vertical ellipsis indicates repetitive material that has been
omitted.
IOB #1: Name = QOUT’
IOB #2: Name = CLKIN’
.
.
.

•

A horizontal ellipsis “. . .” indicates that an item can be repeated
one or more times.
allow block block_name loc1 loc2 ... locn;

Online Document
The following conventions are used for online documents.

vi

•

Red-underlined text indicates an interbook link, which is a crossreference to another book. Click the red-underlined text to open
the specified cross-reference.

•

Blue-underlined text indicates an intrabook link, which is a crossreference within a book. Click the blue-underlined text to open
the specified cross-reference.
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Chapter 1

Introduction to the Xilinx/Synopsys Interface
This chapter describes the Xilinx/Synopsys Interface (XSI), compares
FPGA Compiler, FPGA Compiler II , and Design Compiler, and lists
additional Xilinx and Synopsys documentation you can use in
conjunction with this manual. This chapter includes the following
sections.
•

“What Is XSI?”

•

“XSI Design Flow”

•

“Comparing Design Compiler and FPGA Compiler”

•

“Using FPGA Compiler II”

•

“Xilinx Documentation Set”

What Is XSI?
XSI supports Synopsys FPGA Compiler Version 98.08 or later, FPGA
Compiler II Version 3.2 or later, and Synopsys Design Compiler
Version 98.08 or later.
This manual does not cover the use of Synopsys FPGA Express.
Use the XSI design tool kit to implement Xilinx Field Programmable
Gate Array (FPGA) designs using either Synopsys FPGA Compiler or
Design Compiler. These Synopsys High-Level Design Automation
(HLDA) tools allow you to create and optimize circuit designs from
hardware descriptions written in VHSIC Hardware Description
Language (VHDL) or Verilog HDL. Library support for XC4000E/L/
EX/XL/XLA/XV and XC5200 devices includes a Xilinx DesignWare
(XDW) library.
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Before you start creating your FPGA designs, refer to the most
current version of the Alliance Series 2.1i Quick Start Guide for information about the following topics.
•

XSI installation instructions

•

Tutorial on the M1 tools

•

Reference information on common instantiated components

•

M1 constraints guide

For the latest information on Xilinx parts and software, visit the
Xilinx Web site at http://www.xilinx.com.

XSI Design Flow
The “XSI Design Flow” figure illustrates the following required steps
you follow to implement and simulate your HDL designs.
Refer to the XSI Synopsys tutorials at http://support.xilinx.com/
support/techsup/tutorials/index.htm for step-by-step instructions
on converting your HDL designs.

1-2

1.

Use the Synlibs program to determine the appropriate libraries
for your design.

2.

Synthesize your design with either FPGA Compiler or Design
Compiler.

3.

Save your design as an SXNF file or an EDIF file, along with a DC
file that contains Synopsys constraints. Make sure you use the
.sxnf file extension for FPGA Compiler designs and the .sedif file
extension for Design Compiler designs.

4.

Use the DC2NCF program to translate the Synopsys constraints
DC file to a Netlist Constraints File (NCF).

5.

Run NGDBuild on the SXNF or EDIF file to create an NGD file.

6.

Run the MAP program on the NGD file to create a mapped NCD
file.

7.

Run the TRACE program to determine if PAR meets your timing
goals.

8.

Run PAR on the NCD file to place and route your design.
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9.

Run TRACE again on your placed and routed design.

10. Run NGDAnno on your routed NCD and NGM files to create an
NGA file.
11. Run either NGD2VHDL or NGD2VER on the NGA file to create a
VHDL (VHD) or Verilog (V) file for simulation with the appropriate simulators for back annotation. These two programs also
create a Standard Delay Format (SDF) file containing timing
information.
12. Run the BitGen program to create a bitstream for programming
the FPGA.
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SYNLIBS

SYNLIBS

DC Script

FPGAC Script

XFPGA
XDW

XDC
XDW
Source HDL

Synopsys Setup

Synopsys Setup

FPGA Compiler II

Design Compiler

FPGA Compiler

.edif

.sxnf

.dc

.xnf

.edif

DC2NCF

From base PM
(For Design Compiler
designs only)

.ncf
XDC.NGL
From target arch. PM
NGDBUILD
XPRIM.NGL

.ucf

From other PMs

.ngc

NGL’s
.ngd

MAP

.ngm

.ncd

.pcf
NGDANNO

TRACE

PAR

NGD2VER

NGD2VHDL

.ncd

.v

.vhd

BITGEN
TRACE
.bit
NGDANNO
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NGD2VHDL
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To VHDL Simulators

NGD2VER
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.v

To Verilog Simulators

X8563

Figure 1-1 XSI Design Flow
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Comparing Design Compiler and FPGA Compiler
XSI contains libraries for XC3000A, XC3000L, XC3100A, XC3100L,
XC4000E, XC4000L, XC4000EX, XC4000XL, XC4000XLA, XC4000XV,
and XC5200 FPGAs. You can use either FPGA Compiler or Design
Compiler to synthesize a design for these devices. Generally, for
XC4000L and XC4000XL devices, you can use the XC4000E and the
XC4000EX synthesis libraries, respectively.
This manual assumes that you use FPGA Compiler synthesis tools for
XC4000E/L/EX/XL/XLA/XV and XC5200 devices. If you do not
have FPGA Compiler, XSI provides XC4000E/L/EX/XL/XLA/XV
and XC5200 libraries for use with Design Compiler. You can use
FPGA Compiler for XC3000 and XC3100 devices, but the libraries for
these devices use the Design Compiler synthesis features.
Design Compiler offers the following features.
•

Optimizes flip-flops without clock enables, and latches in the
input/output block (IOB)

•

Optimizes 3-state buffers in the IOB

•

Encodes one-hot state machines

•

Automatically uses the configurable logic block (CLB) Clock
Enable pin

FPGA Compiler offers the previously described Design Compiler
features, as well as the following.
•

Optimizes logic to the XC4000E/L/EX/XL/XLA/XV CLB and
IOB architectures

•

Reports area and timing by device architecture, for example,
CLB, IOB, and 3-state buffer

•

Passes timing constraints to the core tools

•

Uses lookup table (LUT) optimization for XC3000A/L,
XC3100A/L, and XC5200 devices. These new libraries that use
the LUT optimization allow FPGA Compiler to synthesize your
design to a collection of lookup tables, registers, and I/O pads.
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Using FPGA Compiler II
FPGA Compiler II, a logic-synthesis and optimization tool, allows
you to create optimized netlists from VHDL, Verilog, and existing
unoptimized FPGA netlists. FPGA Compiler II (Version 3.2 or better)
offers the following features.
•

Provides an integrated text editor for entering VHDL and Verilog
source code for your design

•

Analyzes HDL source files for correct syntax, accepting any
combination of VHDL, Verilog, and FPGA netlist files as sources

•

Synthesizes logic from VHDL, Verilog, and FPGA netlist sources

•

Optimizes logic for speed and area according to design
constraints

•

Contains integrated schematic viewing and static timing analysis

•

Extracts and displays accurate post-synthesis delay information

Synopsys provides FPGA Compiler II libraries used for Xilinx products.

Xilinx Documentation Set
The following documents provide additional design information.
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•

CPLD Synthesis Design Guide contains information on how to use
your Synopsys tools with the Xilinx Development System to
create CPLD designs.

•

Development System User Guide contains an overview of Xilinx
software, including general design implementation flows and
configuration hints.

•

Development System Reference Guide provides detailed information
on the programs found in Xilinx software.

•

LogiBLOX Reference/User Guide describes the LogiBLOX program,
a tool used to create high-level modules for insertion into your
HDL design.

•

Libraries Guide presents information about the various Xilinxprovided primitives and macros.

Xilinx Development System

Chapter 2

Getting Started
This chapter describes how to verify your software installation,
modify the .synopsys_dc.setup file, and use the Synlibs program to
determine the correct XSI libraries for FPGA Compiler, FPGA
Compiler II, or Design Compiler.
Read this chapter before you begin either the FPGA Compiler or
Design Compiler tutorials located at http://
www.support.xilinx.com/support/techsup/tutorials/index.htm.
This chapter includes the following sections.
•

“Verifying Software Installation”

•

“Modifying the Default Synopsys Startup File”

Verifying Software Installation
Use the following steps to verify installation of Xilinx, XSI, and
DesignWare software on your system, and to ensure your .cshrc or
.login files include the required environmental variables and search
paths.
Xilinx supports Synopsys v1998.08 and later, and Synopsys FPGA
Compiler II version 3.2 or later. These instructions verify the installation of Synopsys v 1998.08 or later.
1.

Go to the platform where the Xilinx software is installed.

2.

To verify that your system has the Xilinx software, enter the
following.
which par
The full path for PAR appears. If the system cannot find PAR,
refer to the installation instructions in the release notes or contact
your system administrator.
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3.

To verify XSI installation, enter the following.
which synlibs
The full path for XSI appears. If the system cannot find Synlibs,
refer to the installation instructions in the release notes or contact
your system administrator.

4.

Enter the following to change to the correct directory.
cd $XILINX/synopsys/libraries/dw/lib/architecture

5.

List the contents of this directory to verify that installation placed
the source Xilinx DesignWare files in this directory.
This directory contains the object file for the Xilinx DesignWare
symbol modules (xdw_module.syn) and the simulation modules
(xdw_module.sim). The variable xdw_module refers to the Xilinx
DesignWare primitive name.
If you do not find the SYN and SIM files in this directory, refer to
the release notes or contact your system administrator. The
README file contains installation instructions, and resides in the
$XILINX/synopsys/libraries/dw/src/architecture directory.

6.

To verify that you are using Synopsys v1998.08 or later, enter the
following.
design_analyzer
This command starts Design Analyzer and displays the version
number on your screen.

Modifying the Default Synopsys Startup File
The startup file for the Synopsys synthesis tools is
.synopsys_dc.setup. This file contains the search path for the XSI
libraries, Synopsys libraries, and user libraries. XSI provides a
template Synopsys startup file.
XSI provides the template.synopsys_dc.setup_dc and
template.synopsys_dc.setup_fc template files. You can find the
template files in the $XILINX/synopsys/examples directory. Use
template.synopsys_dc.setup_dc if you use Design Compiler; use
template.synopsys_dc.setup_fc if you use FPGA Compiler.
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$SYNOPSYS is the directory where the Synopsys software resides. If
you do not know the location of this directory, enter the following at
the system prompt.
echo $SYNOPSYS

If you already have a .synopsys_dc.setup file, you must modify your
file to include the commands found in the Xilinx-supplied template
startup files.
If you do not already have a Synopsys startup file, copy the appropriate Xilinx-supplied startup file to your home or working directory
and rename it as follows.
cp $XILINX/synopsys/examples/
template.synopsys_dc.setup_compiler .synopsys_dc.setup

Substitute “dc” or “fc” for compiler.

Checking the FPGA Compiler Setup File
This section contains a reproduction of the template setup file for
FPGA Compiler.
/* =================================================================== */
/* Template .synopsys_dc.setup file for Xilinx designs

*/

/*

*/

For use with Synopsys FPGA Compiler.

/* =================================================================== */
/* =================================================================== */
/* The Synopsys search path should be set to point

*/

/* to the directories that contain the various

*/

/* synthesis libraries used by FPGA Compiler during

*/

/* synthesis.

*/

/* =================================================================== */
XilinxInstall = get_unix_variable(XILINX);
SynopsysInstall = get_unix_variable(SYNOPSYS);

search_path = { . \
XilinxInstall + /synopsys/libraries/syn \
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SynopsysInstall + /libraries/syn }
/* !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! */
/* Ensure that your UNIX environment */
/* includes the two environment var- */
/* iables: $XILINX (points to the

*/

/* Xilinx installation directory) and*/
/* $SYNOPSYS (points to the Synopsys */
/* installation directory.)

*/

/* !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! */
/* ================================================= */
/* Define a work library in the current project dir

*/

/* to hold temporary files and keep the project area */
/* uncluttered. Note: You must create a subdirectory */
/* in your project directory called WORK.

*/

/* ================================================= */
define_design_lib WORK -path ./WORK
/* ================================================= */
/* General configuration settings.

*/

/* ================================================= */
compile_fix_multiple_port_nets = true

xnfout_constraints_per_endpoint = 0
xnfout_library_version = "2.0.0"

bus_naming_style = "%s<%d>"
bus_dimension_separator_style = "><"
bus_inference_style = "%s<%d>"
/* ================================================= */
/* Set the link, target and synthetic library

*/

/* variables. Use synlibs (with the -fc switch) to

*/
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/* determine the link and target library settings.

*/

/* You may like to copy this file to your project

*/

/* directory, rename it ".synopsys_dc.setup" and

*/

/* append the output of synlibs. For example:

*/

/*

*/

synlibs -fc 4028ex-3 >> .synopsys_dc.setup

/* ================================================= */

Checking the Design Compiler Setup File
This section shows the template setup file for Design Compiler.
/* =================================================================== */
/* Template .synopsys_dc.setup file for Xilinx designs

*/

/*

*/

For use with Synopsys Design Compiler.

/* =================================================================== */
/* =================================================================== */
/* The Synopsys search path should be set to point

*/

/* to the directories that contain the various

*/

/* synthesis libraries used by Design Compiler during

*/

/* synthesis.

*/

/* =================================================================== */
XilinxInstall = get_unix_variable(XILINX);
SynopsysInstall = get_unix_variable(SYNOPSYS);

search_path = { . \
XilinxInstall + /synopsys/libraries/syn \
SynopsysInstall + /libraries/syn }
/* !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! */
/* Ensure that your UNIX environment */
/* includes the two environment var- */
/* iables: $XILINX (points to the

*/

/* Xilinx installation directory) and*/

Xilinx/Synopsys Interface Guide — 2.1i

2-5

Xilinx/Synopsys Interface Guide
/* $SYNOPSYS (points to the Synopsys */
/* installation directory.)

*/

/* !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! */
/* ================================================= */
/* Define a work library in the current project dir

*/

/* to hold temporary files and keep the project area */
/* uncluttered. Note: You must create a subdirectory */
/* in your project directory called WORK.

*/

/* ================================================= */
define_design_lib WORK -path ./WORK
/* ================================================= */
/* General configuration settings.

*/

/* ================================================= */
compile_fix_multiple_port_nets = true

bus_naming_style = "%s<%d>"
bus_dimension_separator_style = "><"
bus_inference_style = "%s<%d>"

edifout_netlist_only = true
edifout_power_and_ground_representation = cell
edifout_write_properties_list = "instance_number pad_location part"
edifout_no_array = true
/* ================================================= */
/* Set the link, target and synthetic library

*/

/* variables. Use synlibs (with the -dc switch) to

*/

/* determine the link and target library settings.

*/

/* You may like to copy this file to your project

*/

/* directory, rename it ".synopsys_dc.setup" and

*/

/* append the output of synlibs. For example:

*/
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/*

synlibs -dc 4028ex-3 >> .synopsys_dc.setup

*/

/* ================================================= */
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Chapter 3

Synthesizing Your Design
Synthesize and implement your HDL designs for Xilinx FPGA
devices with either FPGA Compiler or Design Compiler by using the
information in the following sections.
•

“Before You Begin”

•

“Setting the Wire-Load Model”

•

“Setting the Operating Condition Parameters”

•

“Porting Code from FPGA Compiler to FPGA Compiler II”

•

“Configuring IOBs”

•

“Inserting Clock Buffers”

•

“Using Memory”

•

“Performing Boundary Scans”

•

“Using the Global Set/Reset Net”

•

“Using the Xilinx DesignWare Library”

•

“Creating Timing Specifications”

•

“Compiling Your Design”

•

“Creating the Area Report”

•

“Evaluating Timing Delays”

•

“Generating Reports for Debugging”

•

“Writing and Saving Your Design”

•

“Using the Xilinx Development System”
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Before You Begin
Before beginning a Xilinx design using the Synopsys tools, read the
“Getting Started” chapter and ensure the following.
•

Verify the installation of XSI and Xilinx software on your system.

•

Modify the Xilinx-provided default Synopsys startup file, if
applicable.

•

Verify that you use Synopsys version 1998.08 or later for FPGA
Compiler and Design Compiler, and version 3.2 for FPGA
Compiler II.

Xilinx does not support the following library cells in the Spartan
design flow because they do not exist in the Spartan architecture.
•

RAM16X1

•

RAM32X1

•

DECODEx

•

WANDx

•

WOR2AND

•

MD0

•

MD1

•

MD2

Setting the Wire-Load Model
Each primitive library contains device and speed-grade specific estimated pre-layout and routing wire-load models. The Synopsys tools
can use these estimates when optimizing your design for an FPGA.
XSI provides two wire-load models per device-speed grade combination, an average model and a worst-case model. These models receive
“_avg” and “_wc” designations, respectively; the default is average.
Using the default (average) wire loads produces more realistic
designs.
To change a wire load model, use the following syntax.
set_wire_load “parttype –s.wc”

Substitute the part type to change for parttype.
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Run Synlibs with the –h option to get a listing of all available part
type and speed grade combinations. You can also refer to the Xilinx
online Data Book at http://www.xilinx.com/support for current
speed grade information.

Setting the Operating Condition Parameters
You need only one set of operating condition parameters, the worstcase commercial (WCCOM) parameter. This set of parameters is the
default in the Xilinx libraries.

Porting Code from FPGA Compiler to FPGA
Compiler II
You can port a design from FPGA Compiler or Design Compiler to
FPGA Compiler II. You do not have to modify the code if compiling a
100 percent behavioral design originally compiled with FPGA
Compiler or Design Compiler. However, if you instantiated components from the XSI libraries understand that some of these components do not exist in the FPGA Compiler II libraries.
Some of the components you can instantiate in the Xilinx design flow
you cannot instantiate in the FPGA Compiler II tool because of slight
differences in names. For example, the BUFGP_F in the XSI component library does not exist in the FPGA Compiler II component
library. In FPGA Compiler II, the equivalent name of the BUFGP_F is
BUFGP. For a complete listing of the library cells that can be instantiated in FPGA Compiler II, refer to the contents of the following.
fpgacompilerII/lib/xc3000
fpgacompilerII/lib/xc4000e
fpgacompilerII/libxc5200

The fpgacompilerII directory is where FPGA Compiler II resides on
your system. These directories contain files with a .dsn extension. The
string in front of .dsn is the name of the CELL that you can instantiate
in FPGA Compiler.
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In general, instantiation is not necessary. For the XC4000EX/XL/
XLA/XV FPGA Compiler II flow, you must instantiate the following
components.
•

I/O muxes

•

Fast capture latches

•

RAM

•

BSCAN

•

LogiBLOX

Configuring IOBs
This section describes how to configure FPGA IOBs. You must implement some features manually, but FPGA Compiler performs the
following optimization functions automatically.
•

Inserts input buffers (IBUF) and output buffers (OBUF)

•

Inserts IBUFs and 3-state output buffers (OBUFT) for bidirectional I/O (IOBUF)

•

Inserts a clock buffer for ports driving clock pins (BUFG)

Note: The following functions apply only to FPGAs with I/O flipflops.
•

Optimizes a flip-flop (IFD) without a clock enable, or latch
(ILD_1) attached to input buffers into the IOB

•

Optimizes a flip-flop without a clock enable attached to output
buffers into the IOB (OFD)

Indicate which ports in your design to use for chip-level I/Os with
the Set Port Is Pad command. The Insert Pads command adds the
correct buffers to the ports declared as pads, as shown in the
following example.
set_port_is_pad “*”
insert_pads
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All Architectures
This section includes general information about IOBs that applies to
all supported device architectures.

Optimizing Inputs
FPGA Compiler optimizes any flip-flops connected to an input port
into the IOB if the flip-flop or latch does not use the Clock Enable,
Direct Clear, or Preset pin.
You can configure the buffered input signal that drives the data input
of a storage element as either a flip-flop or a latch. You can use the
buffered signal in conjunction with the input flip-flop or latch.
A delay buffer added to the signal feeding the data input of the input
flip-flop/latch avoids a possible hold time violation. Instantiating a
flip-flop or latch, such as an IFD_F or ILD_1F, removes this delay
because these cells include a NODELAY attribute. Refer to the “XSI
Library Primitives” appendix for a complete list of primitives that
include NODELAY attributes.

Optimizing Outputs
FPGA Compiler has the ability to optimize flip-flops attached to
output pad in the IOB. However, FPGA Compiler cannot optimize
flip-flops in an IOB configured as a bidirectional pad.

Understanding and Using Slew Rate
The output buffers have a default slow slew rate that alleviates
ground-bounce problems and the option of a fast slew rate that
reduces the output delay. The SLOW option increases the transition
time and reduces the noise level. The FAST option decreases the transition time and increases the noise level.
Warning: Synopsys and Xilinx define slew rate using opposite terms.
Synopsys uses slew control, whereas Xilinx uses slew rate. For example,
the Synopsys HIGH slew control is equivalent to the Xilinx SLOW
slew rate.
The XSI libraries contain two types of output buffers. The default
output buffer has a slow slew rate. An additional output buffer with a
fast slew rate has a FAST attribute assigned to it, OBUF_F (output
buffer) and OBUFT_F (3-state output buffer), also in the XSI libraries.
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To avoid possible ground-bounce problems, use the default SLOW as
the slew rate. Assign a FAST slew rate only to output buffers that
require additional speed.
Note: FPGA Compiler V3.3 and later versions use a default slew rate
of slow.
To change any output port to a FAST slew rate, use the following
command. Replace port with the name of the output port.
set_pad_type –slewrate NONE {port}

Set this command before implementing the Insert Pads commands.
Table 3-1
Xilinx Slew
Rate

XC4000E/EX/XV Slew Rate Settings

Synopsys Slew
Control Attribute

FPGA Compiler Command

SLOW

HIGH

set_pad_type –slewrate HIGH {port}

FAST

NONE

set_pad_type –slewrate NONE {port}

XC3000A/L and XC3100A/L IOBs
This section describes XC3000A/L and XC3100A/L IOBs.

Using Input Blocks
Select input thresholds globally with TTL/CMOS. Internal pull-up
resistors can optionally attach to the I/O pad. You can make inputs
registered or latched. You can select register and latch setup time.
In the default configuration, the input register or latch has positive
setup and negative hold time (when used in conjunction with a
global clock network). Reducing input setup time produces a small
positive hold time.
Registered and latched inputs become available simultaneously with
direct input. You have no clock or latch-enable or asynchronous set/
reset control on input registers and latches, but you can control the
initial state of input registers and latches.
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Using Output Blocks
You can select the output driver slew rate. The output driver by
default uses a slow slew rate setting to reduce system noise and
power. A faster slew rate decreases chip-to-out propagation delay.
You can make outputs tristate and you can register them.
You cannot apply clock-enable or asynchronous set/reset control on
output registers but you can control the initial state of output registers.

Using Bidirectional Mode
You cannot use internal pull-up resistors in this mode.
You can select the output driver slew rate. The output driver by
default uses a slow slew rate setting to reduce system noise and
power. A faster slew rate decreases chip-to-out propagation delay.
Select input thresholds globally with TTL/CMOS. Input can be registered or latched and you can select register and latch setup time.
In the default configuration, the input register or latch has positive
setup and negative hold time (when used in conjunction with a
global clock network). Reducing input setup time slightly increases
hold time.
You cannot apply clock or latch-enable or asynchronous set/reset
control on input registers and latches. Direct input enables simultaneous availability of registered and latched input.
You can control the initial state of input registers and latches, and you
can register output.
You cannot apply clock-enable or asynchronous set/reset control on
output registers, but you can control the initial state of output registers.

Xilinx/Synopsys Interface Guide — 2.1i

3-7

Xilinx/Synopsys Interface Guide

XC4000E/L/EX/XL/XLA/XV IOBs
This section describes XC4000E/L/EX/XL/XLA/XV IOBs.

Using Input Blocks
Select input thresholds globally with TTL/CMOS. Specify an internal
pull-up/pull-down resistor that can optionally attach to an I/O pad.
You can make inputs registered or latched and you can select register
and latch setup time.
In the default configuration, the input register or latch has positive
setup and zero hold time (when used in conjunction with a global
clock network). For XC4000 devices, reducing input setup time
slightly increases hold time. For XC4000EX/XL/XLA/XV devices,
three setup and hold delay adjustments allow setup versus hold
parameter tuning.
Direct input enables simultaneous availability of registered and
latched input. You cannot apply asynchronous set/reset control on
input registers and latches, but you can apply clocks and latches on
input register and latches.
FPGA Compiler cannot infer I/O registers and latches with clock and
latch-enables.
You can control the initial state of input registers and latches.

Using Output Blocks
You can select the output driver slew rate. By default the output
driver uses a slow slew rate setting to reduce system noise and
power. A faster slew rate decreases chip-to-out propagation delay
You can register outputs and make them tristate. You cannot enable
asynchronous set/reset control on output registers, but you can
specify clock-enable on output registers. FPGA Compiler cannot infer
I/O registers and latches with clock and latch enables.
You can control the initial state of output registers.
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Perform 2-to-1 multiplexing or 2-input function directly in the output
path of an IOB (XC4000EX/XL/XV only). You can trade an output
register for a 2-input function or multiplexer. Additionally, you must
instantiate the following primitives (valid for XC4000EX/XL/XLA/
XV/XLT). See the “XSI Library Primitives” appendix for more details.
•

OAND2

•

OMUX2

•

ONAND2

•

ONOR2

•

OOR2

•

OXNOR2

•

OXOR2

FPGA Compiler cannot infer output drivers containing a 2-input
function or output multiplexer.

Using Bidirectional Mode
You can select the output driver slew rate. By default the output
driver uses a slow slew rate setting to reduce system noise and
power. Faster slew rates decrease chip-to-out propagation delay.
Select input thresholds globally with TTL/CMOS. Input can be registered or latched and you can select register and latch setup time.
In the default configuration, the input register or latch has positive
setup and negative hold time (when used in conjunction with a
global clock network). This corresponds to a full delay. Reducing
input setup time slightly increases hold time.
You cannot enable asynchronous set/reset control on input registers
and latches. Direct input makes registered and latched input available simultaneously.
You can specify clock and latch-enable on input registers and latches.
FPGA Compiler cannot infer I/O registers or latches with clock or
latch enables.
You can control initial states of I/O registers and latches. You can
register output.
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You cannot enable asynchronous set/reset control on output registers, but you can specify clock-enable on output registers. FPGA
Compiler cannot infer I/O registers and latches with clock or latch
enables.
You can control the initial state of output registers.
Perform 2-to-1 multiplexing or 2-input function directly in the output
path of an IOB. You can trade an output register for a 2-input function
or multiplexer. FPGA Compiler cannot infer output drivers
containing 2-input functions or output multiplexers. Additionally,
you must instantiate the OMUX2, ONADN2, ONOR2, and OOR2
primitives. See the “XSI Library Primitives” appendix for more
details.

Using XC5200 IOBs
This section describes XC5200 IOBs.

Using Input Blocks
Select input thresholds globally with TTL/CMOS. Specify an internal
pull-up/pull-down resistor that can optionally attach to an I/O pad.
IOBs can contain no input registers, although you can emulate this
functionality using the latch/flip-flop in the adjacent CLB. Additionally, CLB registers and latches have clock or latch-enables and asynchronous reset inputs.
The IOB input path has an optional delay with which you can adjust
input setup and hold times. By default an input register or latch has a
positive setup and negative hold time (when used in conjunction
with a global clock network). Reducing input setup time slightly
increases hold time.

Using Output Blocks
You can select the output driver slew rate. By default the output
driver uses a slow slew rate setting to reduce system noise and
power. A faster slew rate decreases chip-to-out propagation delay.
You can make outputs tristate.
IOBs contain no output registers, although you can emulate this functionality using the latch or flip-flop in the adjacent CLB. Additionally,
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CLB registers and latches have clock or latch-enables and asynchronous reset inputs.

Using Bidirectional Mode
Select input thresholds globally with TTL/CMOS. Have an internal
pull-up/pull-down resistor that can optionally attach to an I/O pad.
IOBs contain no input registers, although you can emulate this functionality using the latch/flip-flop in the adjacent CLB. Additionally,
CLB registers and latches have clock or latch-enables and asynchronous reset inputs.
The IOB input path has an optional delay with which you can adjust
input setup and hold times. By default the input register or latch has
a positive setup and negative hold time (when used in conjunction
with a global clock network). Reducing input setup time slightly
increases hold time.
You can select the output driver slew rate. By default the output
driver uses a slow slew rate setting to reduce system noise and
power. A faster slew rate decreases chip-to-out propagation delay.
You can make outputs tristate.
IOBs contain no output registers, although you can emulate this functionality using the latch or flip-flop in the adjacent CLB. Additionally,
CLB registers and latches have clock or latch-enables and asynchronous reset inputs.

Assigning and Prohibiting Pad Locations
You can specify pad locations in your synthesis script or in a Xilinx
User Constraints File (UCF). To assign pad locations in your synthesis
DC script, include the following command in your script, replacing
pad and pin number with the appropriate values.
set_attribute pad “pad_location” \
–type string “pin number”

Refer to The Programmable Logic Data Book, available on the Xilinx Web
site at http://www.xilinx.com, for the locations and name of the pins.
For more information on the UCF, refer to the Development System
Reference Guide or the Libraries Guide.
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Implementing 3-State Registered Output
FPGA Compiler infers the use of 3-state output flip-flops, such as
OFDT, under the following two conditions.
•

The flip-flop must directly drive the 3-state signal.

•

The HDL code of the flip-flop must reside in the same process as
the 3-state HDL code.

The following sections illustrate a flip-flop that does not directly
drive the 3-state signal and one that does directly drive the 3-state
signal.

Example of Not Directly Driving the 3-State Signal
If any logic exists between the flip-flop and the 3-state signal
connected to the output flip-flop, FPGA Compiler does not infer a 3state output flip-flop. The following VHDL and Verilog examples
illustrate a flip-flop not directly driving a 3-state output flip-flop. The
“No Output Register Inferred” figure shows a schematic representation.
The three_ex1 VHDL example follows.
library IEEE;
use IEEE.std_logic_1164.all;
use IEEE.std_logic_unsigned.all;
entity three_ex1 is
port (BUS_IN, EN, CLK: in STD_LOGIC;
BUS_OUT: out STD_LOGIC);
end three_ex1;
architecture RTL of three_ex1 is
signal BUS_IN_REG, BUS_OUT_REG: STD_LOGIC;
begin
sync: process (CLK)
begin
if (CLK’ event and CLK= ‘1’) then
BUS_IN_REG <= BUS_IN;
BUS_OUT_REG <= BUS_IN_REG;
end if;
end process;
BUS_OUT <= BUS_OUT_REG when (EN= ‘0’) else ‘Z’;
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end RTL;

The three_ex1 Verilog example follows.
module three_ex1(BUS_IN, EN, CLK, BUS_OUT);
input BUS_IN ;
input EN ;
input CLK ;
output BUS_OUT ;
reg BUS_OUT_REG, BUS_IN_REG, BUS_OUT;
always @(posedge CLK)
begin
BUS_OUT_REG = BUS_IN_REG ;
BUS_IN_REG = BUS_IN ;
end
always @(EN or BUS_OUT_REG)
begin
if (!EN)
BUS_OUT = BUS_OUT_REG;
else
BUS_OUT = 1’bz;
end
endmodule

T

EN
IBUF
D

BUS_IN

IFD

Q BUS_IN_REG D

C

CLOCK

FDC

BUS_OUT
Q BUS_OUT_REG

C

OBUFT_F

BUFG_F
X8564

Figure 3-1 No Output Register Inferred
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Example of Directly Driving the 3-State Signal
The HDL code for the flip-flop must reside in the same process as the
3-state HDL code and must directly drive the 3-state output, as
shown in the sync process in the following VHDL and Verilog examples. If the code meets these two conditions, FPGA Compiler infers a
registered 3-state output, as illustrated by the “Output Register
Inferred” figure.
Having the flip-flop and the 3-state signal in separate processes
causes the insertion of additional logic between the flip-flop and the
3-state signal.
The three_ex2 VHDL example follows.
library IEEE;
use IEEE.std_logic_1164.all;
use IEEE.std_logic_unsigned.all;
entity three_ex2 is
port (BUS_IN, EN, CLK: in STD_LOGIC;
BUS_OUT: out STD_LOGIC);
end three_ex2;
architecture RTL of three_ex2 is
signal BUS_IN_REG: STD_LOGIC;
begin
sync: process (CLK, EN)
begin
if (CLK’ event and CLK= ‘1’) then
BUS_IN_REG <= BUS_IN;
if (EN= ‘0’) then
BUS_OUT <= BUS_IN_REG;
else
BUS_OUT <= ‘Z’;
end if;
end if;
end process;
end RTL;
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The three_ex2 Verilog example follows.
module three_ex2(BUS_IN, EN, CLK, BUS_OUT) ;
input
BUS_IN ;
input
EN ;
input
CLK ;
output BUS_OUT ;
reg
reg

BUS_OUT ;
BUS_IN_Q, BUS_IN_REG ;

always @(posedge CLK)
begin
BUS_IN_Q = BUS_IN ;
BUS_IN_REG = BUS_IN_Q ;
if (!EN) BUS_OUT = BUS_IN_REG;
else BUS_OUT = 1’bz;
end
endmodule

D

EN

IFD

Q

BUS_OUT_TRI_ENABLE

C
OFDT

D

BUS_IN

IFD

Q BUS_IN_REG D

C

CLOCK

C

OFD

BUS_OUT
Q
OBUFT

BUFG

X8559

Figure 3-2 Output Register Inferred

Inserting Bidirectional I/Os
FPGA Compiler has the ability to insert non-registered bidirectional
ports. Describe the 3-state signal that drives the output buffer in the
same hierarchy level as the input signal, as in the bidi_reg.vhd and
bidi_reg.v examples in the following section.
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Instantiating a Registered Bidirectional I/O
The top-level design examples bidi_reg.vhd and bidi_reg.v instantiate a core design, reg4. In these examples, two clock buffers,
CLOCK1 and CLOCK2, automatically infer a BUFG buffer. The reset
and load signals, RST and LOADA, automatically infer an IBUF
when you run the Set Port Is Pad and Insert Pads commands.
However, FPGA Compiler cannot automatically infer the OFDT_F (3state registered output buffers with a FAST slew rate) cells in bidirectional I/Os. Therefore, these cells and the IBUF instantiate into the
top-level design.
The bidi_reg.vhd VHDL example follows.
library IEEE;
use IEEE.std_logic_1164.all;
entity bidi_reg is
port (SIGA: input STD_LOGIC_VECTOR (3 downto 0);
LOADA, CLOCK1, CLOCK2, RST: in STD_LOGIC);
end bidi_reg;
architecture STRUCTURE of bidi_reg is
component reg4
port (INX: in STD_LOGIC_VECTOR (3 downto 0);
LOAD, CLOCK, RESET: in STD_LOGIC;
OUTX: buffer STD_LOGIC_VECTOR (3 downto 0));
end component;
component OFDT_F
port (D: in STD_LOGIC;
C: in STD_LOGIC;
T: in STD_LOGIC;
O: out STD_LOGIC);
end component;
component IBUF
port (I: in STD_LOGIC;
O: out STD_LOGIC);
end component;
signal INA, OUTA: STD_LOGIC_VECTOR (3 downto 0);
begin
U5: reg4 port map (INA, LOADA, CLOCK1, RST, OUTA);
U0: OFDT_F port map (OUTA(0), CLOCK2, LOADA, SIGA(0));
U1: OFDT_F port map (OUTA(1), CLOCK2, LOADA, SIGA(1));
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U2: OFDT_F port map (OUTA(2), CLOCK2, LOADA, SIGA(2));
U3: OFDT_F port map (OUTA(3), CLOCK2, LOADA, SIGA(3));
U4: IBUF port map (SIGA(0), INA(0));
U6: IBUF port map (SIGA(1), INA(1));
U7: IBUF port map (SIGA(2), INA(2));
U8: IBUF port map (SIGA(3), INA(3));
end STRUCTURE;

The bidi_reg.v Verilog example follows.
module bidi_reg (SIGA, LOADA, CLOCK1, CLOCK2, RST) ;
inout
input
input
input
input

[3:0]

wire
[3:0]
// Netlist

SIGA ;
LOADA ;
CLOCK1 ;
CLOCK2 ;
RST ;
INA, OUTA ;

reg4 U5 (.INPUT(INA), .LD(LOADA), .CLOCK(CLOCK1), .RESET(RST), \
.OUT(OUTA)) ;
OFDT_F
OFDT_F
OFDT_F
OFDT_F
IBUF
IBUF
IBUF
IBUF

U0
U1
U2
U3
U4
U6
U7
U8

(.D(OUTA[0]),
(.D(OUTA[1]),
(.D(OUTA[2]),
(.D(OUTA[3]),
(.I(SIGA[0]),
(.I(SIGA[1]),
(.I(SIGA[2]),
(.I(SIGA[3]),

.C(CLOCK2),
.C(CLOCK2),
.C(CLOCK2),
.C(CLOCK2),
.O(INA[0]))
.O(INA[1]))
.O(INA[2]))
.O(INA[3]))

.T(LOADA),
.T(LOADA),
.T(LOADA),
.T(LOADA),
;
;
;
;

.O(SIGA[0]))
.O(SIGA[1]))
.O(SIGA[2]))
.O(SIGA[3]))

;
;
;
;

endmodule

The backslash (“\”) character shows a line break required for formatting purposes.
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Compiling Bidirectional I/O
Do not use the Set Port Is Pad command for the instantiated I/O cells.
For example, in the bidi_reg.vhd example, use the following
commands to insert the I/Os for the LOADA, RST, CLOCK1, and
CLOCK2 signals only.
set_port_is_pad {LOADA RST CLOCK1 CLOCK2}
insert_pads

Before compiling the design, you must place a Dont Touch attribute
on any instantiated I/O cells to prevent their alteration, as shown in
the following example.
dont_touch {U0 U1 U2 U3 U6 U7 U8}

The following example shows the script files used to compile
bidi_reg.vhd and bidi_reg.v.
The script file for bidi_reg.vhd example follows.
/* ===============================================
/* Sample Script for Synopsys to Xilinx Using
/*
the FPGA Compiler
/*
Bidirectional Register Example.
/* ================================================

*/
*/
*/
*/
*/

/* +++++++++++++++++++++++++++++++++++++++++++++++
/*
Read in the design
/* +++++++++++++++++++++++++++++++++++++++++++++++
/* Set the top-level modules name for the design

*/
*/
*/
*/

TOP = bidi_reg
SUB = reg4
/* Set the Designer and Company name for documentation

*/

designer = “XSI Team”
company = “Xilinx, Inc”
/* Analyze and Elaborate the design file and specify the design file
/* format

*/
*/

analyze –format vhdl SUB + “.vhd”
analyze –format vhdl TOP + “.vhd”
elaborate TOP
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/* Set the current design to the top level

*/

current_design TOP
/* Add pads to the design. Make sure the current design is the
/* top-level module

*/
*/

set_port_is_pad {LOADA RST CLOCK1 CLOCK2}
insert_pads
dont_touch {U0 U1 U2 U3 U4 U6 U7 U8}
/* +++++++++++++++++++++++++++++++++++++++++++++++
/*
Compile the design
/* +++++++++++++++++++++++++++++++++++++++++++++++
/* Set the synthesis design constraints.

*/
*/
*/
*/

remove_constraint –all
/* Synthesize and optimize the design

*/

compile –map_effort med
/* +++++++++++++++++++++++++++++++++++++++++++++++
/*
Save the design
/* +++++++++++++++++++++++++++++++++++++++++++++++
/* Write the design report file

*/
*/
*/
*/

report_fpga > TOP + “.fpga”
report_timing > TOP + “.timing”
/* Write out the design to a DB file

*/

write –format db –hierarchy –output TOP + “.db”
/* Replace CLBs and IOBs with gates

*/

replace_fpga
/* Set the part type

*/

set_attribute TOP “part” –type string “4013epq208-3”
/* Save design in XNF format as <design>.sxnf

*/

write –format xnf –hierarchy –output TOP + “.sxnf”
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/* Exit the Compiler.

*/

exit

The script file for bidi_reg.v example follows.
/* ================================================
/* Sample Script for Synopsys to Xilinx Using
/*
the FPGA Compiler
/*
Bidirectional Register Example.
/* ================================================

*/
*/
*/
*/
*/

/* ++++++++++++++++++++++++++++++++++++++++++++++++
/*
Read in the design
/* +++++++++++++++++++++++++++++++++++++++++++++
/* Set the top-level modules name for the design

*/
*/
*/
*/

TOP = bidi_reg
SUB = reg4
/* Set the Designer and Company name for
documentation.

*/

designer = “XSI Team”
company = “Xilinx, Inc”
/* Analyze and Elaborate the design file and specify the
/* design file format

*/
*/

analyze –format verilog SUB + “.v”
analyze –format verilog TOP + “.v”
elaborate TOP
/* Set the current design to the top level

*/

current_design TOP
/* Add pads to the design. Make sure the current design is the
/* top-level module.

*/
*/

set_port_is_pad {LOADA RST CLOCK1 CLOCK2}
insert_pads
dont_touch {U0 U1 U2 U3 U4 U6 U7 U8}
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/* +++++++++++++++++++++++++++++++++++++++++++++++
/*
Compile the design
/* +++++++++++++++++++++++++++++++++++++++++++++++
/* Set the synthesis design constraints.

*/
*/
*/
*/

remove_constraint –all
/* Synthesize and optimize the design

*/

compile –map_effort med
/* +++++++++++++++++++++++++++++++++++++++++++++++
/*
Save the design
/* +++++++++++++++++++++++++++++++++++++++++++++++
/* Write the design report file

*/
*/
*/
*/

report_fpga > TOP + “.fpga”
report_timing > TOP + “.timing”
/* Write out the design to a DB file
write –format db –hierarchy –output TOP + “.db”
/* Replace CLBs and IOBs with gates

*/

replace_fpga
/* Set the part type

*/

set_attribute TOP “part” –type string “4013epq208-3”
/* Save design in XNF format as <design>.sxnf

*/

write –format xnf –hierarchy –output TOP + “.sxnf”
/* Exit the Compiler.

*/

exit

Using Unbonded IOBs
In some package and device pairs, not all pads bond to a package pin.
You can use these unbonded IOBs and the flip-flops inside them in
your design by instantiating them in the HDL code. However,
Synopsys cannot infer unbonded primitives.
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A “_U” suffix indicates unbounded primitives. Refer to the “XSI
Library Primitives” appendix for a complete listing of all unbonded
cells.

Adding Pull-Up and Pull-Down Resistors
You can apply pull-up and pull-down resistors to chip-level I/O
ports and you can use them internally. Use the following command to
attach pull-up or pull-down resistors to I/O ports before you issue
the Insert Pads command.
set_pad_type {–pullup | –pulldown} port_name

You can only instantiate internal pull-up and pull-down resistors.
The following table shows which devices require pull-up/pull-down
resistors.
Table 3-2

Instantiating Pull-up/Pull-down Resistors

XC3000A/L
Pull-up

XC4000E/L
Pull-up/
Pull-down

XC4000EX/XL/
XLA/XV
Pull-up/
Pull-down

XC5200
Pull-up/
Pull-down

Refer to the “XSI Library Primitives” appendix for a listing of all cells
and their pin names for instantiation.
See the “Configuring IOBs” section in this chapter for more information on pull-up and pull-down resistors for a specific device family.

Removing the Default Input Delay
The input flip-flops and latches have a default delay preceding the
data to the input flip-flop or latch. This delay prevents any possible
hold-time violations if you have a clock signal that also comes into
the device and clocks the input flip-flop or latch.
You can remove this delay by instantiating a cell that includes the
NODELAY attribute if you need additional input speed and have no
possibility of a hold-time violation. The “XSI Library Primitives”
appendix lists all cells that include a NODELAY attribute. Input flipflops or latches with an “_F” suffix have a NODELAY attribute
assigned to the cell.
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Initializing the IOB Flip-Flop to Preset
You can initialize IOB flip-flops to either Clear or Preset in XC3000A/
L and XC4000E/L/EX/XL/XV FPGAs. The default is Clear. To
initialize an I/O flip-flop or latch to Preset, use the following
command to attach an INIT=S attribute to the flip-flop.
set_attribute “register_name” xnf_init \
“S” type string

Replace register_name with the name of the I/O flip-flop.
You can instantiate I/O cells with the INIT=S attribute already
assigned to them. Refer to the “XSI Library Primitives” appendix for
a list of all cells and their pin names for instantiation.

Inserting Clock Buffers
For designs with global signals, use global clock buffers to take
advantage of the low-skew, high-drive capabilities of the primary
global clock buffer (BUFGP) and the secondary global clock buffer
(BUFGS). When you use the Insert Pads command, FPGA Compiler
automatically inserts a generic global clock buffer (BUFG) whenever
an input signal drives a clock signal. The Xilinx implementation software automatically selects the clock buffer appropriate for your specified design constraints. If you want to use a specific global buffer,
you must instantiate it.
You can instantiate an architecture-specific buffer if you understand
the architecture and want to specify how to use the resources. Each
XC4000E/L device contains four primary and four secondary global
buffers that share the same routing resources. XC4000EX/XL/XLA/
XV devices have eight global buffers; each buffer has its own routing
resources. For all architectures, use the BUFG for up to four
low-skew, high-fanout clock signals.
You can use BUFGS to buffer high-fanout, low-skew signals sourced
from inside the FPGA. To access the secondary global clock buffer for
an internal signal, instantiate the BUFGS_F cell.
Additionally, you can use BUFGP to distribute signals applied to the
FPGA from an external source. A primary global buffer can globally
distribute internal signals, however, the signals must drive an
external pin.
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Controlling Clock Buffer Insertion
Because FPGA Compiler assigns a BUFG to any input signal that
drives a clock signal, your design can contain too many clock buffers.
The following examples illustrate how to control clock buffer insertion.
The following two examples also illustrate a gated clock using VHDL
and Verilog HDL, respectively. By default, Synopsys assigns the
signals IN1, IN2, IN3, IN4, and CLK to a BUFG because they ultimately connect to a clock pin.
The gate_clock VHDL example follows.
entity gate_clock is
port (IN1, IN2, IN3, IN4, IN5, CLK, LOAD: in BIT;
OUT1: buffer BIT);
end gate_clock
architecture RTL of gate_clock is
signal GATECLK: BIT;
begin
GATECLK <= not((((IN1 and IN2) and IN3) and IN4) and CLK);
process (GATECLK)
begin
if (GATECLK’ event and GATECLK= ‘1’) then
if (LOAD= ‘1’) then
OUT1 <= IN5;
else
OUT1 <= OUT1;
end if;
end if;
end process;
end RTL;

The gate_clock Verilog HDL example follows.
module
input
input
input
input
input
input
input
output
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IN1 ;
IN2 ;
IN3 ;
IN4 ;
IN5 ;
CLK ;
LOAD ;
OUT1;
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reg

OUT1;

wire GATECLK ;
assign GATECLK = ~(IN1 & IN2 & IN3 & IN4 & CLK) ;
always @(posedge GATECLK)
begin
if (LOAD == 1’b1)
OUT1 = IN5 ;
end
endmodule

FPGA Compiler identifies clock ports by tracing back from the clock
pins on the flip-flops. In the following figure, the inputs to the 5-input
NAND gate all have a BUFG inserted.
IN5
IBUF
D

LOAD

FDCE

IBUF
CE

OUT1
Q

IN2
C

BUFG_F

OBUF_S

IN3
BUFG_F
IN4

NAND4
BUFG_F

INV
NAND2

CLK
BUFG_F
X4889

IN1
BUFG_F

Figure 3-3 Gated Clock After Pad Insertion
If your design contains gated clocks or has more than four input pins
that drive clock pins, disable the input pins to stop insertion of a
BUFG. Refer to the “Preventing the Insertion of Clock Buffers”
section in this chapter.
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Determining the Number of Clock Buffers
To determine how many clock buffers FPGA Compiler inserted in
your design, use the Report FPGA command after using the Insert
Pads or Compile command. Enter the Report FPGA command as
follows.
report_fpga

The following example shows the output produced when running
the Report FPGA command on the previous gated clock design.
Although clock pads are IOBs, this report lists them separately.
*************************************
Report : fpga
Design : gate_clock
Version: v3.4b
Date
: Tues Dec 10 09:22:21 1996
*************************************
Xilinx FPGA Design Statistics
-----------------------------

3-26

FG Function Generators
H Function Generators
Number of CLB cells:
Number of Hard Macros and
Other Cells:
Number of CLBs in
Other Cells:
Total Number of CLBs:

1
1
1

Number of Ports:
Number of Clock Pads:
Number of IOBs:

8
5
3

Number of Flip Flops:
Number of 3-State Buffers:

1
0

Total Number of Cells:

9

0
0
1
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Preventing the Insertion of Clock Buffers
To prevent FPGA Compiler from inserting the BUFG primitive,
specify the Set Pad Type command with the following options before
inserting the pads.
set_pad_type –no_clock {clock_ports}

Replace clock_ports with the name of the input pins where you do not
want a clock buffer inserted. For the gated clock VHDL and Verilog
examples, enter the following.
set_pad_type –no_clock {IN1, IN2, IN3, IN4, CLK}

Then follow the normal procedures to set the ports as pads and insert
the pads as follows.
set_port_is_pad “*”
insert_pads

Using Memory
You can use on-chip RAM for status registers, index registers, counter
storage, distributed shift registers, LIFO stacks, and FIFO buffers.
The XC4000 family can efficiently implement RAM and ROM using
CLB function generators. Implement a ROM by describing it behaviorally as shown in the “Implementing XC4000E/L/EX/XL/XV
ROMs” section. Alternatively, the XSI XC4000E/L/EX/XL/XV
libraries contain 16 x 1 (16 deep x 1 wide) and 32 x 1 (32 deep x 1
wide) RAM and ROM primitives and 16 x 1 dual-port RAM you can
instantiate.
You can also implement memory using the LogiBLOX program. LogiBLOX can create RAM and ROM between 1–32 bits wide and 2–256
bits deep. Using LogiBLOX to add RAM or ROM to your design
provides an efficient implementation of your memory in addition to a
simulation model for Register Transfer Level (RTL) simulation.
For VHDL and Verilog examples of instantiating RAM in your
designs using LogiBLOX, refer to the “Using Core Generator and
LogiBLOX” chapter. Also, refer to the LogiBLOX Reference/User Guide
for more information on LogiBLOX.
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Implementing XC4000E/L/EX/XL/XV RAMs
Implement RAMs in your HDL with the following methods.
•

Instantiate 16 x 1 and 32 x 1 RAMs from the XSI primitive
libraries.

•

Instantiate any size RAM using LogiBLOX.

Behaviorally describing RAMs in VHDL creates combinatorial loops
during compiling.

Implementing XC4000E/L/EX/XL/XV ROMs
Implement ROM in your HDL with the following methods.
•

Describe ROM behaviorally.

•

Instantiate 16 x 1 and 32 x 1 ROM primitives.

•

Instantiate any size ROM using LogiBLOX.

To instantiate the ROM16 x 1 and ROM32 x 1 primitives into your
design, connect the input and output pins to the appropriate signals.
Use the DC Shell Set Attribute command to define the ROM value.
set_attribute “instance_name” \
xnf_init “rom_value” –type string
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For example, if you gave the 16 x 1 ROM an instance name of “U1”
and a hex value of F5A3, you can use the DC Shell Set Attribute
command to set the ROM value as follows.
set_attribute “U1” xnf_init “F5A3” –type string

Compile calculates ROM content values by considering the 16 x 1 or
32 x 1 ROM’s 16 or 32 1-bit locations as bits in a 16 or 32 bit word. For
example, for a 32 x 1 ROM, specify an 8-digit hexadecimal (hex) value
in place of the 4-digit hex value. See the “Implementing ROMs”
figure.
Refer to the Application Note “Using Select-RAM Memory in XC4000
Series FPGAs” for more information.

ADDR
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ROM16X1
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1

1
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0

0

O[3:0]
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XNF_INIT
0101010101010101
=5555
H

X8001

Figure 3-4 Implementing ROMs
The 16 x 4 ROM VHDL and 16 x 4 ROM Verilog HDL examples illustrate how to define a ROM in VHDL and Verilog HDL, respectively.
FPGA Compiler creates ROMs from optimized random logic gates
implemented using function generators.

Xilinx/Synopsys Interface Guide — 2.1i

3-29

Xilinx/Synopsys Interface Guide
The 16 x 4 ROM RTL VHDL example follows.
------------------------------------------ RTL 16x4 ROM Example
--rom16x4_4k.vhd
-----------------------------------------entity rom16x4_4k is
port ( ADDR: in INTEGER range 0 to 15;
DATA: out BIT_VECTOR (3 downto 0));
end rom16x4_4k;
architecture RTL of rom16x4_4k is
subtype ROM_WORD is BIT_VECTOR (3 downto 0);
type ROM_TABLE is array (0 to 15) of ROM_WORD;
constant ROM: ROM_TABLE := ROM_TABLE’(
ROM_WORD’(“0000”),
ROM_WORD’(“0001”),
ROM_WORD’(“0010”),
ROM_WORD’(“0100”),
ROM_WORD’(“1000”),
ROM_WORD’(“1000”),
ROM_WORD’(“1100”),
ROM_WORD’(“1010”),
ROM_WORD’(“1001”),
ROM_WORD’(“1001”),
ROM_WORD’(“1010”),
ROM_WORD’(“1100”),
ROM_WORD’(“1001”),
ROM_WORD’(“1001”),
ROM_WORD’(“1101”),
ROM_WORD’(“1111”),
begin
DATA <= ROM(ADDR); -- Read from the ROM
end RTL;
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The 16 x 4 ROM RTL Verilog example follows.
module rom16x4_4k(ADDR, DATA) ;
input [3:0] ADDR ;
output [3:0] DATA ;
reg [3:0] DATA ;
always @(ADDR)
begin
case (ADDR)
4’b0000 :
4’b0001 :
4’b0010 :
4’b0011 :
4’b0100 :
4’b0101 :
4’b0110 :
4’b0111 :
4’b1000 :
4’b1001 :
4’b1010 :
4’b1011 :
4’b1100 :
4’b1101 :
4’b1110 :
4’b1111 :
endcase
end

DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA
DATA

=
=
=
=
=
=
=
=
=
=
=
=
=
=
=
=

4’b0000
4’b0001
4’b0010
4’b0100
4’b1000
4’b1000
4’b1100
4’b1010
4’b1001
4’b1001
4’b1010
4’b1100
4’b1001
4’b1001
4’b1101
4’b1111

;
;
;
;
;
;
;
;
;
;
;
;
;
;
;
;

endmodule

Implementing RAM In Virtex Devices
The INIT values for RAM32X 1 and RAM32X1_1 map diiferently
from 4000EX/XL/XV and SpartanXL.
Virtex maps the lower INIT values to G and upper INIT values to F
for both RAM32X. 4000EX/XL/XV and SpartanXL map those lower
INIT values to F and upper INIT values to G.
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Performing Boundary Scans
The XC4000E/L/EX/XL/XLA/XV and XC5200 FPGA devices
contain boundary-scan facilities compatible with IEEE Standard
1149.1. Refer to the Development System Reference Guide for a detailed
description of the XC4000E/L/EX/XL/XLA/XV and XC5200
boundary scan capabilities.
Xilinx parts support external (I/O and interconnect) testing and have
limited support for internal self-test.
Full access to the built-in boundary-scan logic exists between powerup and the start of configuration. Optionally, specify boundary scan
in the design to access built-in logic after configuration. During
configuration, you can use the Sample/Preload and Bypass instructions only.
To make boundary-scan logic active in a configured FPGA device,
include the boundary-scan cell and its related I/O cells in the configuration data of your design. For HDL designs, you must instantiate
the boundary-scan symbol, BSCAN, and the boundary scan I/O pins,
TDI, TMS, TCK, and TDO.
Warning: Do not use the following FPGA Compiler boundary scan
commands because they do not work with FPGA devices.
set jtag implementation
set jtag instruction
set jtag port

The following figure illustrates the BSCAN symbol instantiated into
an HDL design.
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BSCAN
TDI

TDI

TMS

TMS

DRCK

TCK

TCK

IDLE

TDO1

SEL1

TDO2

SEL2

From
User Logic

TDO

TDO

To User
Logic

X8560
Figure 3-5 Boundary Scan Symbol Instantiation in XC4000
Family
The following examples show the code used to instantiate the cells in
the previous figure. Additionally, the examples include code samples
for the XC5200 family. The VHDL code for instantiating BSCAN in
the XC5200 family follows.
Note: You must apply a Dont Touch attribute on all of the following
instantiated components.
entity example is
port (a, b: in bit; c: out bit);
end example;
architecture xilinx of example is
component bscan
port(tdi, tms, tck: in bit; tdo: out bit);
end component;
component tck
port ( i : out bit );
end component;
component tdi
port ( i : out bit );
end component;
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component tms
port ( i : out bit );
end component;
component tdo
port ( o : in
end component;

bit );

component ibuf
port (i: in bit; o: out bit);
end component;
component obuf
port(i: in bit; o: out bit);
end component;
signal
signal
signal
signal

tck_net,
tdi_net,
tms_net,
tdo_net,

tck_net_in : bit;
tdi_net_in : bit;
tms_net_in : bit;
tdo_net_out : bit;

begin
u1: bscan port map (tdi=>tdi_net, tms=>tms_net,
tck=>tck_net, tdo=>tdo_net_out);
u2: ibuf port map(i=>tck_net_in, o=>tck_net);
u3: ibuf port map(i=>tdi_net_in, o=>tdi_net);
u4: ibuf port map(i=>tms_net_in, o=>tms_net);
u5: obuf port map(i=>tdo_net_out, o=>tdo_net);
u6: tck port map (i=>tck_net_in);
u7: tdi port map (i=>tdi_net_in);
u8: tms port map (i=>tms_net_in);
u9: tdo port map (o=>tdo_net);
process(b)
begin
if(b’event and b=’1’) then
c <= a;
end if;
end process;
end xilinx;

The following shows the Verilog code for instantiating BSCAN in the
XC5200 family.
module example (a,b,c);
input a, b;
output c;
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reg c;
wire tck_net,
wire tdi_net,
wire tms_net,
wire tdo_net,

tck_net_in;
tdi_net_in;
tms_net_in;
tdo_net_out;

BSCAN u1 (.TDI(tdi_net), .TMS(tms_net),
.TCK(tck_net), .TDO(tdo_net));
TDI u2 (.I(tdi_net_in));
TMS u3 (.I(tms_net_in));
TCK u4 (.I(tck_net_in));
TDO u5 (.O(tdo_net_out));
IBUF u6 (.I(tdi_net_in), .O(tdi_net));
IBUF u7 (.I(tms_net_in), .O(tms_net));
IBUF u8 (.I(tck_net_in), .O(tck_net));
OBUF u9 (.I(tdo_net), .O(tdo_net_out));
always@(posedge b)
c<=a;
endmodule

The Verilog code for instantiating BSCAN in XC4000/XC4000E
appears in the following example. Note the use of upper and lower
case in the sample.
module example (a,b,c);
input a, b;
output c;
reg c;
wire tck_net;
wire tdi_net;
wire tms_net;
wire tdo_net;
BSCAN u1 (.TDI(tdi_net), .TMS(tms_net),
.TCK(tck_net), .TDO(tdo_net));
TDI u2 (.I(tdi_net));
TMS u3 (.I(tms_net));
TCK u4 (.I(tck_net));
TDO u5 (.O(tdo_net));
always@(posedge b)
c<=a;
endmodule
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The VHDL code for instantiating BSCAN in XC4000/XC4000E
example follows.
entity example is
port (a, b: in bit; c: out bit);
end example;
architecture xilinx of example is
component bscan
port(tdi, tms, tck: in bit; tdo: out bit);
end component;
component tck
port ( i : out bit );
end component;
component tdi
port ( i : out bit );
end component;
component tms
port ( i : out bit );
end component;
component tdo
port ( o : in
end component;
signal
signal
signal
signal

tck_net
tdi_net
tms_net
tdo_net

bit );
:
:
:
:

bit;
bit;
bit;
bit;

begin
u1: bscan port map (tdi=>tdi_net, tms=>tms_net,
tck=>tck_net, tdo=>tdo_net);
u2: tck port map (i=>tck_net);
u3: tdi port map (i=>tdi_net);
u4: tms port map (i=>tms_net);
u5: tdo port map (o=>tdo_net);
process(b)
begin
if(b’event and b=’1’) then
c <= a;
end if;
end process;
end xilinx;

3-36

Xilinx Development System

Synthesizing Your Design

Using the Global Set/Reset Net
All Xilinx FPGA devices have a dedicated Global Set/Reset (GSR) net
that initializes all CLBs and IOB flip-flops. The function of the GSR
net is separate from and overrides the individual flip-flop or latch
Preset (PRE) and Direct Clear (CLR) pins.
If your design includes a signal used to globally initialize all the flipflops or latches, use the GSR net to increase design performance by
reducing the overall routing congestion. The GSR net, a dedicated
routing resource, exists outside of the general purpose interconnect.
You can disconnect your design’s global initialization signal from the
flip-flops and latches in your design and implement this function
using the device’s dedicated GSR net.
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Figure 3-6 Emulation of Power-on State “1” with Inverters
(XC3000A/L, XC3100A, and XC5200)

Accessing Global Set/Reset Using STARTBUF
Access an FPGA’s GSR signal by attaching a net to the input pin on
the STARTBUF cell. Asserting the net attached to the STARTBUF
block’s GSR pin also asserts FPGA Global Set/Reset causing every
flip-flop and latch in the device to assume its power-on state.
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You must instantiate the STARTBUF block.
The GSR net does not appear in the pre-placed and routed netlist.
Asserting the GSR signal to High (the default) sets every flip-flop and
latch to the same state it had at the end of configuration, illustrated in
the following tables. When you simulate the placed and routed
design, the simulator’s translation program correctly inserts the functionality.
Any signal can drive the STARTUP block’s GSR pin, however, do not
use flip-flop or latch output signals.

Synthesizing/Simulating for VHDL Global Set/Reset
Emulation
VHDL requires a testbench to control all signal ports. You can instantiate certain VHDL-specific components, explained in the following
sections, in the RTL and post-synthesis VHDL description to allow
the simulation of the global signals for global set/reset and global 3state.
NGD2VHDL creates a port in your back-annotated design entity for
stimulating the global set/reset or 3-state enable signals. This port
does not actually exist on the configured part.
When running NGD2VHDL, you do not need to use the –gp switch
to create an external port if you instantiate a STARTUP block in your
implemented design. The port is already identified and connected to
the global set/reset or 3-state enable signal. If you do not use the –gp
option or a STARTBUF block, you must use special components, as
described in the following sections.

Using STARTBUF in VHDL
STARTBUF replaces STARTUP. With STARTBUF you can functionally
simulate the GSR/GR net in both function and timing simulation. By
connecting the input pin of the STARTBUF to a top-level port and
using STARTBUF as the source for all asynchronous set/reset signals
in a design, Xilinx M1 software can automatically optimize the design
to use the GSR/GR. Because you can use STARTBUF in functional
simulation (unlike STARTUP), when you use STARTBUF you can
map to the GSR/GR in a device. You can still use STARTUP, but it
does not always provide correct GSR/GR in HDL flows.
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The STARTBUF component passes a reset or 3-state signal in the
same way that a buffer allows simulation to proceed and also instantiates the STARTUP block for implementation. One version of
STARTBUF works for all devices, however, the XC5200 and the
XC4000 STARTUP blocks have different pin names. Implementation
with the correct STARTUP block occurs automatically. The following
shows an instantiation example of the STARTBUF component.
U1: STARTBUF port map (GSRIN => DEV_GSR_PORT, GTSIN
=>DEV_GTS_PORT, CLKIN => ‘0’, GSROUT => GSR_NET,
GTSOUT => GTS_NET, Q2OUT => open, Q3OUT => open,
Q1Q4OUT => open, DONEINOUT => open):

You can use one or both of the input ports (GSRIN and GTSIN) of the
STARTBUF component and the associated output ports (GSROUT
and GTSOUT). You can use pins left open to pass configuration
instructions to the implementation tools by connecting the appropriate signal to the port instead of leaving it open.

Instantiating a STARTUP Block in VHDL
The STARTUP block traditionally instantiates to identify the GR,
PRLD, or GSR signals for implementation. However, simulation can
occur only when the net attached to the GSR or GTS goes off the chip
because the STARTUP block does not have a simulation model. You
can use the new components described below to simulate global set/
reset or 3-state nets whether or not the signal goes off the chip.

Setting Direct Preset or Direct Clear
You can program each flip-flop and latch as either Preset or Clear but
not both. The device’s automatic assertion of its own GSR net asynchronously sets flip-flops and latches as either Preset or Cleared upon
completion of configuration. Use individual flip-flop and latch Preset
(PRE) and Clear (CLR) pins to set them as preset or cleared.
The power-on state of a register or latch and the selection of PRE or
CLR pin must match. For example, a register with a CLR pin assumes
the value of 0 on power-up. Alternatively, a register with a power-up
state of 0 can only have a CLR pin.
To get an async set or async reset FF, describe the behavior in the RTL
code. If you only want to describe the power-on state of an FF,
connect the async set or async reset signal of the RTL FF to the
ROCBUF.
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Increasing Performance with the GSR Net
Many designs have a net that initializes the majority of the design’s
flip-flops. If this signal initializes all the design’s flip-flops, you can
use the GSR net.
To have your HDL simulation match that of the resulting design,
modify your HDL code so that asserting the GSR signal presets or
clears every flip-flop and latch. You must ensure that this signal does
not get routed around general purpose interconnect but instead uses
the dedicated global routing resource. Disconnect this signal with the
Disconnect Net command after you compile your design but before
you save it.
Alternatively, the Xilinx tools move this signal on to the device’s
dedicated GSR routing network when the following conditions apply.
•

The asynchronous Preset or Clear pin of every register in your
design that has this pin connects to the same net.

•

That net connects to the GSR pin of the STARTUP block.

•

You use STARTBUF (see the “Using the Global Set/Reset Net”
section).

The following figure illustrates this flow.
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Figure 3-7 Increasing Performance with GSR Net
The following VHDL and Verilog examples illustrate a design that
uses the GSR net. The design contains two flip-flops, one reset and
one set when the signal RST is High.
The following example shows VHDL code before using the GSR net.
library IEEE;
use IEEE.std_logic_1164.all;
use IEEE.std_logic_unsigned.all;
entity gsr_ex is
port ( CLK,RST : in STD_LOGIC;
ST: buffer std_logic_vector (1 downto 0));
end gsr_ex;
architecture EXAMPLE of gsr_ex is
begin
process (CLK, RST)
begin
if RST= ‘1’ then
ST <= “01”;
elsif (CLK’event and CLK= ‘1’) then
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ST <= ST + “01”;
end if;
end process;
end EXAMPLE;

The following example shows Verilog code before using the GSR net.
module gsr_ex (CLK, RST, ST) ;
input
CLK ;
input
RST ;
output [1:0]
ST;
reg

[1:0]

ST;

always @(posedge CLK or posedge RST)
begin
if (RST == 1’b1)
ST = 2’b01 ;
else
ST = ST + 1’b1 ;
end
endmodule

Add the reset signal in your design to the GSR pin of the STARTUP
block. This makes the Xilinx tools move this signal on to the dedicated routing network if all other conditions are satisfied.
To utilize the GSR net, add the STARTUP block to your design by
instantiation, illustrated in the following examples. The following
example shows VHDL code using the GSR net.
library IEEE;
use IEEE.std_logic_1164.all;
use IEEE.std_logic_unsigned.all;
entity top_gsr is
port ( CLK,RST : in STD_LOGIC;
ST: buffer STD_LOGIC_VECTOR (1 downto 0));
end top_gsr;
architecture EXAMPLE of top_gsr is
component STARTUP
port ( GSR: in STD_LOGIC);
end component;
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component gsr_ex
port ( CLK,RST: in STD_LOGIC;
ST : buffer STD_LOGIC_VECTOR (1 downto 0));
end component;
begin
U1 : STARTUP port map (GSR=>RST);
U2 : gsr_ex port map (CLK=>CLK,RST=>RST,ST=>ST);
end EXAMPLE;

The following example shows Verilog code using the GSR net.
module top_gsr (CLK, RST, ST) ;
input
CLK ;
input
RST ;
output [1:0]
ST;
STARTUP U1 (.GSR(RST)) ;
gsr_ex U2 (.CLK(CLK), .RST(RST), .ST(ST)) ;
endmodule

Because the STARTUP block does not use any outputs in this
example, FPGA Compiler removes the STARTUP block unless you
specify the Dont Touch attribute for U1. You must issue this
command before inserting the I/O pads.

Using the Xilinx DesignWare Library
The XC4000E/L/EX/XL/XLA/XV and XC5200 DesignWare libraries
describe adders, subtracters, comparators, incrementers, and decrementers that map to the fast carry logic structures available in the
target architecture.

Improving Design Area and Speed
For XC4000E/L/EX/XL/XLA/XV and XC5200 designs using VHDL
or Verilog arithmetic operators, take advantage of the Xilinx DesignWare (XDW) library. This library contains the arithmetic functions
that utilize the XC4000E/L/EX/XL/XLA/XV and XC5200 dedicated
carry logic to improve both the area and speed of the design.
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The following table lists the VHDL and Verilog arithmetic operators
and the XDW modules to which they map.
Table 3-3

Arithmetic Operators for XDW Modules
Operators

XDW Module

+

ADD_SUB

–

ADD_SUB

<, <=, >, >=

COMPARE

+1

INC_DEC

–1

INC_DEC

The XDW library contains twos complement and unsigned binary
modules of widths 6, 8, 10, 12, 14, 16, 20, 24, 28, 32, and 48. Additionally, you can use available 64-bit widths for the COMPARE module
only. Operands falling between bit ranges map to the next higher
bit-width module. The Xilinx design implementation tools remove
any unused logic when implementing a smaller bit width or when
adding, subtracting, or comparing with a constant value.
The XDW library contains area and speed information for its
modules. This information allows FPGA Compiler and Design
Compiler to compare XDW implementations of arithmetic functions
to other DesignWare libraries available at compile time. XSI then
selects the implementation that best meets your timing and area
constraints.
XC4000E/L/EX/XL/XLA/XV devices accommodate two bits of
arithmetic function per CLB, and XC5200 devices accommodate four
bits per CLB. XC4000E/L/EX/XL/XLA/XV devices implement
arithmetic functions in one vertical column of CLBs. The carry propagation direction is upward in XC4000EX/XL/XLA/XV devices and
up or down in XC4000E/L devices. XC5200 devices implement arithmetic functions in two vertical columns of CLBs and have an upward
carry propagation direction.
The Xilinx place and route tools determine the best placement for the
CLB columns in the target device and break or wrap a column if
constrained by the physical boundaries of the device. However, as a
general rule, choose a target device that can accommodate the
“tallest” arithmetic structure in your design without altering the
shape of this structure. Selecting the correct device makes it easier to
place and route predominately data path-based designs.
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Creating Timing Specifications
The timing constraints issued to Synopsys to control the synthesis
process pass through to the design implementation tools to control
the place and route process. To get the best possible results, make
these constraints realistic and achievable.
During the synthesis of your design, area and timing constraints can
impact implementation almost as much as changes made to your
HDL code. Carefully apply area and timing constraints. During the
implementation of your design, timing constraints have a direct
impact on run time and performance verification. For example, the
run time required to find a place and route solution to support the 40
MHz operation of a design takes longer than that required to find a 4
MHz solution. Meaningful and detailed timing constraints also allow
the design implementation tools to report the status of your design’s
timing in terms of your timing goals.
The DC2NCF program converts timing constraints applied to your
design in the Synopsys environment to equivalent constraints that
control the Xilinx place and route process. Automatic translation of
these constraints offers an advantage because you do not need to
apply the constraints twice (once for Synopsys and again for Xilinx).
The constraints used by Xilinx are equivalent to those applied with
Synopsys.
DC2NCF supports translation of the following Synopsys timing
constraints.
•

create_clock

•

set_input_delay

•

set_output_delay

•

set_max_delay

•

set_false_path

If you have additional Synopsys timing constraint commands in your
Synopsys script file, DC2NCF issues a warning and does not translate
them.
DC2NCF translates a Synopsys DC file to a Xilinx Netlist Constraints
File (NCF). The DC file is a Synopsys script file containing the
constraints that have been applied to your design. EDIF2NGD or
XNF2NGD reads the output NCF file. The constraints in the NCF file
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become part of the NGO file produced by EDIF2NGD or XNF2NGD.
The following example shows how to translate a DC file to an NCF
file.
dc2ncf dc_file[.dc] [–o ncf_file[.ncf]] [–w | –wildcard]

When you specify the –w option, DC2NCF creates an NCF file with
wildcards. The –w option can significantly increase run time. An NCF
backup file without wildcards saves as ncf_file.ncf_orig. To use the
original file without wildcards, rename ncf_file.ncf_orig to ncf_file.ncf.

Following the DC2NCF Design Flow
Before running DC2NCF, apply your timing constraints to your
design and then compile it. Also, when using FPGA Compiler for
XC4000E/L/EX/XL/XLA/XV designs, run the Replace FPGA
command, then create a netlist and a corresponding script file that
contains the constraints.
DC2NCF can incorrectly translate the timing constraint commands in
user-created script files. Always generate script files as described in
the following sections using either DC Shell or Design Analyzer.

Creating the Netlist and Script File (Design Compiler)
You can use DC Shell or Design Analyzer to create your design’s
netlist and the Synopsys constraints script file.
From the DC Shell command line, perform the following steps.
1.

Flatten your design’s hierarchy by entering the following.
ungroup –all –flatten

2.

Enter the following to create the netlist.
write –format edif –hierarchy –output \
design_name.sedif
The “\” indicates you issue this command in one line, not two as
presented here.

3.

To write your design’s constraints as a Synopsys script file, enter
the following.
write_script > design_name.dc
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From Design Analyzer, perform the following steps.
1.

Select File→Save As
The Save File dialog box appears.

2.

Select the EDIF option in the File Format field. Change the extension to .sedif in the File Name field.

3.

Turn off the Save All Designs in Hierarchy option.

4.

Select OK.

5.

Select Setup→Command Window to get the command window.

6.

At the command window prompt, enter the following.
ungroup –all –flatten

7.

To write your design’s constraints as a Synopsys script file, select
the design setup function, File→Save Info→Design Setup.
The Save Design Setup dialog box appears.

8.

Select OK.

Creating the Netlist and Script File (FPGA Compiler)
Before you create the netlist or the constraints file, you must flatten
any hierarchy in your design. Flattening your design removes hierarchy information from the Synopsys internal database. However, the
hierarchical net names and instance names assigned to objects during
compilation are retained and written to the output netlist. The Xilinx
software reconstructs most of your design’s hierarchy from the information contained in the instance names and net names.
Use the DC Shell or Design Analyzer to flatten your design, create
your design’s netlist, and create the Synopsys constraints script file.
To flatten your design’s hierarchy prior to writing a netlist and
constraints file from the DC Shell command line, perform the
following steps.
1.

Enter the following to flatten the design.
ungroup –flatten –all

2.

To create your design’s netlist in XNF format, enter the following.
write –format xnf –output design_name.sxnf
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3.

To write your design’s constraints as a Synopsys script file, enter
the following.
write_script > design_name.dc

To flatten your design’s hierarchy from Design Analyzer, perform the
following steps.
1.

Select Setup→Command Window.
The Command Window appears.

2.

Enter the following at the command line.
ungroup –all –flatten

3.

Select File→ Save As.
The Save File dialog box appears.

4.

Select the XNF option in the File Format field. Change the .xnf
extension to .sxnf in the File Name field.

5.

Turn off the Save All Designs in Hierarchy option.

6.

Select OK.

7.

To write your design’s constraints as a Synopsys script file, select
the design setup function, File→Save Info→Design Setup.
The Save Design Setup dialog box appears.

8.

Select OK.

Understanding DC2NCF Translation Limitations
This section lists the Synopsys commands you can use to create
timing specifications for your Xilinx designs and provides information about DC2NCF support for the Synopsys timing commands.

Limitations of Create Clock
The Create Clock command applies a constraint of period_value nanoseconds to all paths between the registers reached by tracing forward
from the entries on the port_or_pin_list. A general description of the
Create Clock command follows.
•

Syntax
create_clock [port_or_pin_list] [–name clock_name] \
[–period period_value] [–waveform edge_list]
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•

Virtual clocks
DC2NCF does not support virtual clocks and therefore does not
support Create Clock statements without a port_or_pin_list.

•

Complex clock waveforms
Since DC2NCF only supports single-cycle clock waveforms, the
waveform edge_list variable can only contain two values.

•

Targets for Create Clock
DC2NCF translates the Create Clock command into the Xilinx
PERIOD constraint, applied to chip-level input (or bidirectional)
ports and to the outputs of primitive Xilinx cells. Therefore, the
port_or_pin_list variable can only include references to these types
of nodes.

Limitations of Set Input Delay and Set Output Delay
The Set Input Delay command specifies that data arriving at the
inputs listed in the port_or_pin_list delays externally by the number of
nanoseconds specified by delay_value.
The Set Output Delay command specifies that data arriving at the
outputs listed in the port_or_pin_list drives into an external delay of
delay_value nanoseconds.
Therefore, constrain internal paths starting (Set Input Delay) or
ending (Set Output Delay) at any of the nodes listed in the
port_or_pin_list more tightly to accommodate these external margins.
•

Syntax
set_input_delay delay_value \
[–clock clock_name [–clock_fall] \
[–level_sensitive]] \
[–rise | –fall] [–max] [–min] [–add_delay] \
port_or_pin_list
set_output_delay delay_value \
[–clock clock_name [–clock_fall] \
[–level_sensitive]] \
[–rise | –fall] [–max] [–min] \
[–add_delay] port_or_pin_list
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•

Minimum delay constraints
Normally, the –min switch specifies the minimum value of an
external delay. However, because Xilinx allows constraining only
maximum delays within a device, DC2NCF does not support the
–min switch. (This also makes the –max switch redundant.)

•

Rising and falling constraints
Because Xilinx does not categorize timing paths by their sensitivity to rising or falling edges at their inputs, DC2NCF does not
support the Rise, Fall, and Clock_fall switches.

•

Latch versus register path sources
Because Xilinx does not compute path delays differently
depending on the type of sequential cell that sources the path,
DC2NCF does not support the Level Sensitive switch.

•

Targets for Set Input Delay and Set Output Delay
DC2NCF translates the Set Input Delay and Set Output Delay
commands into the Xilinx OFFSET constraint, applied only to
chip-level input or bidirectional ports (Set Input Delay) and
output or bidirectional ports (Set Output Delay). Therefore, the
port_or_pin_list variable can only include references to these types
of objects. For example, external delays applied to the ports of
hierarchical sub-modules do not translate.
Arrival times specified with the –clock clock_name switch must
conform to the OFFSET command usage restrictions. Although
the clock referred to by clock_name can contain chip-level I/O
ports and cell pin-names, the translation of the Set Input Delay
and Set Output Delay commands applies only to those clocks
assigned to chip-level I/O ports. Therefore, specify arrival times
only with respect to clocks applied externally (not internally).

Limitations of Set Max Delay and Set False Path
The Set Max Delay command specifies the upper delay limits for all
paths that start at nodes listed in the from_list and end at nodes listed
in the to_list.
The Set False Path command specifies that paths starting at nodes
listed in the from_list and ending at nodes listed in the to_list are not
significant for timing.
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•

Syntax
set_max_delay delay_value [–rise | –fall] \
[–from from_list] [–to to_list] \
[–group_path group_name] [–reset_path]
set_false_path [–rise | –fall] \
[–setup | –hold] [–from from_list] [–to to_list] \
[–reset_path]

•

Rising and falling constraints
Because Xilinx does not categorize timing paths by their sensitivity to rising or falling edges at their inputs, DC2NCF does not
support the Rise and Fall switches.

•

Path Grouping (Set Max Delay)
Synopsys uses a path grouping mechanism for directing the logic
optimizer to certain areas of your design; this does not impact the
resulting timing specification. Therefore, DC2NCF does not
support the –group_path group_name switch.

•

Iterative path constraints
You can use the –reset_path switch prior to compilation to
remove a constraint between the indicated path start and end
points. Because DC2NCF reads script files generated after compilation, the –reset_path switch does not appear in the output script
file. Therefore, DC2NCF does not support the –reset_path switch.

•

Targets for Set Max Delay and Set False Path
DC2NCF translates the Set Max Delay and Set False Path
commands to several Xilinx timing constraint commands, adding
elements in the from_list and the to_list to Xilinx timegroups using
the TIMEGROUP command. Issue a constraint between the two
timegroups using the FROM:<group>:TO:<group>:<delay>ns
(Set Max Delay) and FROM:<group>:TO:<group>:TIG; (Set False
Path) commands.
Xilinx allows only certain nodes for path start points and end
points. These nodes include RAMs, latches, registers and I/O
ports. Therefore, from_list and to_list can only include references
to these types of objects.
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•

The Replace FPGA Command removes Set Max Delay and Set
False Path constraints (FPGA Compiler only)
The Replace FPGA command removes any Set Max Delay or Set
False Path constraints. As a result, when you use the Write Script
command after Replace FPGA, Write Script does not include in
the DC file it creates any Set Max Delay or Set False Path
constraints applied before the Replace FPGA. To include these
constraints in the DC file, you must re-apply them after you use
the Replace FPGA command. Also, you must use the full hierarchical names with the Set Max Delay and Set False Path
commands.

The VHDL Set Max Delay and Set False Path example follows.
analyze –f vhdl file1.vhd
analyze –f vhdl file2.vhd
.
.
elaborate TOPLVLENTITY
set_port_is_pad “*”
insert_pads
/* Set Timing Constraints */
create_clock...
set_max_delay...
set_false_path...
set_input_delay...
set_output_delay...
compile
replace_fpga
ungroup –all –flatten
/ *Reapply Timing Constraints */
report_port
all_clocks
all_registers
set_max_delay...
set_false_path...
write_script > “top.dc”
sh dc2ncf “top.dc”
exit
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The Verilog Set Max Delay and Set False Path example follows.
read –f verilog file1.v
read –f verilog file2.v
.
.
read –f verilog filen.v
set_port_is_pad “*”
insert_pads
/* Set Timing Constraints */
create_clock...
set_max_delay
set_false_path
compile
replace_fpga
ungroup –all –flatten
/* Reapply Timing Constraints */
report_port
all_clocks
all_registers
set_max_delay...
set_false_path...
write_script > “top.dc”
sh dc2ncf “top.dc”
exit

Set Multicycle Path
DC2NCF does not support translation of the Set Multicycle Path
command. However, you can achieve equivalent functionality with
the Set Max Delay command. These two constraints differ in the
interpretation of their numerical field.
The syntax of the two commands follows.
set_multicycle_path path_multiplier,[–rise | –fall] \
[–setup | –hold] [–start | –end] \
[–from from_list] [–to to_list] [–reset_path]
set_max_delay delay_value [–rise | –fall] \
[–from from_list] [–to to_list] \
[–group_path group_name] [–reset_path]

Delay_value specifies the absolute delay value in nanoseconds for the
path between the indicated start and end points. The period of the
clock that controls the path between the indicated start and end
points multiplies path_multiplier and specifies the path delay.
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You can use the Set Max Delay command instead of the Set Multicycle Path command by using the clock period multiplied by the
path_multiplier for the delay_value. The following example illustrates
this command substitution.
create_clock my_clock_port –period 50
set_multicycle_path 2 –from find(cell,“a_reg”) \
–to find(cell,“b_reg”)

Alternatively, you can express this as shown in the following
example.
create_clock my_clock_port –period 50
set_max_delay 100 –from find(cell,“a_reg”) \
–to find(cell,“b_reg”)

Note: When DC2NCF translates Synopsys timing commands into
Xilinx syntax, point-to-point exception commands (such as Set Max
Delay and Set False Path) result in timegroup statements in the
resulting NCF file. For identification purposes, the names allocated to
timegroups include the line number of the related command in the
Synopsys script file. The following example shows the translation of
a line of a Synopsys script file.
set_max_delay 57 –from find(clock,clocka)

The DC2NCF output NCF file appears as follows.
TIMEGROUP tg_5_dest = FFS:LATCHES:RAMS:PADS;
ts_01 = FROM:clocka:TO:tg_5_dest:57;

Compiling Your Design
After you insert the I/O pads, you can optimize your design for area,
speed, or a combination of both. To get the most effective results from
FPGA Compiler, apply accurate and achievable constraints. For
example, if you set a timing goal of 0 ns on all ports, FPGA Compiler
attempts to meet this goal by duplicating logic to reduce critical
paths. This can result in a significant and possibly unwarranted
increase in CLB and interconnect usage.
The following sections describe the commands you use to compile
and optimize your HDL design.
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Optimizing Logic Across Hierarchical Boundaries
CLBs contain Boolean logic implemented in both function generators
and flip-flops. Compiling a hierarchical design or a design that uses a
DesignWare module does not optimize the logic across the hierarchical boundary because DesignWare modules exist inside their own
hierarchical boundaries. Therefore, some CLBs only implement flipflops and contain unused function generators and other CLBs only
implement function generators and contain unused flip-flops. Additionally, the Boolean logic in one hierarchy is not optimized with that
in another to reduce the CLB area or logic levels.
The choice of hierarchical boundaries can have a significant impact
on the area and speed of the synthesized design. Using FPGA
Compiler, you can optimize a design while preserving these hierarchical boundaries.
The TOP design, illustrated in the following figure, references two
sub-blocks, one completely combinatorial (block1) and one
completely sequential (block2).
TOP
BLOCK1
IN1

BLOCK 2
D

FDC

Q

IN2
OR2

OUT1

C

CLOCK
X4887

Figure 3-8 Sequential and Combinatorial Design
FPGA Compiler cannot move logic across levels of hierarchy. To
maintain the hierarchy you need two CLBs to implement the TOP
design. FPGA Compiler uses one CLB to implement the OR gate and
another to implement the FDC flip-flop.
However, if FPGA Compiler merges two subdesigns into a single
level of hierarchy, you need only one CLB to implement the TOP
design, illustrated in the following figure. FPGA Compiler can merge
the combinatorial and sequential logic into one CLB.
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TOP
CLB
IN1

D

FDC

Q

OUT1

IN2
OR2
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Figure 3-9 Merging into a Single Level of Hierarchy
To check if FPGA Compiler can combine the combinatorial and
sequential logic across hierarchical boundaries, optimize the design
with and without hierarchy, and then compare the results as
described in the following sections.
By default, FPGA Compiler does not flatten your design hierarchy.
You must use the Compile command with the Ungroup All option to
flatten your design. However, FPGA Compiler only partially optimizes logic across hierarchical modules. Full optimization is possible
across those parts of your design hierarchy ungrouped in FPGA
Compiler. Flatten or reconstruct hierarchy artificially prior to using
the Compile command by issuing the Group and Ungroup
commands. Follow the guidelines for controlling flattening in the
Synopsys Design Compiler Family Reference Manual.

Using a Flattening Optimization Strategy
Flattening eliminates the existing logic structure. In general, you can
flatten random control logic because automatic structuring usually
improves upon manual structuring. For FPGA designs, flatten
designs when the number of CLBs needed to implement a Boolean
function seems too high or there are too many logic levels. You probably do not need to flatten regular or highly structured designs such
as adders and ALUs designed with an explicit structure.
Flattening works especially well for the FPGA CLB structure because
FPGA Compiler has a built-in optimizer for Boolean logic. This algorithm works efficiently when the structure decomposes sufficiently so
that the Boolean logic can map into the CLB function generators.
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Compiling the Design with Hierarchy
To compile the design and maintain its hierarchy, enter the following
command.
compile –map_effort [low|med|high] \
–boundary_optimization

This command enables some logic optimization to occur across hierarchical boundaries. For more information on this option, refer to the
Synopsys Design Compiler Family Reference Manual.
Even a flat design can end up containing hierarchical blocks after
compiling. These hierarchical blocks contain either Synopsys DesignWare modules or XDW modules mapped during the optimization
process.

Compiling the Design Without Hierarchy
To compile the design without hierarchy, enter the following
command.
compile –map_effort [low|med|high] –ungroup_all

This command creates a flattened design and then optimizes it.
If your design contains Synopsys DesignWare modules (after the first
compile), re-compile your design using the Ungroup All option. This
command does not optimize XDW modules but instead optimizes the
entirely combinatorial Synopsys DesignWare modules. You cannot
optimize XDW modules because FPGA Compiler interprets them as
“black boxes.” The CLBs that implement the XDW parts have unused
flip-flops but the Xilinx design implementation tools can correct this
later on in the implementation flow.
Using the Ungroup command with the All Flatten option and then
compiling differs substantially from invoking the Compile command
with the Ungroup All option. If you run the Ungroup command
before using the Compile command, DesignWare components
inferred during compilation retain their hierarchy and can cause the
usage of unnecessary CLBs. See your Synopsys documentation for
more information on the Ungroup command.
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Compiling a Design with Instantiated I/O Cells
This section describes the design flow if your design contains instantiated I/O cells. If you instantiate all I/O buffers (FPGA Compiler
does not need to automatically insert I/O buffers), do not use the Set
Port Is Pad and Insert Pads commands. Place a Dont Touch attribute
on all instantiated I/O buffers.
If your design contains some instantiated I/O buffers and you want
FPGA Complier to automatically insert the rest of the I/O buffers, do
the following.
•

Use the Set Port Is Pad command only on the I/Os that you want
the FPGA Compiler to insert.

•

Place a Dont Touch attribute on all instantiated I/O buffers
before the design is compiled.

•

Issue the Insert Pads command.

See the bidi_reg.vhd and bidi_reg.v examples in the “Inserting Bidirectional I/Os” section for designs that contain both instantiated I/
Os and I/Os inserted using FPGA Compiler. The bidi_reg.script
(VHDL) in the “Inserting Bidirectional I/Os” section provides an
example script file illustrating the correct design flow.

Compiling XC4000E/L/EX/XL/XLA/XV Designs
The following sample script file demonstrates how to compile your
XC4000E/L/EX/XL/XLA/XV designs using FPGA Compiler.
/* ==================================================*/
/*
Sample Script for Synopsys to Xilinx Using
*/
/*
FPGA Compiler
*/
/* Targets the Xilinx XC4028EX-3 and assumes a VHDL */
/*
source file by way of an example.
*/
/*
For general use with XC4000E/EX architectures. */
/*
Not suitable for use with XC3000A/XC5200
*/
/*
architectures.
*/
/* ==================================================*/
/*
/*
/*
/*
/*

=================================================
Set the name of the design’s top-level module.
(Makes the script more readable and portable.)
Also set some useful variables to record the
designer and company name.
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/* ================================================= */
TOP = calc
MOD1 = clockgen
MOD2 = count3
MOD3 = statmach
MOD4 = stack
MOD5 = bardec
MOD6 = seg7dec
MOD7 = alu
MOD8 = control
MOD9 = switch7
MOD10 = debounce
designer = “XSI Team”
company = “Xilinx, Inc”
/*
/*
/*
/*

=================================================
Analyze and Elaborate the design file and specify
the design file format.
=================================================

analyze –format
analyze –format
analyze –format
analyze –format
analyze –format
analyze –format
analyze –format
analyze –format
analyze –format
analyze –format
analyze –format
elaborate TOP

vhdl
vhdl
vhdl
vhdl
vhdl
vhdl
vhdl
vhdl
vhdl
vhdl
vhdl

*/
*/
*/
*/

MOD1 + “.vhd”
MOD2 + “.vhd”
MOD3 + “.vhd”
MOD4 + “.vhd”
MOD5 + “.vhd”
MOD6 + “.vhd”
MOD7 + “.vhd”
MOD8 + “.vhd”
MOD9 + “.vhd”
MOD10 + “.vhd”
TOP + “.vhd”

/* ================================================= */
/* Set the current design to the top level.
*/
/* ================================================= */
current_design TOP
/* ================================================= */
/* Set the synthesis design constraints.
*/
/* ================================================= */
remove_constraint –all

Xilinx/Synopsys Interface Guide — 2.1i

3-59

Xilinx/Synopsys Interface Guide
/* ================================================= */
/* Apply dont_touch attributes to instantiated prims */
/* ================================================= */
dont_touch STARTUPBLK
dont_touch “OSCILLATOR/OSCILLATOR”
dont_touch “OSCILLATOR/CLOCK_BUF”
/*
/*
/*
/*
/*
/*

=================================================
Indicate those ports on the top-level module that
should become chip-level I/O pads. Assign any I/O
attributes or parameters and perform the I/O
synthesis.
=================================================

*/
*/
*/
*/
*/
*/

set_port_is_pad “*”
set_pad_type –slewrate HIGH all_outputs()
insert_pads
/* ================================================= */
/* Synthesize and optimize the design
*/
/* ================================================= */
compile –boundary_optimization
/* ================================================= */
/* Write the design report files.
*/
/* ================================================= */
report_fpga > TOP + “.fpga”
report_timing > TOP + “.timing”
/* ================================================= */
/* Write out the design to a DB file. (Post compile) */
/* ================================================= */
write –format db –hierarchy –output TOP + “_compiled.db”
/* ================================================= */
/* Replace CLBs and IOBs with gates.
*/
/* ================================================= */
replace_fpga
/* ================================================= */
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/* Set the part type.
*/
/* ================================================= */
set_attribute TOP “part” –type string “4028expg299-3”
/* ================================================= */
/* Write out the design to a DB. (Post replace_fpga) */
/* ================================================= */
write –format db –hierarchy –output TOP + “.db”
/*
/*
/*
/*

=================================================
Flatten the design's hierarchy to rationalize
netlist and constraints files
=================================================

*/
*/
*/
*/

ungroup –all –flatten
/* ================================================= */
/* Save design in XNF format as <design>.sxnf
*/
/* ================================================= */
write –format xnf –hierarchy –output TOP + “.sxnf”
/*
/*
/*
/*

=================================================
Write-out the timing constraints that were
applied earlier.
=================================================

*/
*/
*/
*/

write_script > TOP + “.dc”
/*
/*
/*
/*
/*
/*
/*

================================================= */
Call the Synopsys-to-Xilinx constraints translator*/
utility DC2NCF to convert the Synopsys constraints*/
to a Xilinx NCF file. You may want to view
*/
dc2ncf.log to review the translation process.
*/
================================================= */
sh dc2ncf TOP + “.dc”

*/

/* ================================================= */
/* Exit the Compiler.
*/
/* ================================================= */
exit
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/* ================================================= */
/* Now run the Xilinx design implementation tools.
*/
/* ================================================= */

Creating the Area Report
FPGA Compiler reports area with the Report FPGA command as
follows.
report_fpga
The statistics reported by this command include the number of the
following elements used in your design.
•

F, G, and H function generators

•

XDW cells

•

Instantiated cells

•

3-state buffers

•

Flip-flops

•

IOBs

The Report FPGA command also reports the number of CLBs used
for the design on the basis of the mapping performed by FPGA
compiler.
The Report FPGA command provides an accurate CLB count when
FPGA Compiler provides packing information to the place and route
tools. However, the Synopsys output netlist suppresses packing data.
As a result, the actual CLB count can vary between FPGA Compiler’s
Report FPGA count and MAP’s mapping report. The Synopsys
output netlist suppresses packing data because it impacts the
routability of the design. For better results with the Xilinx tools,
ensure that the software controls the allocation of flip-flops and function generators to CLBs. You can reactivate the Synopsys packing
data.
The reported number of CLBs can vary during design implementation, however, the number of flip-flops, F, G, and H function generators does not. Therefore, you can accurately assess a design’s area in
these terms. Use the Synopsys CLB count as a conservative estimate.
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Run the Report FPGA command after compiling your design because
the Compile command maps the logic into CLBs and IOBs. Also, run
this command before replacing the CLB and IOBs with gates (before
running the Replace FPGA command).
The area utilization report below illustrates the Report FPGA output
for the bidi_reg design. The report shows the number of CLBs used.
*************************************
Report : fpga
Design : bidi_reg
Version: v3.4b
Date
: Tues Dec 10 09:22:21 1996
*************************************
Xilinx FPGA Design Statistics
----------------------------FG Function Generators
H Function Generators
Number of CLB cells:
Number of Hard Macros and
Other Cells:
Number of CLBs in
Other Cells:
Total Number of CLBs:

2
0
2

Number of Ports:
Number of Clock Pads:
Number of IOBs:

8
2
2

Number of Flip Flops:
Number of 3-State Buffers:

4
4

Total Number of Cells:

14

4
0
2

Evaluating Timing Delays
The Synopsys tools report all delays in nanoseconds. The reported
delays include logic-level and interconnect delays. Because FPGA
Compiler synthesizes CLBs and IOBs (XC4000E/L/EX/XL/XLA/XV
devices) or LUTs and flip-flops (XC3000A, XC3100A/L, and XC5200
devices), it reports logic-level delays with a higher degree of accuracy
than Design Compiler. Because Design Compiler synthesizes only
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logic gates, it provides only estimates of logic-level delays. Logiclevel delays are worst case.
Both FPGA Compiler and Design Compiler estimate possible interconnect delays on the basis of a net’s fanout. These estimates allow
you to evaluate your design’s performance prior to performing place
and route. FPGA Compiler applies the wire-load model only to nets
between CLBs and IOBs (XC4000E/L/EX/XL/XLA/XV devices) or
between LUTs, I/Os, and flip-flops (XC3000A, XC3100A/L, and
XC5200 devices). Design Compiler’s estimates of interconnect delays
based on fanout match FPGA Compiler’s. However, because Design
Compiler does not have information on how your design maps and
packs into LUTs or CLBs, it applies the wire-load model to every net
in your design. This results in a less accurate net contribution to
overall path delays. You can use either average or worst-case wireload models.
To evaluate the timing results, use the Report Timing command.
report_timing

Refer to the Synopsys Design Compiler Family Reference Manual for
information on other report options.
Run the Report Timing command after compiling the design because
the Compile command maps the logic into CLBs and IOBs, and
before running the Replace FPGA command, which replaces the
CLBs and IOBs with gates.
Only XC4000E/L/EX/XL/XLA/XV designs require the Replace
FPGA command.
Synopsys assigns a default “average case” wire-load model to all nets
in your design. Refer to the “Setting the Wire-Load Model” section at
the beginning of this chapter for more information.

Generating Reports for Debugging
FPGA Compiler includes additional commands that provide CLB
and IOB information for debugging purposes.
Use the following commands before using the Replace FPGA
command to replace CLBs and IOBs with gates.
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Generating a Configuration Report
You can generate a report that gives you CLB and IOB configuration
information similar to the reports generated with the Xilinx software.
This report contains information cell configuration and the logic
function it implements.
To generate a CLB and IOB configuration report, first generate a
symbol or schematic view for the design using either of the following
methods.
•

From Design Analyzer Menu, select Tools→FPGA Compiler→Report→Cell→Apply.

•

From the DC shell prompt, enter report_cell, ENTER.

The system displays the following output in the Command window.
*************************************
Report : cell
Design : count8
Version: v3.4b
Date
: Tues Dec 10 09:22:21 1996
*************************************
Attributes:
b - black box (unknown)
BO - reference allows boundary optimization
h - hierarchical
n- noncombinational
r - removable
u- contains unmapped logic
Cell
Reference
Library
Area
Attributes
------------------------------------------------------------------------U62
iob_4000
xfpga_4000-5
1.00
n
U64
iob_4000
xfpga_4000-5
1.00
n
U66
iob_4000
xfpga_4000-5
1.00
n
U68
iob_4000
xfpga_4000-5
1.00
n
U70
iob_4000
xfpga_4000-5
1.00
n
U72
iob_4000
xfpga_4000-5
1.00
n
U74
iob_4000
xfpga_4000-5
1.00
n
U76
iob_4000
xfpga_4000-5
1.00
n
U78
iob_4000
xfpga_4000-5
1.00
n
U80
iob_4000
xfpga_4000-5
1.00
n
U82
BUFG_F
xprim_4000-5
0.00
n
U83
clb_4000
xfpga_4000-5
1.00
n
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U85
clb_4000
xfpga_4000-5
1.00
n
U87
clb_4000
xfpga_4000-5
1.00
n
U89
clb_4000
xfpga_4000-5
1.00
n
add_21/plus/LEFT_UNSIGNED_ARG_799
count8_inc_dec_ub_8_0
4.00
BO, h, n
------------------------------------------------------------------------Total 16 cells
18.00
Detailed FPGA Configuration Information:
Cell Name: U62
TYPE: IOB
OUT:O
PAD:FAST
I1:
I2:
TRI:
Cell Name: U64
OUT:O
PAD:FAST

TYPE: IOB

Cell Name: U66
OUT:O
PAD:FAST

TYPE: IOB

Cell Name: U68
OUT:O
PAD:FAST

TYPE: IOB

Cell Name: U70
OUT:O
PAD:FAST

TYPE: IOB

Cell Name: U72
OUT:O
PAD:FAST

TYPE: IOB

Cell Name: U74
OUT:O
PAD:FAST

TYPE: IOB

Cell Name: U76
OUT:O
PAD:FAST

TYPE: IOB

Cell Name: U78
OUT:O
PAD:FAST

TYPE: IOB

Cell Name: U80

TYPE: IOB
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OUT:O
PAD:FAST
Cell Name: U83
X:
H1:
DX:DIN

I1:
TYPE: CLB
Y:
DIN:C1
DY:G

EQUATE G = (G1)
FFX_NAME:QOUT_reg<1>
Cell Name: U85
X:
H1:
DX:DIN

TYPE: IOB
Y:
DIN:C1
DY:G

EQUATE G = (G1)
FFX_NAME:QOUT_reg<3>
Cell Name: U87
X:
H1:
DX:DIN

TYPE: IOB
Y:
DIN:C1
DY:G

EQUATE G = (G1)
FFX_NAME:QOUT_reg<5>
Cell Name: U89
X:
H1:
DX:DIN

TYPE: IOB
Y:
DIN:C1
DY:G

EQUATE G = (G1)
FFX_NAME:QOUT_reg<7>

I2:

TRI:

XQ:QX
YQ:QY
SR:C2
EC:C3
FFX:EC:RESET:K
FFY:EC:RESET:K
FFY_NAME:QOUT_reg<0>

XQ:QX
YQ:QY
SR:C2
EC:C3
FFX:EC:RESET:K
FFY:EC:RESET:K
FFY_NAME:QOUT_reg<2>

XQ:QX
YQ:QY
SR:C2
EC:C3
FFX:EC:RESET:K
FFY:EC:RESET:K
FFY_NAME:QOUT_reg<4>

XQ:QX
YQ:QY
SR:C2
EC:C3
FFX:EC:RESET:K
FFY:EC:RESET:K
FFY_NAME:QOUT_reg<6>

Generating a Hierarchical Schematic
As an alternative to interpreting the Report Cell output listing, you
can direct FPGA Compiler to replace all CLB and IOB cells with an
equivalent set of logic from the target libraries. Use the generated
schematic to determine what logic implemented the CLBs and IOBs.
To generate a hierarchical CLB and IOB schematic, perform the
following steps.
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1.

Save your original design as a DB file using one of the following
methods. You do this because the commands used to generate the
hierarchical CLB and IOB schematic alter your design’s hierarchy
and logical representation.
Select File→Save As→File Format ‘DB’ from the Design
Analyzer menu then click on OK, or enter the following in the
command window.
write –format db –hierarchy –output design.db

2.

Select Tools→FPGA Compiler→FPGA Cells to Gates
Options from the Design Analyzer menu, or enter the following
in the command window.
replace_fpga

3.

After you finish viewing the hierarchical schematic, read in the
original DB file using one of the following methods.
Select File→Read→File Format ‘DB’ from the Design
Analyzer menu, specifying the appropriate file name. Then click
on OK, or enter the following in the command window.
read –format db design.db

Creating a Level for Each CLB and IOB
Create a hierarchy level for each CLB and IOB or a hierarchy level for
each function generator to assist you in locating logic or signals for
debugging purposes. To create levels of hierarchy in Design
Analyzer, select Tools→FPGA Compiler→FPGA Cells to Gates
Options→Create a Level of Hierarchy for each CLB and
IOB.
You can also enter the following at the DC Shell prompt.
replace_fpga –group_cells

After you select these options, the resulting logic does not accurately
reflect the timing of the actual CLB and IOB implementation. Timing
or area reports then produce inaccurate results.
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Generating a Level for Each Function Generator
Generate hierarchical schematics that show the logic in each function
generator it implements. This process replaces each CLB by an F, G,
or H function generator, along with the used flip-flops. The function
generators add an additional level of hierarchy. To create a level of
hierarchy for each function generator, select Tools→ FPGA Compiler→FPGA Cells to Gates Options→Create a Level of Hierarchy for each “Table-lookup” from the Design Analyzer
menu.
You can also enter the following at the DC Shell prompt.
replace_fpga –group_tlus

You can now view the implementation of the function generators.

Writing and Saving Your Design
After your design meets your timing and area requirements, you can
save the design as a DB file. For XC4000E/L/EX/XL/XLA/XV
devices and FPGA Compiler only, replace the CLBs and IOBs with
gates. For FPGA Compiler, set the design part type and any other
supporting information. Then, write and save your design as a netlist
in either XNF (FPGA Compiler and FPGA Express) or EDIF (Design
Compiler and FPGA Compiler II) formats.

Saving the DB File
Save the Synopsys database file before converting your design to
gates by running the Replace FPGA command (XC4000E/L/EX/XL/
XLA/XV and FPGA Compiler only). If you use the Replace FPGA
command options for debugging, such as Group TLUS and Group
Cell, save the DB file before running these debugging options.
To save the DB file, choose one of the following methods.
•

Enter the following from the Design Analyzer menu.
File→Save As
File name: design_name.db
File Format: db
Save all Designs in Hierarchy: on
OK
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•

Type the following at the command line. (Select the top level of
your design.)
write –format db –hierarchy –output design_name.db

Replacing CLBs and IOBs with Gates
This section applies to XC4000E/L/EX/XL/XLA/XV devices and
FPGA Compiler.
After compiling with FPGA Compiler, XC4000E/L/EX/XL/XLA/
XV designs contain CLB and IOB elements used to determine the best
implementation of a design for a given set of constraints. Before
writing an output netlist, you must convert these CLBs and IOBs into
gates recognizable by the Xilinx software. The mapping information
passes to the netlist with the FMAP, HMAP, and, optionally, BLKNM
parameters, so you can map your design according to FPGA
Compiler’s directions.

Invoking the Replace FPGA Command
Enter the following command at the command line at the top level of
your design.
replace_fpga

Replacing CLBs and IOBs in Designs with Hierarchy
Running the Replace FPGA command with either the Group Cells or
the Group TLUS option and then writing the netlist file generates
netlists for each level of hierarchy in your design. If you use the
Group Cells option, each CLB transforms into a level of hierarchy
with a netlist created for each CLB. Similarly, if you use the Group
TLUS option, each function generator transforms into a level of hierarchy.
If you use these options, perform the following steps.
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Delete the design from memory.

2.

Read in the saved DB file saved prior to the Replace FPGA
command.

3.

Run the Replace FPGA command without any options.
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Controlling the Synopsys Mapping
This section applies only to FPGA Compiler.
By default, the FPGA Compiler XNF Writer contains information on
how it should map the logic into the CLB and IOBs. FPGA Compiler
uses the FMAP and HMAP symbols to map Boolean logic into F and
H function generators, and the BLKNM attribute to group flip-flops
and function generators into a CLB.
When the XNF Writer includes FPGA Compiler’s mapping information in the netlist, the accuracy of the estimated timing information
increases.
FPGA Compiler provides efficient mapping information, so leave the
mapping on. However, using FPGA Compiler to perform mapping
decreases the MAP program’s processing time.
Block names can restrict placement and routing. For this reason,
FPGA Compiler by default does not write the BLKNM attributes.
The following section describes how to remove FMAP and HMAP
information and restore BLKNM attributes.

Removing FMAP and HMAP Symbols
To remove the FMAP and HMAP mapping, enter the following at the
command line.
set_attribute find(design,"*") \
"xnfout_write_map_symbols" –type boolean FALSE

Restoring BLKNM Attributes
To restore the creation of BLKNM attributes, enter the following at
the command line.
set_attribute find(design,"*") \
"xnfout_use_blknames" –type boolean TRUE
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Setting the Design Part Type
Type the following command at the command line to select a specific
part for the design. The following example uses a 4005EPC84–4
device.
set_attribute design_name "part" \
–type string "4005epc84–4"

You can also specify the part type when running NGDBuild.

Saving the Design Netlist File
Follow the instructions in the appropriate section below to save your
design netlist file.

Saving your Netlist in EDIF Format (Design Compiler)
Save your design netlist file in EDIF format with a .sedif extension to
denote its source. NGDBuild processes netlists from Synopsys in a
slightly different way than other netlists. The .sedif extension indicates to NGDBuild to use the Synopsys design flow.
You can save your design as an SEDIF file by either of the following
methods.
•

Select your design and then select the following from the Design
Analyzer menu.
File→Save As
File name: design_name.sedif
File Format: edif
Save all Designs in Hierarchy: on
OK

•

Enter the following at the command line. (Select the top level of
your design.)
write –format edif –hierarchy –output \
design_name.sedif
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Saving your Netlist in XNF Format (FPGA Compiler)
Save your design netlist file in XNF format with a .sxnf extension to
denote its source. NGDBuild processes netlists from Synopsys in a
slightly different way than other netlists. The .sxnf extension indicates to NGDBuild to use the Synopsys design flow.
The XNF netlist format can convey your design’s logical hierarchy
only with hierarchical instance names and net names. Therefore,
flatten your design’s hierarchy prior to writing out a netlist in XNF
format. Although this removes the design hierarchy from the
Synopsys design database, hierarchical net and instance names
remain unchanged. As a result, the XNF file still conveys your
design’s hierarchy. After you have flattened your design, you can
then write out the netlist.
You can save your design as an SXNF file by either of the following
methods.
•

Select your design and then select the following from the Design
Analyzer menu.
Setup→Command Window
ungroup –all –flatten
File → Save As
File name: design_name.sxnf
File Format: xnf
Save all Designs in Hierarchy: off
OK

•

Enter the following at the command line. (Select the top level of
your design.)
ungroup –all –flatten
write –format xnf –output design_name.sxnf
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To translate your design to a bit file so the Xilinx tools can program
your device, perform the following steps.
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1.

Run NGDBuild on the SXNF or SEDIF file to create an NGD file.

2.

Run the MAP program on the NGD file to create a mapped NCD
file.

3.

Run the TRACE program to determine if PAR will meet your
timing goals.

4.

Run PAR on the NCD file to place and route your design.

5.

Run TRACE again on your placed and routed design.

6.

Run NGDAnno on your routed design to create an NGA file.

7.

Run either NGD2VHDL or NGD2VER on the NGA file to create a
VHD or VER file that can be simulated with the appropriate
simulators.

8.

Run the BitGen program to create a bitstream for programming
the FPGA.
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Chapter 4

Using Core Generator and LogiBLOX
Core Generator is a graphic user interface (GUI) tool for creating
RLOC’d cores. Core Generator optimizes core layout to the target
FPGA architecture, allowing higher performance. Core Generator
differs from LogiBLOX but this information is included here because
both provide a GUI toolset you can use in creating your design.
Refer to the Core Generator documentation for more information
about using that product with XSI.
LogiBLOX is a GUI tool for creating high-level modules such as
counters, shift registers, and multiplexers. LogiBLOX includes both a
library of generic modules and a set of tools for customizing them.
You can also use the modules you create in your HDL designs. LogiBLOX generates a simulation model (VHDL, EDIF, or Verilog) for
each LogiBLOX module during design entry. This enables immediate
simulation of LogiBLOX designs without logic implementation.
Refer to the LogiBLOX Reference/User Guide for a complete explanation of LogiBLOX.
This chapter includes the following sections.
•

“Using Core Generator”

•

“Specifying Inputs and Outputs in LogiBLOX”

•

“Using LogiBLOX in the HDL Design Flow”

•

“Instantiating RAM”
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Using Core Generator
The basic flow of using Core Generator with XSI involves selecting a
core in Core Generator, entering parameters, then generating the core.
You then instantiate the cores in your XSI design.
The Core Generator documentation provides details about how to
use Core Generator with XSI.
Apply a Dont Touch attribute to all Core Generator cores used in XSI.

Specifying Inputs and Outputs in LogiBLOX
Use the LogiBLOX Module Selector GUI, shown in the following
figure, to create LogiBLOX modules. Specifying a LogiBLOX module
consists of selecting or deselecting optional pins on the symbol, and
specifying various module attributes, resulting in a module customized for a specific function.
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Figure 4-1 Module Selector
After you complete the module specification, LogiBLOX uses its
symbol generator, model generator, and netlist generator to create the
following three outputs and store them in the current project directory.
•

A schematic symbol for inclusion on the schematic
The symbol generator creates a symbol definition file that your
third-party interface converts into a schematic symbol.
For Synopsys or synthesis tools, the symbol generator creates a
Verilog/VHDL instantiation template.
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•

An RTL HDL simulation model
The model generator creates an RTL HDL simulation model for
the LogiBLOX module.
The RTL model permits immediate simulation of your design in
those environments that support mixed schematic and RTL simulation.

•

Gate-level netlists, produced as an alternative simulation
medium
The netlist generator creates a gate-level netlist for the LogiBLOX
module converted to the third-party’s simulation format. These
netlists permit immediate simulation of the design in gate-level
simulation environments.

Using LogiBLOX in the HDL Design Flow
You can instantiate LogiBLOX components in your HDL code to take
advantage of their high-level functionality.
Express each LogiBLOX module in HDL code with a component
declaration describing the module type and a component instantiation describing how the module connects to the other design
elements.
Follow these steps to use the LogiBLOX program.
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1.

Invoke the Module Selector from an icon or from the command
line.

2.

Configure your project directory using the LogiBLOX Setup
window. The default directory is your current directory.

3.

Select a base module type (for example, Counter, Memory, or
Shift-register)

4.

Customize the module by selecting pins and specifying
attributes.

5.

Press the OK button after completely specifying a module.
Pressing OK initiates the generation of a component instantiation
declaration, an RTL model, and an implementation netlist.

6.

Deposit the HDL module declaration or instantiation into your
HDL design.
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7.

Complete the signal connections of the instantiated LogiBLOX
module to the rest of your HDL design.

8.

Conduct functional simulation on your design. The HDL simulator reads the component declaration and looks for an RTL
model.

9.

Apply a Dont Touch attribute to all LogiBLOX modules.

10. Implement your design by invoking the Xilinx implementation
tools.
11. Simulate your post-layout design by converting your design back
to a timing netlist and invoking the back-annotation flow.

Instantiating RAM
You can implement memory using LogiBLOX, creating RAM and
ROM between 1 to 32 bits wide and 2 to 256 bits deep. Using LogiBLOX to add RAM or ROM to your design provides an efficient
implementation of your memory in addition to a simulation model
for RTL simulation.
Note: For Verilog designs, use the Remove Design command on
instantiated LogiBLOX memory before writing out the design.
You can instantiate RAM in your designs using LogiBLOX, as shown
in the following VHDL and Verilog examples. A sample script file
follows each example. Refer to the LogiBLOX Reference/User Guide for
more information about using LogiBLOX.
The following example shows how to instantiate RAM using LogiBLOX with VHDL.
library IEEE;
use IEEE.std_logic_1164.all;
entity test is
port (ADDRESS: IN std_logic_vector(5 downto 0);
DATAOUT: OUT std_logic_vector(3 downto 0);
DATAIN: IN std_logic_vector(3 downto 0);
WRITEN: IN std_logic;
CLK: IN std_logic);
end test;
architecture inside of test is
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component testram
port (A: IN std_logic_vector(5 downto 0);
DO: OUT std_logic_vector(3 downto 0);
DI: IN std_logic_vector(3 downto 0);
WR_EN: IN std_logic;
WR_CLK: IN std_logic);
end component;
begin
U0: testram port
map(A=>ADDRESS,DO=>DATAOUT,DI=>DATAIN,
WR_EN=>WRITEN,WR_CLK=>CLK);
end inside;
/*=================================================*/
/*
Sample Script for Synopsys to Xilinx Using
*/
/*
FPGA Compiler with LogiBLOX Memory
*/
/* Targets the Xilinx XC4028EX-3 and assumes a
*/
/*
VHDL source file by way of an example.
*/
/*
*/
/*
For general use with XC4000E/EX architectures.*/
/*
Not suitable for use with XC3000A/XC5200
*/
/*
architectures.
*/
/*=================================================*/
/*
/*
/*
/*
/*
/*

===============================================
Set the name of the design’s top-level module.
(Makes the script more readable and portable.)
Also set some useful variables to record the
designer and company name.
===============================================

*/
*/
*/
*/
*/
*/

TOP = test
/*
/*
/*
/*
/*

==========================
Note: Assumes design filename and entity name are
the same (minus extension)
==========================

*/
*/
*/
*/
*/

designer = "XSI Team"
company = "Xilinx, Inc"
part
= "4028expg299-3"
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/*
/*
/*
/*

=================================================
Analyze and Elaborate the design file and specify
the design file format.
=================================================

*/
*/
*/
*/

analyze –f vhdl TOP + ".vhd"
elaborate TOP
/* ================================================= */
/* Set the current design to the top level.
*/
/* ================================================= */
current_design TOP
/* ================================================= */
/* Set the synthesis design constraints.
*/
/* ================================================= */
remove_constraint –all
/* Some example constraints */
/* create_clock <clock_port_name> –period 50
set_input_delay 5 –clock <clock_port_name> \
{ <a_list_of_input_ports> }
set_output_delay 5 –clock <clock_port_name> \
{ <a_list_of_output_ports> }
set_max_delay 100 –from <source> –to <destination>
set_false_path –from <source> –to <destination>
*/
/* Place dont_touch on LogiBLOX instantiation

*/

set_dont_touch {U0}
/*
/*
/*
/*
/*
/*

=================================================
Indicate those ports on the top-level module that
should become chip-level I/O pads. Assign any I/O
attributes or parameters and perform the I/O
synthesis.
=================================================

*/
*/
*/
*/
*/
*/

set_port_is_pad "*"
/* Some example I/O parameters */
/* set_pad_type –pullup <port_name>
set_pad_type –no_clock all_inputs()
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set_pad_type –clock <clock_port_name>
set_pad_type –exact BUFGS_F <hi_fanout_port_name>
set_pad_type –slewrate HIGH all_outputs() */
/*
/*
/*
/*
/*
/*
/*

=============================
Note: Synopsys slew-control=
HIGH is the same as Xilinx's
slewrate=SLOW. Synopsys slewcontrol=LOW is same as Xilinx
slewrate=FAST.
=============================

*/
*/
*/
*/
*/
*/
*/

insert_pads
/* ================================================= */
/* Synthesize and optimize the design
*/
/* ================================================= */
compile –boundary_optimization
/* ================================================= */
/* Write the design report files.
*/
/* ================================================= */
report_fpga > TOP + ".fpga"
report_timing > TOP + ".timing"
/* ================================================= */
/* Write out the design to a DB file. (Post compile) */
/* ================================================= */
write –format db –hierarchy –output TOP + "_compiled.db"
/* ================================================= */
/* Replace CLBs and IOBs with gates.
*/
/* ================================================= */
replace_fpga
/* ================================================= */
/* Set the part type for the output netlist.
*/
/* ================================================= */
set_attribute TOP "part" –type string part
/* ================================================= */
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/*
/*
/*
/*
/*

Optional attribute to remove the FPGA Compiler’s
mapping structures from the design. This permits
The Xilinx design implementation tools to map the
design instead.
=================================================

*/
*/
*/
*/
*/

/* set_attribute find(design,"*") "xnfout_write_map_symbols" \
–type boolean FALSE
*/
/* ================================================= */
/* Add any I/O constraints to the design.
*/
/* ================================================= */
/* set_attribute <port_name> "pad_location" \
–type string "<pad_location>"

*/

/*
/*
/*
/*
/*
/*

*/
*/
*/
*/
*/
*/

=================================================
Write-out the timing constraints that were
applied earlier. (Note that any design hierarchy
needs to be flattened before the constraints are
written-out.)
=================================================
ungroup –all –flatten
write_script > TOP + ".dc"

/* Write out the design as a .sxnf file

*/

write –f xnf –h –o TOP + ".sxnf"
/*
/*
/*
/*
/*
/*

================================================= */
Call the Synopsys-to-Xilinx constraints translator*/
utility DC2NCF to convert the Synopsys constraints*/
to a Xilinx NCF file. You may like to view
*/
dc2ncf.log to review the translation process.
*/
================================================= */
sh dc2ncf TOP + ".dc"

/* ================================================= */
/* Exit the Compiler.
*/
/* ================================================= */
exit
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/* ================================================= */
/* Now run the Xilinx design implementation tools.
*/
/* ================================================= */

The following example shows how to instantiate RAM using LogiBLOX with Verilog.
module test(address,dataout,datain,writen,clk);
input [5:0] address;
output [3:0] dataout;
input [3:0] datain;
input writen;
input clk;
testram U0
( .A(address),
.DO(dataout),
.DI(datain),
.WR_EN(writen),
.WR_CLK(clk));
endmodule
//--------------------------------------------------// LogiBLOX SYNC_RAM Module "testram"
// Created by LogiBLOX version M1.2.11
//
on Sun May 18 19:34:35 1997
// Attributes
//
MODTYPE = SYNC_RAM
//
BUS_WIDTH = 4
//
DEPTH = 64
//--------------------------------------------------module testram(A, DO, DI, WR_EN, WR_CLK);
input [5:0] A;
output [3:0] DO;
input [3:0] DI;
input WR_EN;
input WR_CLK;
endmodule
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/* ==================================================*/
/*
Sample Script for Synopsys to Xilinx Using
*/
/*
FPGA Compiler with
*/
/*
LogiBLOX Memory
*/
/*
*/
/* Targets the Xilinx XC4028EX-3 and assumes a
*/
/*
Verilog source file by way of an example. */
/*
*/
/*
For general use with XC4000E/EX architectures. */
/*
Not suitable for use with XC3000A/XC5200
*/
/*
architectures.
*/
/* ==================================================*/
/*
/*
/*
/*
/*
/*

=================================================
Set the name of the design’s top-level module.
(Makes the script more readable and portable.)
Also set some useful variables to record the
designer and company name.
=================================================

*/
*/
*/
*/
*/
*/

TOP = test
/*
/*
/*
/*
/*

==========================
Note: Assumes design filename and entity name are
the same (minus extension)
==========================

*/
*/
*/
*/
*/

designer = "XSI Team"
company = "Xilinx, Inc"
part
= "4028expg299-3"
/*
/*
/*
/*

=================================================
Analyze and Elaborate the design file and specify
the design file format.
=================================================

*/
*/
*/
*/

read –f verilog "testram.v"
read –f verilog TOP + ".v"
/* ================================================= */
/* Set the current design to the top level.
*/
/* ================================================= */
current_design TOP
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/* ================================================= */
/* Set the synthesis design constraints.
*/
/* ================================================= */
remove_constraint –all
/* Some example constraints */
/* create_clock <clock_port_name> –period 50
set_input_delay 5 –clock <clock_port_name> \
{ <a_list_of_input_ports> }
set_output_delay 5 –clock <clock_port_name> \
{ <a_list_of_output_ports> }
set_max_delay 100 –from <source> –to <destination>
set_false_path –from <source> –to <destination>
*/
/* Place dont_touch on LogiBLOX instantiation

*/

set_dont_touch {U0}
/*
/*
/*
/*
/*
/*

=================================================
Indicate those ports on the top-level module that
should become chip-level I/O pads. Assign any I/O
attributes or parameters and perform the I/O
synthesis.
=================================================

*/
*/
*/
*/
*/
*/

set_port_is_pad "*"
/* Some example
/* set_pad_type
set_pad_type
set_pad_type
set_pad_type
set_pad_type

I/O parameters
*/
–pullup <port_name>
–no_clock all_inputs()
–clock <clock_port_name>
–exact BUFGS_F <hi_fanout_port_name>
–slewrate HIGH all_outputs()
*/
/*
/*
/*
/*
/*
/*
/*
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=============================
Note: Synopsys slew-control=
HIGH is the same as Xilinx's
slewrate=SLOW. Synopsys slewcontrol=LOW is same as Xilinx
slewrate=FAST.
=============================

*/
*/
*/
*/
*/
*/
*/
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insert_pads
/* ================================================= */
/* Synthesize and optimize the design
*/
/* ================================================= */
compile –boundary_optimization
/* ================================================= */
/* Write the design report files.
*/
/* ================================================= */
report_fpga > TOP + ".fpga"
report_timing > TOP + ".timing"
/* ================================================= */
/* Write out the design to a DB file. (Post compile) */
/* ================================================= */
write –format db –hierarchy –output TOP + "_compiled.db"
/* ================================================= */
/* Replace CLBs and IOBs with gates.
*/
/* ================================================= */
replace_fpga
/* ================================================= */
/* Set the part type for the output netlist.
*/
/* ================================================= */
set_attribute TOP "part" –type string part
/*
/*
/*
/*
/*
/*

=================================================
Optional attribute to remove the FPGA Compiler's
mapping structures from the design. This permits
The Xilinx design implementation tools to map the
design instead.
=================================================

*/
*/
*/
*/
*/
*/

/* set_attribute find(design,"*") "xnfout_write_map_symbols" \
–type boolean FALSE
*/
/* ================================================= */
/* Add any I/O constraints to the design.
*/
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/* ================================================= */
/*

/*
/*
/*
/*
/*
/*

set_attribute <port_name> "pad_location" \
–type string "<pad_location>" */
=================================================
Write-out the timing constraints that were
applied earlier. (Note that any design hierarchy
needs to be flattened before the constraints are
written-out.)
=================================================

*/
*/
*/
*/
*/
*/

ungroup –all –flatten
write_script > TOP + ".dc"
/* Remove the LogiBLOX Memory from the Environment
/* This is done to prevent insure that the
/* .ngo file from LogiBLOX is used.

*/
*/
*/

remove_design testram
/* Write out the design as a .sxnf file

*/

write –f xnf –h –o TOP + ".sxnf"
/*
/*
/*
/*
/*
/*

================================================= */
Call the Synopsys-to-Xilinx constraints translator*/
utility DC2NCF to convert the Synopsys constraints*/
to a Xilinx NCF file. You may like to view
*/
dc2ncf.log to review the translation process.
*/
================================================= */
sh dc2ncf TOP + ".dc"

/* ================================================= */
/* Exit the Compiler.
*/
/* ================================================= */
exit
/* ================================================= */
/* Now run the Xilinx design implementation tools.
*/
/* ================================================= */
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Instantiating RAM or ROM with FPGA Compiler
Use the following procedures and examples to instantiate a LogiBLOX RAM or ROM in Verilog or VHDL with FPGA Compiler.
1.

Create a LogiBLOX RAM/ROM with the LogiBLOX GUI.
When specifying options for LogiBLOX, specify the vendor type
as Synopsys. Also specify in the LogiBLOX GUI whether you
need Verilog or VHDL files.

2.

For Verilog, create an NGC, VEI, and V file. For VHDL, create a
NGC, VHI, and VHD file.
The V and VHD files are simulation models. The VEI and VHI
files are templates which assist in instantiating the LogiBLOX
into your HDL. The NGC file is the actual LogiBLOX module for
your design.

3.

For the Verilog flow, use the name of the NGC file as the name of
the module instantiation in the Verilog code.
The VEI file contains the module name, pin names, and port
names needed to instantiate the LogiBLOX memory. Do not just
rename the VEI file to a V file. Use the VEI file as a template for
instantiating the LogiBLOX memory in your design.

4.

For the Verilog flow, make an empty Verilog file for the LogiBLOX module to tell the Synopsys netlist writer the pin directions for the LogiBLOX module.

5.

A module with pin names and pin directions exists in the .vei file
produced by LogiBLOX. Cut this empty module out and place it
in a Verilog file with the same name as the LogiBLOX module
you created.
Read this file into Synopsys during the compile of your design.

6.

For the Verilog flow, after instantiating the LogiBLOX into your
design, place a Dont Touch attribute on every instantiated LogiBLOX instance.

7.

For the Verilog flow, Synthesize the design with the normal A1.5
XSI run script.

Note: Before writing out the netlist file, remove the LogiBLOX
memory from the Synopsys memory. This prevents Synopsys from
overwriting the LogiBLOX module.
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8.

For VHDL, use the name of the NGC file as the name of the
component instantiation in the VHDL code. The VHI file contains
an example of how to instantiate the LogiBLOX into VHDL.

9.

For VHDL, after instantiating the LogiBLOX into your VHDL
code, place a Dont Touch attribute on every instantiated LogiBLOX instance.

10. For VHDL, synthesize the design. The synthesis run script for
VHDL is the same as the standard A1.5 XSI run script.
The following example shows the testram LogiBLOX module V file
created from the VEI file.
module testram(A, DO, DI, WR_EN, WR_CLK);
input [5:0] A;
output [3:0] DO;
input [3:0] DI;
input WR_EN;
input WR_CLK;
endmodule

The following example shows the instantiation of a LogiBLOX design
in Verilog code.
module test(address,dataout,datain,writen,clk);
input [5:0] address;
output [3:0] dataout;
input [3:0] datain;
input writen;
input clk;
testram U0
( .A(address)
.DO(dataout),
.DI(datain),
.WR_EN(writen),
.WR_CLK(clk));
endmodule

The following example shows the run script for compiling a LogiBLOX design in Verilog.
read -f verilog “testram.v” read -f verilog “test.v”
set_port_is_pad “*” insert_pads
compile
replace_fpga
ungroup -all -flatten
write_script test.dc

4-16

Xilinx Development System

Using Core Generator and LogiBLOX
sh dc2ncf test.dc
remove_design testram
write -f xnf -h -o “test.sxnf”

The following example shows an instantiation of a LogiBLOX design
in VHDL code.
library IEEE;
use IEEE.std_logic_1164.all;
entity test is
port (ADDRESS: IN std_logic_vector(5 downto 0);
DATAOUT: OUT std_logic_vector(3 downto 0);
DATAIN: IN std_logic_vector(3 downto 0);
WRITEN: IN std_logic;
CLK: IN std_logic);
end test;
architecture inside of test is
component testram
port (A: IN std_logic_vector(5 downto 0);
DO: OUT std_logic_vector(3 downto 0);
DI: IN std_logic_vector(3 downto 0);
WR_EN: IN std_logic;
WR_CLK: IN std_logic);
end component;
begin
U0: testram port map(A=ADDRESS,DO=DATAOUT,DI=DATAIN,
WR_EN=WRITEN,WR_CLK=CLK);
end inside;

The following example shows a run script for instantiated LogiBLOX
designs in VHDL code.
analyze -f vhdl “test.vhd” elaborate test
set_port_is_pad “*” insert_pads
compile
replace_fpga
ungroup -all -flatten
write_script test.dc
sh dc2ncf test.dc
write -f xnf -h -o “test.sxnf”
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Instantiating RAM or ROM with FPGA Compiler II
Use the following procedures to instantiate a LogiBLOX RAM or
ROM in Verilog or VHDL with FPGA Compiler II.
1.

Create a LogiBLOX RAM or ROM with the LogiBLOX GUI.
When specifying options for LogiBLOX, specify the vendor type
as Synopsys. Also specify in the LogiBLOX GUI whether you
need Verilog or VHDL files.

2.

For Verilog, create an NGC, VEI, and V file. For VHDL, create an
NGC, VHI, and VHD file.
The V and VHD files are simulation models. The VEI and VHI
files are templates which assist in instantiating the LogiBLOX
into your HDL. The NGC file is the actual LogiBLOX module for
your design.

3.

For the Verilog flow, use the name of the NGC file as the name of
the module instantiation in the Verilog code.
The VEI file contains the module name, pin names, and port
names needed to instantiate the LogiBLOX memory. Do not
rename the VEI file to a V file. Use the VEI file as a template for
instantiating the LogiBLOX memory in your design.

4.

For the Verilog flow, make an empty Verilog file for the LogiBLOX module to tell the Synopsys netlist writer the pin directions for the LogiBLOX module.

5.

In the VEI file produced by LogiBLOX, there is a module with pin
names and pin directions. Cut this empty module out and place it
in a Verilog file with the same name as the LogiBLOX module
you created.
Read this file into FPGA Compiler II during the compile of your
design.

6.
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After implementing the design files in FPGA Compiler II, notice
in the Warnings window a number of warnings about the instantiated LogiBLOX module. FPGA Compiler II reports that it
cannot link to the instantiated design. Also, FPGA Compiler II
can report that some of the wires attached to the instantiated
LogiBLOX have multiple drivers. Ignore these warnings.
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Additionally, after implementing the design, in the modules view
in the Edit Constraints view, all instantiated LogiBLOX modules
are tagged as UNLINKED, a normal situation. UNLINKED
means that FPGA Compiler II cannot find a library cell in its
synthesis library that matches, a normal situation because the
instantiated LogiBLOX is a black-box.
7.

After implementing the design, if the implementation icon
contains a “!” mark, optimize (synthesize) the design and write
out the netlist file.

8.

For VHDL, use the name of the NGC file as the name of the
component instantiation in the VHDL code.
The VHI file contains an example of how to instantiate the LogiBLOX into VHDL.

9.

After implementing the design files in FPGA Compiler II, notice
in the Warnings window a number of warnings about the instantiated LogiBLOX module. FPGA Compiler II reports that it
cannot link to the instantiated design. Also, FPGA Compiler II
can report that some of the wires attached to the instantiated
LogiBLOX have multiple drivers. Ignore these warnings.
Additionally, after implementing the design, in the modules view
in the Edit Constraints view, all instantiated LogiBLOX modules
are tagged as UNLINKED, a normal situation. UNLINKED
means that FPGA Compiler II cannot find a library cell in its
synthesis library that matches, a normal situation because the
instantiated LogiBLOX is a black-box.

10. After implementing the design, if the implementation icon
contains a “!” mark, optimize (synthesize) the design and write
out the netlist file.
The following examples shows the testram LogiBLOX module V file
created from the VEI file.
module testram(A, DO, DI, WR_EN, WR_CLK);
input [5:0] A;
output [3:0] DO;
input [3:0] DI;
input WR_EN;
input WR_CLK;
endmodule
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The following example shows the instantiation of a LogiBLOX design
in Verilog code.
module test(address,dataout,datain,writen,clk);
input [5:0] address;
output [3:0] dataout;
input [3:0] datain;
input writen;
input clk;
testram U0
( .A(address),
.DO(dataout),
.DI(datain),
.WR_EN(writen),
.WR_CLK(clk));
endmodule

The following examples shows an instantiation of a LogiBLOX design
in VHDL code.
library IEEE;
use IEEE.std_logic_1164.all;
entity test is
port (ADDRESS: IN std_logic_vector(5 downto 0);
DATAOUT: OUT std_logic_vector(3 downto 0);
DATAIN: IN std_logic_vector(3 downto 0);
WRITEN: IN std_logic;
CLK: IN std_logic);
end test;
architecture inside of test is
component testram
port (A: IN std_logic_vector(5 downto 0);
DO: OUT std_logic_vector(3 downto 0);
DI: IN std_logic_vector(3 downto 0);
WR_EN: IN std_logic;
WR_CLK: IN std_logic);
end component;
begin
U0: testram port map(A=ADDRESS,DO=DATAOUT,DI=DATAIN,
WR_EN=WRITEN,WR_CLK=CLK);
end inside;
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Chapter 5

Simulating Your Design
You can efficiently manage your design changes with the XSI VHDL
and Verilog simulation options described in this chapter. VHDL
simulation supports the VHDL Initiative Towards ASIC Libraries
(VITAL) standard, which allows you to simulate with any VITALcompliant simulator, including Synopsys VSS. Built-in Verilog
support allows you to simulate with Cadence Verilog-XL and other
compatible simulators.
XSI simulation options provide the following.
•

Fast, timing-accurate, gate-level HDL simulation with the VHDL,
VITAL-compliant or Verilog versions of the SimPrim Library

•

RTL or post-synthesis, functional verification of designs
containing instantiated Xilinx Unified Library components, using
either the VITAL or Verilog versions of the UniSim Library

•

Support for FPGA architecture features such as Global Set/Reset,
Oscillator, RAM, and ROM

This chapter includes the following sections
•

“Simulation Design Flow Overview”

•

“Using Simulation Libraries”

•

“Working with the VITAL Standard”

•

“VHDL and Verilog Simulation Flow”

•

“Synthesizing/Simulating for VHDL Global Set/Reset Emulation”

•

“NGDBuild Support of Multiple Device Architectures”

•

“Recommended VSS Simulation Strategy”

•

“VSS Simulation Flow”
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•

“Editing the VSS Setup File”

•

“Creating a Testbench File”

•

“Using RTL Simulation”

•

“Implementing Your Design”

Simulation Design Flow Overview
A typical single chip VHDL or Verilog simulation design flow
includes the following steps, illustrated in the “HDL Simulation
Design Flow” figure.
1.

Generation of a VHDL RTL description

2.

VHDL RTL simulation

3.

Synthesis implementation

4.

Optional unit delay gate-level functional simulation

5.

Timing simulation

HDL
Design

UniSim Library
Module

HDL RTL
Simulation

Testbench
Stimulus

Synthesis

Post-Synthesis Gate-Level
Functional Simulation

Xilinx XACTstep
Implementation

SimPrim Library

HDL Timing
Simulation
X7692

Figure 5-1 HDL Simulation Design Flow
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Using Simulation Libraries
This section provides information on the libraries needed to simulate
your VHDL and Verilog designs.

UniSim Library
To make an RTL simulation FPGA-specific, the design must contain
instantiated Unified Library or LogiBLOX components. To support
these instantiations, Xilinx provides a functional UniSim library and a
behavioral LogiBLOX library. The VHDL and Verilog versions of the
UniSim library differ because of variations in language features and
methodologies. You can also use the UniSim library for postsynthesis, gate-level simulation as discussed in the “VHDL and
Verilog Simulation Flow” section.

UniSim Library Structure
Use the UniSim Library for functional simulation only; it contains
default unit delays. Structures differ for the library directories for
VHDL and Verilog. Only one VHDL library exists for all Xilinx technologies. However, some components contain configuration statements to select the appropriate functionality for a specific
architecture. A single library makes it easier to switch between technologies. Because Verilog does not have configuration statements,
separate libraries are provided for each technology.
The UniSim Library contains all the Xilinx Unified Library components inferred by most synthesis tools. In addition, the UniSim
Library contains commonly instantiated components such as IOs and
memory components. Use your synthesis tool’s module generators or
LogiBLOX to generate higher order functions such as adders,
counters, and RAM.
Schematic macros are not provided because schematic vendors
usually provide the lower-level netlist when a synthesis tool imports
a design. This lower-level netlist for a schematic macro is required for
implementation as well. You can find VHDL models for DesignWare
components in $XILINX/synopsys/libraries/sim/src/xdw.
Note: DesignWare does not currently provide components in Verilog
versions.
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You can accelerate the VITAL-compliant VHDL version of the
UniSim Library but you cannot back-annotate it with an SDF file.
Compile the library for each HDL simulator using the Xilinxsupplied source files in $XILINX/vhdl/src/unisims. Compile the
source files into a library named UNISIM.
You do not always have to compile the Verilog version of the UniSim
Library, depending on the Verilog tool. Because there are a few
components with functional differences between Xilinx technologies,
each supported technology has a separate library, in upper case only.
If needed, you can find lower case libraries in the Xilinx Cadence
Interface located in $XILINX/verilog/src/technology, where technology is UNI3000, UNI4000E, UNI4000X, or UNI5200.
A few differences exist between the upper and lower case versions of
the Verilog UniSim libraries. For example, because buf, pullup, and
pulldown are reserved words in Verilog, the lower case version of the
UniSim library uses buff, pullup1, and pulldown1, and the upper
case version uses BUF, PULLUP, and PULDOWN.

UniSim Library Files
You can compile the UniSim VHDL Library to any physical location
on your system. You can find the VHDL source files in $XILINX/
vhdl/src/unisims, listed below in the order in which you must
compile them with the Synopsys compiler.
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1.

unisim_VCOMP.vhd (component declaration file)

2.

unisim_VCOMP52K.vhd (substitutional component declaration
file for XC5200 designs)

3.

unisim_VPKG.vhd (package file)

4.

unisim_VITAL.vhd (model file)

5.

unisim_VITAL52K.vhd (additional model file for XC5200
designs)

6.

unisim_VCFG4K.vhd (configuration file for XC4000 edge
decoders)

7.

unisim_VCFG52K.vhd (configuration file for XC5200 internal
decoders)
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You can find the uppercase Verilog components in individual component files in the following directories.
•

$XILINX/verilog/src/UNI3000 (Series 3K)

•

$XILINX/verilog/src/UNI4000E (Series 4KE and 4KL)

•

$XILINX/verilog/src/UNI4000X (Series 4KEX, 4KXL, and
4KXV)

•

$XILINX/verilog/src/UNI5200 (Series 5200)

UniSim Library Component Instantiation
You must refer to the compiled UniSim Library in your VHDL code
to instantiate components from this library in your design for RTL
simulation. The VHDL simulation tool must map the logical library
to the physical location of the compiled library. Verilog must also
map to the UniSim Verilog library. Even though VHDL component
declarations are provided in the library, component declarations are
required in the RTL code for synthesis.

SimPrim Library
Use the SimPrim (simulation primitive) library for post-NGDBuild,
post-map partial timing, and full timing back-annotated simulation.

LogiBLOX Library
Use the LogiBLOX module generator to create schematic-based
modules such as adders, counters and large memory blocks. For your
HDL designs, use LogiBLOX to generate large blocks of memory for
instantiation. Refer to the “Using Core Generator and LogiBLOX”
chapter and LogiBLOX User Guide for more information.

LogiBLOX Library Compilation
You can compile the LogiBLOX VHDL library to any physical location. You can find the VHDL source files in $XILINX/vhdl/src/logiblox, listed below in the order in which you must compile them.
1.

mvlutil.vhd

2.

mvlarith.vhd

3.

logiblox.vhd
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LogiBLOX Library Component Instantiation
Simulate LogiBLOX components with behavioral code not intended
for synthesis. The synthesizer processes the component as a “black
box.” The implementation software reads the NGO file created by
LogiBLOX. You can find the source libraries for LogiBLOX in
$XILINX/vhdl/src/logiblox. The LogiBLOX tool creates the actual
models. You must compile the package files into a library called
LOGIBLOX. You should compile the LogiBLOX component model in
your working directory with your design.

Working with the VITAL Standard
VITAL was created to promote the standardization of VHDL libraries
and simulators from different vendors. VITAL also defines a standard
for back-annotation of timing information to VHDL simulators.
The IEEE-STD 1076.4 VITAL standard accelerates gate-level simulations. Check with your simulator company to verify they support this
standard. Also, make sure you use the proper settings and VHDL
packages for this standard.
Your simulator can also accelerate IEEE-1164, the standard logic
package for Types. VITAL libraries require overhead for timing
checks and back-annotation styles. The UniSim Library turns off
these timing checks because they do not apply to unit delay functional simulation. The SimPrim back-annotation library by default
turns on these timing checks. However, you can turn them off and
then edit and re-compile the SimPrim components file.

VHDL and Verilog Simulation Flow
HDL simulation can occur at five different steps in the design flow, as
listed below. Subsequent sections describe each step in more detail.
The “VHDL and Verilog Simulation Flow” figure illustrates the
design flow.
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•

Register Transfer Level (RTL)

•

Post-synthesis, pre-NGDBuild
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•

Post-NGDBuild, pre-MAP

•

Post-MAP partial timing (CLB and IOB block delays only; no net
delays)

•

Post-route full timing (block and net delays)

VHDL or Verilog
UniSim Library

VHDL
Designs

Synthesis
Libraries

RTL

VHDL or
Verilog SimPrim
Library

Testbench
Stimulus

Synthesis
Simulation

UCF
User Constraints File

XNF and
Constraints

NCF
Netlist Constraint File

EDIF 2 0 0 &
Constraints

Verilog and
SDF 2.1

Netlist Translation Out

NGDBuild

NGD

MAP

VHDL and
SDF 2.1

NGA

NGM

NGDAnno
CPLD Fitter

Partial Timing
NCD & Constraints

PAR

Full Timing
NCD & Constraints
X7699

Figure 5-2 VHDL and Verilog Simulation Flow

Simulating at Register Transfer Level (RTL)
RTL simulation allows you to verify or simulate your HDL design at
the system or chip level. High-level RTL language constructs usually
describe the system or chip at this level. You can use VHDL and
Verilog simulators to check your design’s functionality before you
implement it in gates.
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Use a testbench to model the environment of the system or chip. At
this level, you can use the UniSim library to instantiate components
from the Xilinx Unified Library. You can also instantiate LogiBLOX
components if you do not want to use modules generated by your
synthesis tool.

Conducting a Post-Synthesis (pre-NGDBuild) GateLevel Functional Simulation
After synthesizing the system or chip to gates, re-use the testbench in
post-synthesis, gate-level functional simulation to simulate the
synthesized result. Check consistency with your original design
description. In the Xilinx design flow, post-synthesis, gate-level simulation includes any simulation performed after any of the synthesis,
map, or place and route steps.
A post-synthesis, pre-NGDBuild gate-level functional simulation
allows you to directly verify your design after synthesis. Any differences in the behavior of the original RTL description and the synthesized design can indicate a problem with your synthesis tool. Not all
synthesis tools support post-synthesis simulation. The synthesis tool
must be able to write VHDL or Verilog output in terms of the UniSim
library.
LogiBLOX components remain behavioral models, expanded and
represented as gates. The library usage guidelines for RTL simulation
also apply to post-synthesis gate-level functional simulation.

Conducting a Post-NGDBuild (Pre-Map) Gate-Level
Functional Simulation
If your synthesis tool cannot write UniSim-compatible VHDL or
Verilog netlists, you cannot simulate the synthesis output. In this
case, use post-NGDBuild (pre-MAP) gate-level functional simulation
with generic SimPrim library models. As with the post-synthesis, preNGDBuild simulation, this type of gate-level simulation allows you
to verify that your design synthesized correctly.
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Conducting a Post-Map Partial Timing (CLB and IOB
Block Delays) Simulation
In the Xilinx design flow, you can perform a partial timing simulation
after your design maps (see the “VHDL and Verilog Simulation
Flow” figure). The resulting NCD file contains timing information for
the CLB and IOB mapped blocks. At this point your design is not
routed and does not contain net delays, with the exception of pre-laid
out macros such as cores.

Conducting a Post-Route Full Timing (Block and Net
Delays) Simulation
After using PAR to route your design, you can simulate it with the
actual block and net timing delays with the same testbench used in
the earlier behavioral simulation. The back-annotation process
produces a netlist of SimPrims annotated with the appropriate block
and net delay data from the place and route process.
Different simulation libraries are required to support simulation
before and after you run NGDBuild on your design. Prior to
NGDBuild, designs are expressed as netlists containing Unified
Library components. After NGDBuild, designs are expressed as
netlists containing SimPrims. While the impact of these library
changes are not apparent, designs need different simulation libraries
for pre- and post-implementation simulation. Additionally, pre- and
post-implementation netlists include different gate-level components.

Synthesizing/Simulating for VHDL Global Set/Reset
Emulation
VHDL requires a testbench to control all signal ports. You can instantiate certain VHDL-specific components, explained in the following
sections, in the RTL and post-synthesis VHDL description to allow
the simulation of the global signals for global set/reset and global 3state.
NGD2VHDL creates a port in your back-annotated design entity for
stimulating the global set/reset or 3-state enable signals. This port
does not actually exist on the configured part.

Xilinx/Synopsys Interface Guide — 2.1i
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When running NGD2VHDL, you do not need to use the –gp switch
to create an external port if you instantiate a STARTUP block in your
implemented design. The port is already identified and connected to
the global set/reset or 3-state enable signal. If you do not use the –gp
option or a STARTBUF block, you must use special components, as
described in the following sections.

Using STARTBUF in VHDL
STARTBUF replaces STARTUP. With STARTBUF you can functionally
simulate the GSR/GR net in both function and timing simulation. By
connecting the input pin of the STARTBUF to a top-level port and
using STARTBUF as the source for all async set/reset signals in a
design, Xilinx M1 software can automatically optimize the design to
use the GSR/GR. Because you can use STARTBUF in functional simulation (unlike STARTUP), when you use STARTBUF you can map to
the GSR/GR in a device. You can still use STARTUP, but it does not
always provide correct GSR/GR in HDL flows.
The STARTBUF component passes a reset or 3-state signal in the
same way that a buffer allows simulation to proceed and also instantiates the STARTUP block for implementation. One version of
STARTBUF works for all devices, however, the XC5200 and the
XC4000 STARTUP blocks have different pin names. Implementation
with the correct STARTUP block occurs automatically. The following
shows an instantiation example of the STARTBUF component.
U1: STARTBUF port map (GSRIN => DEV_GSR_PORT, GTSIN
=>DEV_GTS_PORT, CLKIN => ‘0’, GSROUT => GSR_NET,
GTSOUT => GTS_NET, Q2OUT => open, Q3OUT => open,
Q1Q4OUT => open, DONEINOUT => open):

You can use one or both of the input ports (GSRIN and GTSIN) of the
STARTBUF component and the associated output ports (GSROUT
and GTSOUT). You can use pins left “open” to pass configuration
instructions to the implementation tools by connecting the appropriate signal to the port instead of leaving it open.

Instantiating a STARTUP Block in VHDL
The STARTUP block traditionally instantiates to identify the GR,
PRLD, or GSR signals for implementation. However, simulation can
occur only when the net attached to the GSR or GTS goes off the chip
because the STARTUP block does not have a simulation model. You
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can use the new components described below to simulate global set/
reset or 3-state nets whether or not the signal goes off the chip.

Generating a Reset-On-Configuration in VHDL
The Reset-On-Configuration (ROC) component generates during
back-annotation if you do not use the –gp option or STARTUP block
options. Therefore, you can instantiate the ROC in the front end to
match for functionality with GSR, GR, or PRLD (done in both functional and timing simulation). During back-annotation, the entity and
architecture for the ROC component are placed in your design’s
output VHDL file.
In the front end, the entity and architecture reside in the UniSim
Library, and require a component declaration and instantiation.
The ROC component generates a one-time initial pulse to drive the
GR, GSR, or PRLD net starting at time “0” for a user-defined pulse
width. You can set the pulse width with a generic in a configuration
statement. The default value of “width” is 0 ns, which disables the
ROC component and causes a low global set/reset. The netlist itself
handles active low resets, requiring you to invert this signal before
using it.
The ROC component allows you to simulate with the same testbench
as in RTL simulation, and also allows you to control the width of the
GSR signal in your implemented design.
One of the easiest methods for mapping the generic involves configuring your testbench. An example testbench configuration for setting
the generic follows.
CONFIGURATION cfg_my_timing_testbench OF my_testbench IS
FOR my_testbench_architecture
FOR ALL:my_design USE ENTITY work.my_design(structure);
FOR structure
FOR ALL:roc ENTITY work.roc (roc_v);
GENERIC MAP (width => 100 ms)
END FOR;
END FOR;
END FOR;
END FOR;
END cfg_my_timing_testbench;
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The following shows an instantiation example of the ROC component.
U1: ROC port map (O => GSR_NET);

Using ROCBUF in VHDL
The ROCBUF component allows you to provide a stimulus for the
ROC signal through a testbench. However, the port connected to it
does not implement as a chip pin. Use the –gp switch with
NGD2VHDL to use the port in timing simulation. The following
example shows an instantiation of the ROCBUF component.
U1: ROCBUF port map (I => SIM_GSR_PORT, O => GSR_NET);

Generating a 3-State-On-Configuration in VHDL
The 3-State-On-Configuration (TOC) component generates if you do
not use the –tp option or STARTUP block options. The entity and
architecture for the TOC component are placed in your design’s
output VHDL file.
The TOC component generates a one-time initial pulse to drive the
GR, GSR, or PRLD net starting at time ‘0’ for a user-defined pulse
width. You can set the pulse width with a generic in a configuration
statement. The default value of “width,” 0 ns, disables the TOC
component and causes the 3-state enable to be held low. The netlist
itself handles active low 3-state enables, requiring you to invert this
signal before using it.
The TOC component allows you to simulate with the same testbench
as in the RTL simulation, and also allows you to control the width of
the 3-state enable signal in your implemented design.
The TOC components require a value for the generic width, usually
specified with a configuration statement. Otherwise, you must
include a generic map as part of the component instantiation. You can
set the generic width with any generic mapping method. Set the
“width” generic after consulting The Programmable Logic Data Book for
the particular part and mode you have implemented. For example, a
XC4000E part can vary from 10 ms to 130 ms. Use the TPOR (PowerOn Reset) parameter found in the Configuration Switching Characteristics tables for Master, Slave, and Peripheral modes.
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One of the easiest methods for mapping the generic to configure your
testbench. An example testbench configuration for setting the generic
follows.
CONFIGURATION cfg_my_timing_testbench OF my_testbench IS
FOR my_testbench_architecture
FOR ALL:my_design USE ENTITY work.my_design(structrue);
FOR structure
FOR ALL:toc ENTITY work.toc (toc_v);
GENERIC MAP (width => 100 ms)
END FOR;
END FOR;
END FOR;
END FOR;
END cfg_my_timing_testbench;

The following example shows an instantiation of the TOC component.
U2: TOC port map (O => GTS_NET);

Using TOCBUF in VHDL
The TOCBUF allows you to provide a stimulus for the global 3-state
signal (GTS) through a testbench. However, the port connected to it
does not implement as a chip pin. Use the –tp switch with
NGD2VHDL to use the port in timing simulation. The following
example shows an instantiation of the TOCBUF component.
U2: TOCBUF port map (I =>SIM_GTS_PORT, O =>GTS_NET);

Using Oscillators in VHDL
The SimPrim library does not include the Oscillator component
because you cannot drive global signals in VHDL designs. After
back-annotation, your VHDL design output contains the oscillator
entity and architectures. The UniSim Library instantiates and simulates oscillators for functional simulation. You must set the period of
the base frequency for simulation because the default period of 0 ns
disables the oscillator. The oscillator’s frequency can vary significantly with process and temperature.
Before setting the base period parameter, consult The Programmable
Logic Data Book for the part you are using. For example, for a XC4000
on-chip oscillator, the base frequency ranges from 4 MHz to 10 MHz,
and is nominally 8 MHz. Therefore, the base period generic
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“period_8m” for the XC4000E OSC4 VHDL model ranges from 250 ns
to 100ns, as shown in the following example.
CONFIGURATION cfg_my_functional_testbench OF my_testbench IS
FOR my_testbench_architecture
FOR ALL: my_design USE ENTITY work.my_design (my_design_rtl);
FOR my_design_rtl
FOR ALL:my_submodule USE ENTITY work.my_submodule (my_submodule_rtl);
FOR my_submodule_rtl
FOR all: osc4 USE ENTITY work.osc4 (structure)
GENERIC MAP (period_8m => 125 nS);
END FOR;
END FOR;
END FOR;
END FOR;
END FOR;
END FOR;
END cfg_my_functional_testbench;

Using Global Set/Reset Emulation in Verilog
For more information, refer to the Cadence User’s Manual.

Using Global 3-State Emulation in Verilog
For more information, refer to the Cadence User’s Manual.

Using Oscillators in Verilog
For more information, refer to the Cadence User’s Manual.

NGDBuild Support of Multiple Device Architectures
Note: Refer to the “VHDL and Verilog Simulation Flow” figure.
NGDBuild processes multiple device architectures with the same core
map and place and route software. NGDBuild performs two functions during design implementation.
•
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•

NGDBuild creates an native generic database (NGD) netlist,
which consists of technology-independent primitives common to
all FPGAs (SimPrims).

The MAP program reads this NGD file and creates a native circuit
description (NCD) file, a physical description of your design in terms
of the target device.
Next, the PAR program places and routes the NCD file. NGDAnno
creates an NGA file, a back-annotated NGD file.

Recommended VSS Simulation Strategy
Because of the flexibility of the simulation environment, you can
verify your design using various methods. The following steps,
explained in subsequent sections, show you one recommended flow
for FPGA simulation.
1.

Create a .synopsys_vss.setup file.
Before you can begin simulation, you must create a simulation
setup file.

2.

Specify the initial states of your registers in your VHDL source
file.
If you use attributes at the DC Shell command line or in Design
Analyzer to control the initial states of the registers in your
design, RTL simulation does not reflect those initial states.

3.

Create a test bench file.
By following the guidelines described in this section, you can use
the same test bench for both RTL and timing simulation.

4.

Perform RTL simulation.
This step allows you to debug the behavior of your source design
before implementing it in an FPGA.

5.

Implement the design in an FPGA.
This step provides the necessary physical resource information
necessary for timing simulation.

6.

Prepare the timing model.
The NGD2VHDL program prepares a back-annotated timing
model of your design for simulation.

Xilinx/Synopsys Interface Guide — 2.1i
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7.

Perform timing simulation.
By re-using the RTL simulation test bench file, you can easily
compare results and prevent errors caused by accidental differences between separate test bench files.

VSS Simulation Flow
The VSS simulation flows appear in the following figure and the
“Back-annotation Simulation” figure.
Original HDL Source

Testbench

.vhd

.vhd

VHDLAN -i

VHDLAN -i

.sim

.sim

UniSim

VSS v1997.01
or later

(VITAL)
VHDLAN -i

.synopsys_vss.setup

UniSim

UniSim source code for RTL
simulation of instaniated
unified library primitives
(back-annotation primitives).

(VITAL)
X8561

Figure 5-3 RTL Simulation
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Testbench

Back-annotation
netlist and timing

.vhd

.vhd

VHDLAN -i

VHDLAN -i

.sim

.sim

.sdf

VSS v1997.01
SimPrim

.synopsys_vss.setup

VITAL source code
for SimPrim
comps. Shipped
with core tools.

(VITAL)

VHDLAN -i

SimPrim

(VITAL)

X8562

Figure 5-4 Back-annotation Simulation

Editing the VSS Setup File
To properly analyze and simulate Xilinx designs using VSS, you must
edit your Synopsys VSS setup file, .synopsys_vss.setup. You can find
a sample VSS setup file in $XILINX/synopsys/examples/
template.synopsys_vss. setup. You can copy this file to your project
directory and rename it .synopsys_vss.setup.
The following example shows the sample VSS setup file in $XILINX/
synopsys/examples/template.synopsys_vss. setup. Make sure you
have included the information in this file in your VSS setup file.
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-- =================================================== --- Template .synopsys_vss.setup file for Xilinx design --For use with Synopsys VSS.
--- =================================================== --- =================================================== --Set any simulation preferences.
--- =================================================== -TIMEBASE
= NS
TIME_RES_FACTOR = 0.1
-- ================================================== --- Define a work library in the current project dir
--- to hold temporary files and keep the project area --- uncluttered. Note: You must create a subdirectory --- in your project directory called WORK.
--- ================================================== -WORK
> DEFAULT
DEFAULT : ./WORK
-- ================================================== --- Note that the following simulation libraries are
--- provided ready-analyzed with VSS 3.4b-vital. (With --- the exception of FTGS libraries which are ready--- analyzed with VSS 3.4b) If you’re using a later
--- version of VSS then refer to the automatic compile --- scripts provided in the appropriate library’s
--- source directory. I.e. $XILINX/synopsys/sim/src
--- ================================================== --- ================================================== --- VITAL SimPrim libraries provided to support back- --- annotated simulation only.
--- ================================================== -SIMPRIM : $XILINX/synopsys/libraries/sim/lib/simprims
-- ================================================== --- Packages used by LogiBLOX functional simulation
--- models only. Ie. To support behavioral simulation --- of VHDL designs with instantiated LogiBLOX cells. --- ================================================== -LOGIBLOX : $XILINX/synopsys/libraries/sim/lib/logiblox
-- ================================================== --- Example pointers to the Xilinx FTGS simulation
--- libraries. Note that these libraries are provided --- for compatibility with earlier versions of XSI.
--- ================================================== -XC4000E : $XILINX/synopsys/libraries/sim/lib/xc4000e/ftgs
XC5200 : $XILINX/synopsys/libraries/sim/lib/xc5200/ftgs
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XC7000
XC9000

: $XILINX/synopsys/libraries/sim/lib/xc7000/ftgs
: $XILINX/synopsys/libraries/sim/lib/xc9000/ftgs

Creating a Testbench File
Follow the instructions in the testbench.vhd file included with the
Calc tutorial to create a testbench file for your design. See the XSI
tutorial at http://support.xilinx.com/support/techsup/tutorials/
index.htm for more information about creating a testbench for Xilinx
devices. You can use the same testbench for RTL and timing simulation.
After you have created a testbench file, you can begin using the VSS
simulator for RTL simulation.

Using RTL Simulation
Use RTL simulation to debug your logic before fitting your design
into an FPGA.
Generally RTL level simulation does not require VITAL or Verilog
unified library models because VHDL simulators can simulate
behavioral code. However if your design contains instantiated
components (such as RAMs, ROMs, input registers, INFF, clock
buffers), the simulator must have access to VITAL or Verilog models
for these front end unified library components.
During simulation, analyze your design’s modules according to hierarchical precedence with the lowest first (analyze the testbench last).
Analyze the RTL models for all instantiated primitives, followed by
the design files, with the Synopsys VHDLAN command.
vhdlan –i module.vhd
.
.
.
vhdlan –i testbench.vhd

Note: Use the –i option on the VHDLAN command. While this
option can result in a slight increase in simulation time, it is not
dependent on any operating system or C compilers. Additionally,
VHDLAN can analyze your design in compiled or interpretive
modes. While the compiled mode usually accelerates simulation run
times, it reduces debugger visibility into the simulation. For more
information, refer to the Synopsys documentation.
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After analyzing all your design modules (including the testbench),
start the simulator. The simulator comes in two versions, a graphic
debugging environment, VHDLDBX, and a command-line driven
simulator, VHDLSIM. VHDLDBX allows you to select the desired
configuration from a graphic window. VHDLSIM requires you to
specify the desired configuration at the command line. In either case,
select the configuration name associated with your testbench entity.
For example, consider a testbench with the following entity and
architecture statements.
entity my_testbench is
end my_testbench;
architecture my_vectors of my_testbench is
.
.
begin
.
.
end my_vectors;

At a minimum, you then require a configuration of the following
type.
configuration my_configuration of my_testbench is
for my_vectors
end for;
end my_configuration;

To start VHDLDBX on this design, perform the following steps.
1.

Enter the following at the UNIX command line.
vhdldbx

2.

Select my_configuration from the command list.

3.

Press OK.

To start VHDLSIM on this design, enter the following command at
the UNIX command line.
vhdlsim my_configuration
For an example of how to use these tools, refer to the XSI tutorial at
http://support.xilinx.com/support/techsup/tutorials/index.htm.
Also, see the Synopsys user documentation for more information.
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The Calc tutorial provides the behv_sim.csh script file. This script
illustrates the necessary steps to perform an RTL simulation on the
Calc design. You can modify behv_sim.csh to use with your designs.
This script analyzes the VHDL files, and starts the VSS VHDL
Debugger (VHDLDBX). During simulation, the testbench applies
stimulus to the design, and monitors and records its outputs.

Implementing Your Design
After debugging your design using RTL simulation, you can compile
it using synthesis and implement it in an FPGA using the Xilinx software. You must implement your design before performing timing
simulation.
Use DC Shell commands or Design Analyzer, as described in the
“Synthesizing Your Design” chapter, to create the XNF or EDIF netlist
file required by the Xilinx software. This gate-level netlist file
contains components from the appropriate library but not timing
information. The Xilinx software processes the netlist file and places
the logical design into the physical architecture of your target FPGA.
After the Xilinx software implements the design, the actual target
device timing information is available for timing simulation.
Using the Calc design as an example, the following steps provide an
overview of the implementation procedure.
1.

Compile the design, targeting the appropriate libraries, and
create an XNF or EDIF netlist by executing the following
command at the command line.
dc_shell –f calc.script
During processing, the system displays informational messages.

2.

Run NGDBuild to process the netlist. NGDBuild translates the
Synopsys-generated netlist to a Xilinx netlist.
ngdbuild –p parttype calc

3.

Run the MAP program. MAP allocates the logic to CLBs and
IOBs.
map calc
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4.

Run PAR, which produces a placed and routed design. The –w
option specifies the output file name.
PAR calc –w calc_routed

5.

Run NGDAnno, which relates the placed and routed design with
the original design to ensure the retention of as many of the original component and net names as possible.
ngdanno calc_routed calc

6.

Run NGD2VHDL, which creates a structural VHDL netlist for
use as a simulation model and a corresponding SDF file
containing timing information.
ngd2vhdl calc_routed

When simulating, you must analyze your design’s modules
according to hierarchical precedence with the lowest first (structural
netlist first, followed by the testbench).
vhdlan –i routed_design.vhd
vhdlan –i testbench.vhd

Note: VHDLAN can analyze your design in compiled or interpretive
modes. While the compiled mode usually accelerates simulation run
times, it reduces debugger visibility into the simulation. For more
information, refer to the Synopsys documentation.
The VHDL Simulator launches and reads in the testbench, the backannotated VHDL model for your placed and routed design, and the
associated SDF file.
For timing simulation, the simulator starts in the same way as for
RTL simulation, but with the addition of the following two command
line options.
•

The name of the SDF file that contains the timing information

•

The instance in the testbench where you apply timing information

The following examples illustrate these two command line options.
•

VHDLSIM Example
vhdlsim –sdf_top my_testbench/instance_name \
–sdf routed_design.sdf my_configuration
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•

VHDLDBX Example
vhdldbx –sdf_top my_testbench/instance_name \
–sdf routed_design.sdf my_configuration

Where instance_name is the instance name of the unit under test in
your testbench.
Note: You can also specify the –sdf_top and –sdf options in the arguments field of the initial window that appears when you start
VHDLDBX.
The Calc tutorial provides the tim_sim.csh script file. This script
provides the necessary steps to perform a timing simulation with the
VSS simulator. You can modify this script to use with your designs.
You can use the same testbench you used to perform an RTL simulation to perform a timing simulation.

Xilinx/Synopsys Interface Guide — 2.1i

5-23

Xilinx/Synopsys Interface Guide

5-24

Xilinx Development System

Chapter 6

Using Files, Programs, and Libraries
This chapter describes the files, programs, and Xilinx-supplied
libraries you need to translate your HDL design using Synopsys
FPGA Compiler or Design Compiler.
This chapter includes the following sections.
•

“Understanding the XSI Directory Structure”

•

“Using File Descriptions”

•

“Using Program Descriptions”

•

“Using Supplied Libraries Descriptions”

Understanding the XSI Directory Structure
This section describes the XSI directory tree. This directory tree
allows you to easily find XSI files, programs, and libraries.

XSI Directory Tree Structure
$XILINX/synopsys/
|-- data (contains at the minimum synopsys.acd and nbexpand.acd files)
|
|-- libraries
|
|-- sim
|
|
|-- lib
|
|
|
|-- logiblox (compiled LOGIBLOX simulation library)
|
|
|
|
|-- sparc
|
|
|
|
|
|
|
|-- simprims (compiled SIMPRIM simulation library)
|
|
|
|
|-- sparc
|
|
|
|
|
|
|
|-- xc9000
|
|
|
|
|-- ftgs (compiled FTGS simulation library)
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|
|
|
|
|
|
|
|-- xdw (compiled xdw simulation library)
|
|
|
|-- sparc
|
|
|
|
|
|-- src
|
|
|-- logiblox (LOGIBLOX simulation library source)
|
|
|
|
|
|-- simprims (SIMPRIM simulation library source)
|
|
|
|
|
|-- xc9000
|
|
|
|-- ftgs (FTGS simulation library source)
|
|
|
|
|
|-- xdw (XDW simulation library source)
|
|
|
|-- syn
|
| *.sdb (compiled symbol libraries)
|
| *.sldb (compiled synthetic libraries)
|
| *.db (compiled synthesis libraries)
|
|
|
|-- dw
|
|-- lib
|
|
|-- xc4000e (compiled Design Ware library)
|
|
|-- xc4000ex
|
|
|-- xc4000l
|
|
|-- xc4000xl
|
|
|-- xc4000xv
|
|
|-- xc5200
|
|
|-- xc9000
|
|
|-- Spartan
|
|
|-- SpartanXL
|
|
|
|-- src
|
|-- xc4000e (Design Ware library source)
|
|-- xc4000ex
|
|-- xc4000l
|
|-- xc4000xl
|
|-- xc4000xv
|
|-- xc5200
|
|-- xc9000
|
|-- Spartan
|
|-- SpartanXL
|
|-- examples (example setup files)
|
|-- training
|
|

6-2

Xilinx Development System

Using Files, Programs, and Libraries
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|-- tutorial
|
|-|
|
|-|
|
|--

|-|
|
|
|-|
|
|
|-|
|
|
|-|
|
|
|-|
|
|
|--

bscan
|-- vhdl
|-- verilog
bigadder
|-- vhdl
|-- verilog
bufg
|-- vhdl
|-- verilog
ram
|-- vhdl
|-- verilog
resource
|-- vhdl
|-- verilog
tbufmux
|-- vhdl
|-- verilog

fpga
|-- vhdl
dc
|-- vhdl
cpld
|-- verilog
|-- vhdl
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Using File Descriptions
This section describes the files you need to translate, map, place, and
route your design using the XSI and Synopsys tools.
Table 6-1
File

File Descriptions
FPGA Compiler
or Design
Compiler

Description

design_name.script

The design_name.script file is user-created and Both
contains the commands for Synopsys FPGA
Compiler or Design Compiler. These
commands specify the operating conditions,
the name and format of the design file, and
synthesis directives. Script files can have extensions other than .script.

design_name.v

The .v extension indicates the Verilog HDL
format.

design_name.vhd

The .vhd extension indicates the VHDL format. Both

Both

.synopsys_dc.setup The .synopsys_dc.setup file is the startup file
Both
for the Synopsys synthesis tools. It must reside
in your home directory or working directory.
XC4000e.sdb

The XC4000e.sdb file contains XC4000E schematic symbols for Synopsys.

Both

XC4000ex.sdb

The XC4000ex.sdb file contains XC4000EX
schematic symbols for Synopsys.

Both

XC4000xv.sdb

The XC4000xv.sdb file contains XC4000XV
schematic symbols for Synopsys.

Both

XC5200.sdb

The XC5200.sdb file contains XC5200 schematic Both
symbols for Synopsys.

XC3000a.sdb

The XC3000a.sdb file contains XC3000A schematic symbols for Synopsys.

spartan.sdb

The spartan.sdb file contains Spartan schematic Both
symbols for Synopsys.

spartanxl.sdb

The spartanxl.sdb file contains SpartanXL sche- Both
matic symbols for Synopsys.
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Table 6-1

File Descriptions

File

Description

FPGA Compiler
or Design
Compiler

virtex.sdb

The virtex.sdb file contains Virtex schematic
symbols for Synopsys.

XC9000.sdb

The XC9000.sdb file contains XC9000 schematic Both
symbols for Synopsys.

.sim

VSS simulation uses SIM files.

Both

design_name.sxnf

The design_name.sxnf file is the synthesized
design generated by the Synopsys synthesis
tools.

FPGA Compiler

design_name.sedif

The design_name.sedif file is the synthesized
design generated by the Synopsys synthesis
tools using the EDIF syntax.

Design Compiler

design_name.ncf

DC2NCF creates the design_name.ncf file.
Both
DC2NCF converts timing constraints applied to
your design in the Synopsys environment to
equivalent constraints that control the Xilinx
place and route process.

design_name.ngo

EDIF2NGD or XNF2NGD create the
design_name.ngo file, which contains a logical
description of your design in terms of its original components and hierarchy.

design_name.ngd

The NGDBuild program generates the
Both
design_name.ngd file, a binary file containing a
logical description of your design in terms of
both its original components and hierarchy, and
the NGD primitives to which your design is
reduced.

design_name.ncd

The MAP program generates the
design_name.ncd file, a physical description of
your design in terms of the components in the
target Xilinx device.

Both

design_routed.ncd

The design_routed.ncd file, generated by PAR,
is your placed and routed design.

Both
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Table 6-1
File

File Descriptions
FPGA Compiler
or Design
Compiler

Description

design_name.nga

NGDAnno generates the design_name.nga file, a Both
back-annotated NGD file.

design_name.vhd

This file is the VHDL timing simulation model
created by the NGD2VHDL program.

Both

design_name.sdf

This file is the timing back-annotation file
created by the NGD2VHDL program.

Both

Using Program Descriptions
This section describes the programs you use when translating,
mapping, placing, and routing your design using the XSI and
Synopsys tools. You can use the following programs with both
Design Compiler and FPGA Compiler.
Table 6-2
Program

Program Descriptions
Description

Design Analyzer

Design Analyzer is the Synopsys graphic interface to the Synopsys
synthesis tools.

DC Shell

DC Shell is the Synopsys UNIX command-line interface for entering
commands, arguments, and options to the Synopsys synthesis tools.

Synlibs

This program displays the target and link libraries for the specified
part type and speed grade. You can append the output of the Synlibs
command to the .synopsys_dc.setup file.
Note: You must list the libraries in your setup
file in the order that they appear in the Synlibs
output.

VHDLAN

The VHDLAN program analyzes a VHD source file for simulation.
Use the –i option with this program.

VHDLDBX

The VHDLDBX program is the VHDL Debugger, a graphic interface
to the VHDL simulator. Through its dialog box, you can issue simulator commands, view command output, and view source code.

NGDBUILD

This program reads a netlist file in XNF or EDIF format and creates
an NGD file describing a logical design.
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Table 6-2

Program Descriptions

Program

Description

DC2NCF

This program translates a Synopsys DC file to a netlist constraints
file (NCF) file. The DC file is a Synopsys file containing your design
constraints.

MAP

This program maps a logical design to a Xilinx FPGA.

TRACE

This program provides static timing analysis of your design based on
input timing constraints.

PAR

This program takes an NCD file, places and routes the design, and
outputs an NCD file, which is then used by the BitGen program.

NGDAnno

This program distributes delays, setup and hold times, and pulse
widths found in the physical NCD design file back to the logical
NGD file.

NGD2VHDL or
NGD2VER

These programs convert Xilinx NGD format into structural HDL for
gate-level simulation. Netlist consists of SimPrims.

BitGen

This program produces a bitstream for Xilinx device configuration. It
takes a fully routed NCD file as its input and creates a configuration
bitstream.

Using Supplied Libraries Descriptions
This section describes the Xilinx-supplied libraries and supported
part types and speed grades. The “Library Descriptions” table
contains the following variables.
•

family refers to the family of Xilinx devices, for example, 4000e,
4000ex, or 3000a.

•

parttype refers to the specific Xilinx device, for example, 4003e,
4005e, or 3120a.

•

4kparttype refers to the specific Xilinx XC4000 device, for
example, 4003e or 4005e.

•

–s indicates the part type’s speed grade, for example, –5. Not all
speed grades are available for all part types. Run Synlibs with the
–h option to get a listing of all available part type and speed
grade combinations.
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Table 6-3
Library

Library Descriptions
FPGA Compiler
or Design
Compiler

Description

xgen_3000a.db

The xgen_3000a.db library describes the
Both
XC3000a cells that do not contain timing
information, for example, CLBMAP, PULLUP,
net flags, and VCC.

xgen_3000l.db

The xgen_3000l.db library describes the
Both
XC3000l cells that do not contain timing information, for example, CLBMAP, PULLUP, net
flags, and VCC.

xgen_3100l.db

The xgen_3100l.db library describes the
Both
XC3100l cells that do not contain timing
information, for example, CLBMAP, PULLUP,
net flags, and VCC.

xgen_4000e.db

The xgen_4000e.db library describes the
XC4000e cells that do not contain timing
information, for example, FMAP, PULLUP,
and VCC.

xgen_4000l.db

The xgen_4000l.db library describes the
Both
XC4000l cells that do not contain timing information, for example, FMAP, PULLUP, and
VCC.

xgen_4000ex.db

The xgen_4000ex.db library describes the
XC4000ex cells that do not contain timing
information, for example, FMAP, PULLUP,
and VCC.

Both

xgen_4000xl.db

The xgen_4000xl.db library describes the
XC4000xl cells that do not contain timing
information, for example, FMAP, PULLUP,
and VCC.

Both

xgen_4000xla.db

The xgen_4000xla.db library describes the
XC4000xla cells that do not contain timing
information, for example, FMAP, PULLUP,
and VCC.

Both
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Table 6-3

Library Descriptions

Library

Description

FPGA Compiler
or Design
Compiler

xgen_4000xv.db

The xgen_4000xv.db library describes the
XC4000xv cells that do not contain timing
information, for example, FMAP, PULLUP,
and VCC.

xgen_5200.db

The xgen_5200.db library describes the
Both
XC5200 cells that do not contain timing information, for example, FMAP, PULLUP, and
VCC.

xprim_family-s.db

The xprim_family-s.db libraries describe the
Xilinx XC4000E/L/EX/XL/XLA/XV,
XC3000A/L, XC3100A/L, and XC5200 gates,
flip-flops, input/output buffers, and other
simple circuit elements whose delays do not
vary with the density of the part. These files
contain worst-case commercial (WCCOM)
timing information.

xprim_parttype–s.db

The xprim_ parttype–s.db libraries describe
Both
the Xilinx XC4000E/L/EX/XL/XLA/XV,
XC3000A/L, XC3100A/L, and XC5200 3-state
buffers, clock buffers, I/O decoders, and
other simple circuit elements whose delays
vary with the density of the part. These files
contain WCCOM timing information.

xio_4kparttype–s.db

The xio_4kparttype–s.db libraries describe the
Xilinx XC4000E/L/EX/XL/XLA/XV input/
output buffers whose delays vary with the
device type. These files contain WCCOM
timing information.

Both

xio_5kparttype–s.db

The xio_5kparttype–s.db libraries describe the
Xilinx XC5200 input/output buffers whose
delays vary with the device type. These files
contain WCCOM timing information.

Both
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Table 6-3
Library

Library Descriptions
FPGA Compiler
or Design
Compiler

Description

xfpga_family–s.db

The xfpga_family–s.db libraries describe the
Xilinx XC4000E/L/EX/XL/XLA/XV,
XC3000A/L, XC3100A/L, and XC5200 CLB
and IOB primitives, which allow the FPGA
Compiler to directly map to CLBs and IOBs.
These files contain WCCOM timing information.

xdc_family–s.db

The xdc_ family–s.db libraries contain Boolean Design Compiler
functions to which the Synopsys tools map.

xdw_4000e.sldb

The xdw_4000e.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xdw_4000l.sldb

The xdw_4000l.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xdw_4000ex.sldb

The xdw_4000ex.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xdw_4000xl.sldb

The xdw_4000xl.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xdw_4000xla.sldb

The xdw_4000xla.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.
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Table 6-3

Library Descriptions

Library

Description

FPGA Compiler
or Design
Compiler

xdw_4000xv.sldb

The xdw_4000xv.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xdw_5200.sldb

The xdw_5200.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xdw_spartan.sldb

The xdw_spartan.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xdw_spartanxl.sldb

The xdw_spartanxl.sldb library contains the Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xdw_virtex.sldb

The xdw_virtex.sldb library contains the
Both
DesignWare macros that allow adders,
subtracters, incrementers, decrementers, and
comparators to map directly to Xilinx DesignWare modules.

xprim_family/*.ngl

Data files containing XSI library component
expansion for NGDBuild.

Both

Finding Supported Part Types and Speed Grades
Run Synlibs with the –h option to get a listing of all available part
type and speed grade combinations. You can also refer to the Xilinx
online Data Book at http://www.xilinx.com for current speed grade
information.
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Finding Unsupported Part Types and Speed Grades
If designing for a part type or speed grade for which no libraries are
available, use the libraries for the closest part type or speed grade in
the same family. Indicate the part type or speed grade actually used
when you run PAR. The timing constraints in the NCF file can need
adjustment.
Note: For more information on specifying the part type, refer to the
Development System Reference Guide.
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Appendix A

XSI Library Primitives
You can find the XSI primitives in the XSI-supplied libraries in FPGA
Compiler and FPGA Express; you can instantiate them in your VHDL
or Verilog HDL file. Use the synlibs program to list the appropriate
libraries for a specific part type. Refer to the “Getting Started”
chapter for information on how to use synlibs.
In the primitive tables in this appendix, the names of the inputs and
outputs follow the primitive names, the applicable architecture, and
any important notes. All primitives in the libraries contain timing
parameters. The Notes column includes specific timing details and
additional functional information.
Although Synopsys cannot synthesize some primitives (primitives
with the Dont Touch and Dont Use attributes), you can instantiate
them. An asterisk (*) next to the primitive name indicates that you
can instantiate it. Refer to the Synopsys documentation for more
information on the Dont Touch and Dont Use attributes. Use the
name of a primitive to instantiate it. In addition, you must identify
the signals connected to the input and output pins when instantiating
a primitive.
In general, pins are organized with data pins before control pins.
When several pins are part of a bus, they are listed with the MSB first.
Buses of four or more bits follow bus notation, for example, A<7:0>.
Buses with fewer bits are kept as separate signals.
Synopsys FPGA Compiler II does not recognize the underscore character (“_”) as valid.
The following sections are included in this appendix.
•

“Generating a List of XSI Library Primitives”

•

“Obtaining XSI Library Primitive Pin Order”
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•

“Alphabetical List of Primitives for All Architectures”

•

“Understanding Virtex-Specific Cell Names”

•

“Xilinx DesignWare Modules”

•

“Post-Configuration Initialization States”

Generating a List of XSI Library Primitives
You can use the following procedure to generate a list of the XSI
library primitives provided in this appendix.
1.

Start DC Shell or Design Analyzer in a directory that contains
your .synopsys_dc.setup file. Ensure this setup file points to the
libraries you need to synthesize your designs in the XSI design
flow.

2.

In the command window of Design Analyzer or in DC Shell,
enter the following command.
read –f db link_library

3.

In the command window of Design Analyzer or in DC Shell,
enter the following command.
list –files
This command lists all the library files in memory.

4.

For each item in the list, enter the following command.
find cell filename/*
filename is the .db library file.
For example, for the library file xfpga_4000e-3.db the Find Cell
command lists the following.
xfpga_4000e-3/clb_4000
xfpga_4000e-3/iob_4000
The library file lists first, followed by the library primitive.
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Obtaining XSI Library Primitive Pin Order
Positional notation allows you to instantiate a primitive without
explicitly specifying the pins for that component. To use this notation,
you must know the pin order of the primitive. You can use the
following procedure to obtain the pin order for any of the XSI library
primitives provided in this appendix.
1.

Start DC Shell or Design Analyzer in a directory that contains
your .synopsys_dc.setup file.

2.

In DC Shell or in the command window of Design Analyzer,
enter the following command.
read –f db link_library

3.

In DC Shell or in the command window of Design Analyzer,
enter the following command.
list –files
This command lists all the library files in memory. Know which
file contains the relevant primitive.

4.

In DC Shell or in the command window of Design Analyzer,
enter the following command.
find (pin, “dbfilename/cellname/*”)
dbfilename is the name of the .db file that contains the primitive
and cellname is the relevant primitive.
For example, the following command finds the pin order of the
OR2 primitive in the XC4000EX library.
find (pin, “xprim_4000ex-3/OR2/*”)
This results in the following pin order.
{“O” “I1” “I0”}
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Alphabetical List of Primitives for All Architectures
This section lists the XSI primitives in alphabetical order with their
associated output, input, and bidirectional pins. In addition, the pins
are listed in the order used for positional notation. For example, the
pins for ACLK are listed with the O pin first, followed by the I pin.
Therefore, you can instantiate ACLK with only the signal (wire)
names; you do not need to declare the ACLK pins. You can also find
the applicable architecture and any notes in the tables included in this
section.

Using the Dont Touch Attribute
An asterisk (*) next to a primitive name indicates that you must
instantiate it. Also, you must apply the Dont Touch attribute to
instantiated primitives. Refer to the Synopsys documentation for
more information on the Dont Touch attribute.

Finding FPGA Compiler II Primitives
Synopsys FPGA Compiler II does not recognize the underscore character (“_”) as valid.

Setting the INIT Attribute
Before you can apply the INIT attribute to instantiated RAM and
ROM primitives, you must modify the Synopsys dc.setup_dc file,
which resides in $XILINX/synopsys/examples/
template.synopsys_dc_setup_fc. Change the following line in that
file.
edifout_write_properties_list = “instance_number \
pad_location part”

The new line, after the changes, appears as follows.
edifout_write_properties_list = “instance_number \
pad_location part” “INIT”
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Primitive Name Suffixes
The following table lists the primitive name suffixes and their corresponding descriptions.
Table A-1

Primitive Name Suffixes

Suffix

Description

I

Inverted global reset (INIT=S)

_F

Fast implementation of clock buffer (using dedicated
input clock pad) or fast slew rate for output buffers;
NODELAY attribute added for input registers

_M

Medium implementation of clock buffer (using dedicated input clock pad) or medium slew rate for output
buffers; MEDDELAY attribute added for input registers

_S

Slow slew rate

_U

Unbonded pad

_1

Inverted clock or gate on flip-flop or latch

_FLAG

Net/pin constraints

_TTL

TTL-compatible level

_CMOS

CMOS-compatible level

CAP

Capacitive slew rate

RES

Resistive slew rate

_N

No meaning; used as a placeholder

Virtex-Specific Primitive Name Suffixes
The following table lists the Virtex primitive name suffixes and their
corresponding descriptions.
Table A-2

Virtex Primitive Name Suffixes

Suffix

Description

_D

Both local and general output pin

_L

Single local output pin

_AGP

Advanced graphic port
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Table A-2
Suffix

Virtex Primitive Name Suffixes
Description

_CTT

Center tap terminated, low-level, high-speed interface
standard

_GTL

Gunning transistor logic

_GTLP

Gunning transistor logic plus

_HSTL_I

High speed transceiver logic, Class 1: 1.5 volt output
buffer supply voltage-based interface standard

_HSTL_III

High speed transceiver logic, Class II

_HSTL_IV

High speed transceiver logic, Class IV

_LVCOMS2 Low-voltage CMOS, 2.5 volt or lower

A-6

_PCI33_3

Partial connection interface

_PCI33_5

Partial connection interface

_PCI66_3

Partial connection interface

_SSTL2_I

Stub series terminated logic for 2.5 volts, Class I

_SSTL2_II

Stub series terminated logic for 2.5 volts, Class II

_SSTL3_I

Stub series terminated logic for 3.3 volts, Class I

_SSTL3_II

Stub series terminated logic for 3.3 volts, Class II

_F_x

Fast slew where drive (x) equals 2, 4, 6, 8, 12, 16, or 24
in units of milliamps (ma)

_S_x

Slow slew where drive (x) equals 2, 4, 6, 8, 12, 16, or 24
in units of milliamps (ma)

_Sx

Single-port synchronous block RAM, where x equals
the port bit width

_Sx_Sy

Dual-port synchronous block RAM, where x equals
the first port bit width and y equals the second port bit
width

_VIRTEX

Virtex-specific component for use in STARTUP,
STARTBUF, CAPTURE, and BSCAN
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Architecture Abbreviations
This appendix uses the architecture abbreviations listed in the
following table.
Table A-3

Architecture Abbreviations
Architecture

Abbreviation

XC3000A/L and XC3100A/L

3

XC4000E

4E

XC4000L

4L

XC4000EX

4EX

XC4000XL

4XL

XC4000XLA

4XLA

XC4000XV

4XV

XC5200

5

Spartan

S

Virtex

V

Primitive Tables
The following tables describe the XSI primitives.
Table A-4
Name

Output

“A”
Input

Architecture

Notes

ACLK*

O

I

3

Alternate

ACLK_F

O

I

3

Alternate;
using dedicated pad

AND2

O

I1, I0

3, 4E/L/EX/XLA/XL/XV,
5, S, V

AND3

O

I2, I1, I0

3, 4E/L/EX/XLA/XL/XV,
5, S, V

AND4

O

I3, I2, I1, I0

3, 4E/L/EX/XLA/XL/XV,
5, S, V

AND5

O

I4, I3, I2, I1, I0

3, 4E/L/EX/XLA/XL/XV,
5, S
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Table A-4
Name

“A”

Output

Input

Architecture

AND12

O

I11, I10, I9, I8, I7, 5
I6, I5, I4, I3, I2, I1,
I0

AND16

O

I15, I14, I13, I12, 5
I11, I10, I9, I8, I7,
I6, I5, I4, I3, I2, I1,
I0

Notes

An asterisk (*) next to a primitive name indicates that you must instantiate it.
Table A-5
Name

“B”

Output

Input

Architecture

Notes

BSCAN

TDO, DRCK,
IDLE, SEL1,
SEL2, RESET,
UPDATE,
SHIFT

TDI, TMS,
TCK, TDO1,
TDO2

4E/L/EX//XLA/
XL/XV, 5, S

No delay. RESET,
UPDATE, and
SHIFT outputs are
only applicable to
the XC5200.

BUF

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

No delay

BUFFCLK

O

I

4EX/XLA/XL/XV,
S

BUFG*

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

BUFGE

O

I

4EX/XL/XLA/XV,
S

BUFG_F

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

BUFGLS

O

I

4EX/XL/XLA/XV,S

BUFGP_F

O

I

4E/L/EX/XL/
XLA/XV, S

Fast implementation
of BUFGP; using
dedicated pad

BUFGS*

O

I

4E/L/EX/XL/
XLA/XV, S

No pad delay
included
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No pad delay
included

Fast implementation
of BUFG; using
dedicated pad
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Table A-5
Name

“B”

Output

Input

Architecture

Notes

BUFGS_F

O

I

4E/L/EX/XL/
XLA/XV, S

Fast implementation
of BUFGS; using
dedicated pad

BUFT

O

I, T

3, 4E/L/EX/XL/
XLA/XV, 5, S

Synopsys tools
synthesize an
internal 3-state
condition using
BUFTs.

I

5

BYPOSC*

An asterisk (*) next to a primitive name indicates that you must instantiate it.
Table A-6
Name

“C”

Output

C_FLAG*

Input
I

CK_DIV*

OSC1, OSC2 C

Architecture
3, 4E/L/EX/XL/
XLA/XV, 5, S

Notes
Signal is on a critical path.

5

*

A, B, C, D, E, 3
K, EC, DI,
RD, X, Y

Pins locked to
external signals;
function generator
closed to additional
logic

CLBMAP_PLO*

A, B, C, D, E, 3
K, EC, DI,
RD, X, Y

Pins locked to
external signals;
function generator
open to additional
logic

CLBMAP_PUC*

A, B, C, D, E, 3
K, EC, DI,
RD, X, Y

Pins unlocked from
signals; function
generator closed to
additional logic

CLBMAP_PLC
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Table A-6
Name
CLBMAP_PUO

CY_MUX*

“C”

Output
*

CO

Input

Architecture

Notes

A, B, C, D, E, 3
K, EC, DI,
RD, X, Y

Pins unlocked from
signals; function
generator open to
additional logic

DI, CI, S

Carry chain multiplexer.

5

An asterisk (*) next to a primitive name indicates that you must instantiate it.
Table A-7
Name

“D”

Output

Input

Architecture

Notes

DEC_CC4*

O

C_IN, A3....A0

5

4-bit internal
decoder built using
C4_MUXes and
lookup tables

DEC_CC8*

O

C_IN, A7....A0

5

8-bit internal
decoder built using
CY_MUXes and
lookup tables

DEC_CC16*

O

C_IN, A15....A0 5

16-bit internal
decoder built using
C4_MUXes and
lookup tables

DECODE1_INT* O

I

4E/L/EX/XL/ 1-bit edge decoder;
XLA/XV
no pull-up resistor;
input from internal
logic

DECODE1_IO*

I

4E/L/EX/XL/ 1-bit I/O edge
XLA/XV
decoder; no pull-up
resistor

A-10
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Table A-7
Name

“D”

Output

Input

Architecture

Notes

*

O

A3....A0

4E/L/EX/XL/ 4-bit I/O edge
XLA/XV, 5
decoder; no pull-up
resistor. In 4E/L/
EX/XL/XV a 4-bit
internal decoder
built using
CY_MUXes and
lookup tables (5)

DECODE8*

O

A7....A0

4E/L/EX/XL/ 8-bit I/O edge
XLA/XV, 5
decoder; no pull-up
resistor. In 4E/L/
EX/XL/XV an 8-bit
internal decoder
built using
CY_MUXes and
lookup tables (5)

DECODE16*

O

A15....A0

4E/L/EX/XL/ 16-bit I/O edge
XLA/XV, 5
decoder; no pull-up
resistor. In 4E/L/
EX/XL/XV a 16-bit
internal decoder
built using
CY_MUXes and
lookup tables (5)

DECODE32*

O

A31....A0

5

In 4E/L/EX/XL/
XV a32-bit internal
decoder built using
CY_MUXes and
lookup tables (5)

DECODE64*

O

A63....A0

5

In 4E/L/EX/XL/
XV a 64-bit internal
decoder built using
CY_MUXes and
lookup tables (5)

DECODE4

An asterisk (*) next to a primitive name indicates that you must instantiate it.
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Table A-8
Name
F5_MUX

*

Output
O

F5MAP_PUC*

“F”
Input

Architecture

Notes

I1, I2, DI

5

Used to connect two
FMAPs to form a 5input function.

I5, I4, I3, I2,
I1, 0

5

Pins unlocked from
signals; function
generator closed to
additional logic.
With Clear Direct;
initial startup value
is 0

FDC

Q

D, C, CLR

3, 4E/L/EX/XL/
XLA/XV, 5, S

FDC_1

Q

D, C, CLR

3, 5, V

FDCE

Q

D, C, CE,
CLR

3, 4E/L/EX/XL/
XLA/XV, 5, S

FDCE_1

Q

D, C, CE,
CLR

3, 5

FDP

Q

D, C, PRE

4E/L/EX/XL/
XLA/XV, S, V

With Preset Direct;
initial startup value
is 1

FDPE

Q

D, C, CE,
PRE

4E/L/EX/XL/
XLA/XV, S, V

Clock Enable with
Preset Direct; initial
startup value is 1

FDPEI

Q

D, C, CE,
PRE

3, 5

Clock Enable with
Preset Direct; initial
startup value is 1

FDPEI_1

Q

D, C, CE,
PRE

3, 5

FDPI

Q

D, C, PRE

3, 5

FDPI_1

Q

D, C, PRE

3, 5
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Clock Enable with
Clear Direct; initial
startup value is 0
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initial startup value
is 1
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Table A-8
Name

“F”

Output

Input

Architecture

Notes

*

I4, I3, I2, I1, 0 4E/L/EX/XL/
XLA/XV, 5, S

Pins locked to
external signals;
function generator
closed to additional
logic.

FMAP_PLO*

I4, I3, I2, I1, 0 4E/L/EX/XL/
XLA/XV, 5, S

Pins locked to
external signals;
function generator
open to additional
logic.

FMAP_PUC*

I4, I3, I2, I1, 0 4E/L/EX/XL/
XLA/XV, 5, S

Pins unlocked from
signals; function
generator closed to
additional logic.

FMAP_PUO*

I4, I3, I2, I1, 0 4E/L/EX/XL/
XLA/XV, 5, S

Pins unlocked from
signals; function
generator open to
additional logic.

FMAP_PLC

An asterisk (*) next to a primitive name indicates that you must instantiate it.
Table A-9
Name

“G”

Output

Input

Architecture

Notes

GCLK*

O

I

3

Global

GCLK_F

O

I

3

Global; using
dedicated pad

GND

G

3, 4E/L/EX/XL/
XLA/XV, 5, S

GXTL*

O

3

Crystal; no
delay

An asterisk (*) next to a primitive name indicates that you must instantiate it.
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Table A-10
Name
HMAP_PUC

“H”

Output

Input

*

I3, I2, I1, 0

Architecture

Notes

4E/L/EX/XL/XLA/
XV, S

An asterisk (*) next to a primitive name indicates that you must instantiate it.

Name

Table A-11

“I”

Output

In-out

Input

Architecture

Notes

IBUF

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S, V (refer
to the “Virtex Primitive Name Suffixes”
table)

IBUF_F*

O

I

5

Includes
NODELAY
attribute

IBUF_U*

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

Unbonded pad

IBUFN

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

Slow output
slew rate

IFD

Q

D, C

3, 4E/L/EX/XL/
XLA/XV, S

IFD_F

Q

D, C

4E/L/EX/XL/XLA/
XV, S

Includes
NODELAY
attribute

IFD_M*

Q

D, C

4EX/XL/XLA/XV, S

Includes
MEDDELAY
attribute

IFD_U*

Q

D, C

3, 4E/L/EX/XL/
XLA/XV, S

Unbonded pad

IFDI*

Q

D, C

4E/L/EX/XL/XLA/
XV, S

INIT=S;
inverted Global
Reset
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Table A-11

“I”

Name

Output

In-out

*

Q

D, C

4E/L/EX/XL/XLA/
XV, S

Includes
NODELAY
attribute;
INIT=S;
inverted Global
Reset

IFDI_M*

Q

D, C

4EX/XL/XLA/XV, S

Includes
MEDDELAY
attribute

IFDI_U*

Q

D, C

4E/L/EX/XL/XLA/
XV, S

Unbonded pad;
INIT=S;
inverted Global
Reset

IFDX*

Q

D, C,
CE

4E/L/EX/XL/XLA/
XV, S

IFDX_F*

Q

D, C,
CE

4E/L/EX/XL/XLA/
XV, S

NODELAY
attribute added

IFDX_M*

Q

D, C,
CE

4EX/XL/XLA/XV, S

Includes
MEDDELAY
attribute

IFDX_U*

Q

D, C,
CE

4E/L/EX/XL/XLA/
XV, S

IFDXI*

Q

D, C,
CE

4E/L/EX/XL/XLA/
XV, S

IFDXI_F*

Q

D, C,
CE

4E/L/EX/XL/XLA/
XV, S

NODELAY
attribute added

IFDXI_M*

Q

D, C,
CE

4EX/XL/XLA/XV, S

Includes
MEDDELAY
attribute

IFDXI_U*

Q

D, C,
CE

4E/L/EX/XL/XLA/
XV, S

ILD

Q

D, G

3

ILD_1

Q

D, G

4E/L/EX/XL/XLA/
XV, S

IFDI_F
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Name

Table A-11

“I”

Output

In-out

Input

Architecture

Notes

ILD_1F

Q

D, G

4E/L/EX/XL/XLA/
XV, S

NODELAY
attribute added

ILD_1M*

Q

D, G

4EX/XL/XLA/XV, S

Includes
MEDDELAY
attribute

ILD_1U*

Q

D, G

4E/L/EX/XL/XLA/
XV, S

Unbonded pad

ILDI_1*

Q

D, G

4E/L/EX/XL/XLA/
XV, S

Inverted Global
Reset

ILDI_1F*

Q

D, G

4E/L/EX/XL/XLA/
XV, S

NODELAY
attribute
added; initializes High

ILDI_1M*

Q

D, G

4EX/XL/XLA/XV, S

Includes
MEDDELAY
attribute

ILDI_1U*

Q

D, G

4E/L/EX/XL/XLA/
XV, S

Unbonded pad;
inverted Global
Reset

ILDX_1*

Q

D, G,
GE

4E/L/EX/XL/XLA/
XV, S

ILDX_1F*

Q

D, G,
GE

4E/L/EX/XLXLA//
XV, S

NODELAY
attribute added

ILDX_1M*

Q

D, G,
GE

4EX/XL/XLA/XV, S

Includes
MEDDELAY
attribute

ILDX_1U*

Q

D, G,
GE

4E/L/EX/XL/XLA/
XV, S

Unbonded pad

ILDXI_1*

Q

D, G,
GE

4E/L/EX/XL/XLA/
XV, S

ILDXI_1F*

Q

D, G,
GE

4E/L/EX/XL/XLA/
XV, S
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Name

Table A-11

“I”

Output

In-out

Input

Architecture

Notes

*

Q

D, G,
GE

4EX/XL/XLA/XV, S

Includes
MEDDELAY
attribute

ILDXI_1U*

Q

D, G,
GE

4E/L/EX/XL/XLA/
XV, S

Unbonded pad

ILFFX_F*

Q

D, GF, 4EX/XL/XLA/XV, S
CE, C

NODELAY
attribute added

ILFFX_M*

Q

D, GF, 4EX/XL/XLA/XV, S
CE, C

Includes
MEDDELAY
attribute

ILFFXI_F*

Q

D, GF, 4EX/XL/XLA/XV, S
CE, C

NODELAY
attribute added

ILFFXI_M*

Q

D, GF, 4EX/XL/XLA/XV, S
CE, C

Includes
MEDDELAY
attribute

ILFLX_F*

Q

D, GF, 4EX/XL/XLA/XV, S
GE, G

NODELAY
attribute added

ILFLX_M*

Q

D, GF, 4EX/XL/XLA/XV, S
GE, G

Includes
MEDDELAY
attribute

ILFLX_1F*

Q

D, GF, 4EX/XL/XLA/XV, S
GE, G

NODELAY
attribute added

ILFLX_1M*

Q

D, GF, 4EX/XL/XLA/XV, S
GE, G

Includes
MEDDELAY
attribute

ILFLXI_1F*

Q

D, GF, 4EX/XL/XLA/XV, S
GE, G

NODELAY
attribute added

ILFLXI_1M*

Q

D, GF, 4EX/XL/XLA/XV, S
GE, G

Includes
MEDDELAY
attribute

INV

O

I

No delay

ILDXI_1M
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Name

Table A-11

“I”

Output

In-out

Input

Architecture

Notes

IOBUF

O

IO

I, T

3, 4E/L/EX/XL/
Slow slew rate
XLA/XV, 5, S, V (refer
to the “Virtex Primitive Name Suffixes”
table)

IOBUF_F

O

IO

I, T

4XV

Fast output
slew rate

IOBUF_S

O

IO

I, T

4XV

Slow output
slew rate

IOBUF_N_F

O

IO

I, T

3, 4E/L/EX/XL/XLA, Fast output
5, S
slew rate

IOBUF_N_S

O

IO

I, T

3, 4E/L/EX/XL/XLA, Slow output
5, S
slew rate

IOBUF_24

O

IO

I, T

4XV

Slow output
slew rate

IOBUF_F_24

O

IO

I, T

4XV

Fast output
slew rate

IOBUFD

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFD_24

O

IO

I

4XV

Slow output
slew rate

IOBUFDN

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFDN_24

O

IO

I

4XV

Slow output
slew rate

IOBUFD_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFD_F_24

O

IO

I

4XV

Fast output
slew rate

IOBUFD_S

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFD_S_24

O

IO

I

4XV

Slow output
slew rate
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Name

Table A-11

“I”

Output

In-out

Input

Architecture

Notes

IOBUFDN_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFDN_F_24

O

IO

I

4XV

Fast output
slew rate

IOBUFDN_S

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFDN_S_24

O

IO

I

4XV

Slow output
slew rate

IOBUFN

O

IO

I, T

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFN_24

O

IO

I, T

4XV

Slow output
slew rate

IOBUFN_F

O

IO

I, T

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFN_F_24

O

IO

I, T

4XV

Fast output
slew rate

IOBUFN_S

O

IO

I, T

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFN_S_24

O

IO

I, T

4XV

Slow output
slew rate

IOBUFND

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFND_24

O

IO

I

4XV

Slow output
slew rate

IOBUFND_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFND_F_24

O

IO

I

4XV

Fast output
slew rate

IOBUFND_S

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFND_S_24

O

IO

I

4XV

Slow output
slew rate
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Name

Table A-11

“I”

Output

In-out

Input

Architecture

Notes

IOBUFNDN

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFNDN_24

O

IO

I

4XV

Slow output
slew rate

IOBUFNDN_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFNDN_F_24

O

IO

I

4XV

Fast output
slew rate

IOBUFNDN_S

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFNDN_S_24

O

IO

I

4XV

Slow output
slew rate

IOBUFNN

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFNN_24

O

IO

I

4XV

Slow output
slew rate

IOBUFNN_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFNN_F_24

O

IO

I

4XV

Fast output
slew rate

IOBUFNS

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFNS_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFNS_F_24

O

IO

I

4XV

Fast output
slew rate

IOBUFNS_S

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFNS_S_24

O

IO

I

4XV

Slow output
slew rate

IOBUFNS_24

O

IO

I

4XV

Slow output
slew rate
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Name

Table A-11

“I”

Output

In-out

Input

Architecture

Notes

IOBUFNSN

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFNSN_24

O

IO

I

4XV

Slow output
slew rate

IOBUFNSN_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFNSN_F_24

O

IO

I

4XV

Fast output
slew rate

IOBUFNSN_S

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFNSN_S_24

O

IO

I

4XV

Slow output
slew rate

IOBUFS

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFS_24

O

IO

I

4XV

Slow output
slew rate

IOBUFS_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFS_F_24

O

IO

I

4XV

Fast output
slew rate

IOBUFS_S

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFS_S_24

O

IO

I

4XV

Slow output
slew rate

IOBUFSN

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFSN_24

O

IO

I

4XV

Slow output
slew rate

IOBUFSN_F

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output
slew rate

IOBUFSN_F_24

O

IO

I

4XV

Fast output
slew rate
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Name

Table A-11

“I”

Output

In-out

Input

Architecture

Notes

IOBUFSN_S

O

IO

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output
slew rate

IOBUFSN_S_24

O

IO

I

4XV

Slow output
slew rate

An asterisk (*) next to a primitive name indicates that you must instantiate it.
Table A-12
Name

Output

L_FLAG*

“L”

Input

Architecture

I

3

Notes
Rout signal along a
longline.

LD

Q

D, G

3, 4EX/XL/XLA/XV, 3: built from gates; not
5, S
recommended; use D flipflops.
4EX/XLXV, 5: built into
CLB; programmable as D
flip-flop or latch.

LD_1

Q

D, G

4E/L/EX/XL/XLA/ 4E/L: built from gates;
XV, 5, S, V
not recommended; use D
flip-flops.
4EX/XL/XV ,5: built into
CLB; programmable as D
flip-flop or latch.

LDC

Q

D, G, CLR

3, 5

A-22
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Table A-12
Name

Output

“L”

Input

Architecture

Notes

LDC_1

Q

D, G, CLR

4E/L/EX/XL/XLA/ With Clear Direct. 4E/L:
XV, 5, S, V
built from gates; not
recommended; use D flipflops.
4EX/XL/XV, 5: built into
CLB; programmable as D
flip-flop or latch.

LDCE

Q

D, G, GE,
CLR

4EX/XL/XLA/XV, 5,
S

LDCE_1

Q

D, G, GE,
CLR

4EX/XLXLA//XV, 5,
S

LDP

Q

D, G, PRE

3

LDP_1

Q

D, G, PRE

4E/L/EX/XL/XLA/ With Preset Direct. 4E/L:
XV, S, V
built from gates; not
recommended. Use D flipflops.
4EX/XL/XV, ,5: built into
CLB; programmable as D
flip-flop or latch.

LDPE

Q

D, G, GE,
PRE

4EX/XL/XLA/XV, S

LDPE_1

Q

D, G, GE,
PRE

4EX/XL/XLA/XV, S

With Preset Direct. Built
from gates; not recommended. Use D flip-flops.

An asterisk (*) next to a primitive name indicates that you must instantiate it.
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Table A-13
Name
MD0

*

Output

“M”

Input

I

MD1*

O

MD2*

I

Architecture

Notes

4E/L/EX/XL/XLA/
XV, 5

Input pad for BSCAN.
5: This pin is in-out.

4E/L/EX/XL/XLA/
XV, 5

Output pad for BSCAN.
5: This pin is in-out.

4E/L/EX/XL/XLA/
XV, 5

Input pad for BSCAN.
5: This pin is in-out.

An asterisk (*) next to a primitive name indicates that you must instantiate it.

Table A-14 “N”
Name

Output

*

N_FLAG

Input

Architecture

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

NAND2

O

I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

NAND3

O

I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

NAND4

O

I3, I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

NAND5

O

I4, I3, I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S

NAND12

O

I11, I10, I9, I8, I7, 5
I6, I5, I4, I3, I2,
I1, I0

NAND16

O

I15, I14, I13, I12, 5
I11, I10, I9, I8, I7,
I6, I5, I4, I3, I2,
I1, I0

NOR2

O

I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

NOR3

O

I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

A-24
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Table A-14
Name

Output

“N”
Input

Architecture

NOR4

O

I3, I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

NOR5

O

I4, I3, I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S

NOR12

O

I11, I10, I9, I8, I7, 5
I6, I5, I4, I3, I2,
I1, I0

NOR16

O

I15, I14, I13, I12, 5
I11, I10, I9, I8, I7,
I6, I5, I4, I3, I2,
I1, I0

Notes

An asterisk (*) next to a primitive name indicates that you must instantiate it.
Table A-15
Name

“O”

Output

Input

Architecture

Notes

OAND2*

O

F, I0

4EX/XL/XLA/XV, S

OBUF

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S, V (refer
to the “Virtex Primitive Name Suffixes”
table)

OBUF_24

O

I

4XV

OBUF_F

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

Fast slew rate

OBUF_F_24

O

I

4XV

Fast slew rate

OBUF_S

O

I

4E/L/EX/XL/XLA/
XV, 5, S

Slow slew rate

O

I

4XV

Slow slew rate

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

Unbonded pad

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUF_S_24
OBUF_U
OBUFD

*
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Table A-15
Name

“O”

Output

Input

Architecture

Notes

OBUFD_24

O

I

4XV

Slow output slew
rate

OBUFD_F

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output slew
rate

OBUFD_F_24

O

I

4XV

Fast output slew
rate

OBUFD_S

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFD_S_24

O

I

4XV

Slow output slew
rate

OBUFDN

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFDN_24

O

I

4XV

Slow output slew
rate

OBUFDN_F

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output slew
rate

OBUFDN_F_24

O

I

4XV

Fast output slew
rate

OBUFDN_S

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFDN_S_24

O

I

4XV

Slow output slew
rate

OBUFE_24

O

I, E

4XV

OBUFE_F_24

O

I, E

4XV

OBUFE_S_24

O

I, E

4XV

OBUFEN

O

I, E

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFEN_24

O

I, E

4XV

Slow output slew
rate

OBUFEN_F

O

I, E

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output slew
rate

OBUFEN_F_24

O

I, E

4XV

Fast output slew
rate
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Table A-15
Name

“O”

Output

Input

Architecture

Notes

OBUFEN_S

O

I, E

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFEN_S_24

O

I, E

4XV

Slow output slew
rate

OBUFN

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFN_24

O

I

4XV

Slow output slew
rate

OBUFN_F

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output slew
rate

OBUFN_F_24

O

I

4XV

Fast output slew
rate

OBUFN_S

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFN_S_24

O

I

4XV

Slow output slew
rate

OBUFNSN_S

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFNSN_S_24

O

I

4XV

Slow output slew
rate

OBUFS

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFS_24

O

I

4XV

Slow output slew
rate

OBUFS_F

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output slew
rate

OBUFS_F_24

O

I

4XV

Fast output slew
rate

OBUFS_S

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUF_S_24

O

I

4XV

Slow output slew
rate
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Table A-15
Name

“O”

Output

Input

Architecture

Notes

OBUFSN

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFSN_F

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output slew
rate

OBUFSN_F_24

O

I

4XV

Fast output slew
rate

OBUFSN_S

O

I

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFSN_S_24

O

I

4XV

Slow output slew
rate

OBUFT

O

I, T

3, 4E/L/EX/XL/
XLA/XV, 5, S, V (refer
to the “Virtex Primitive Name Suffixes”
table)

OBUFT_24

O

I, T

4XV

OBUFT_F

O

I, T

3, 4E/L/EX/XL/
XLA/XV, 5, S

OBUFT_F_24

O

I, T

4XV

OBUFT_S

O

I, T

4E/L/EX/XL/XLA/
XV, 5, S

OBUFT_S_24

O

I, T

4XV

OBUFT_U*

O

I, T

4E/L/EX/XL/XLA/
XV, 5, S

Unbonded pad

OBUFTN

O

I, T

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate

OBUFTN_24

O

I, T

4XV

Slow output slew
rate

OBUFTN_F

O

I, T

3, 4E/L/XLA/EX/
XL/XV, 5,S

Fast output slew
rate

OBUFTN_S

O

I, T

3, 4E/L/XLA/EX/
XL/XV, 5,S

Slow output slew
rate
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Table A-15
Name

Output

“O”
Input

Architecture

Notes

OFD

Q

D, C

3, 4E/L/EX/XL/
XLA/XV, S

OFD_24

Q

D, C

4XV

OFD_F

Q

D, C

3, 4E/L/EX/XL/
XLA/XV, S

OFD_F_24

Q

D, C

4XV

OFD_FU*

Q

D, C

3, 4E/L/EX/XL/
XLA/XV, S

Fast slew rate;
unbonded pad

OFD_S

Q

D, C

4E/L/EX/XL/XLA/
XV, S

Slow slew rate

OFD_S_24

Q

D, C

4XV

OFD_U*

Q

D, C

3, 4E/L/EX/XL/
XLA/XV, S

OFDI*

Q

D, C

4E/L/EX/XL/XLA/
XV, S

OFDI_24

Q

D, C

4XV

OFDI_F*

Q

D, C

4E/L/EX/XL/XLA/
XV, S

OFDI_F_24

Q

D, C

4XV

OFDI_S*

Q

D, C

4E/L/EX/XL/XLA/
XV, S

OFDI_S_24

Q

D, C

4XV

OFDI_U*

Q

D, C

4E/L/EX/XL/XLA/
XV, S

OFDT

O

D, C, T

3, 4E/L/EX/XL/
XLA/XV, S

OFDT_24

O

D, C, T

4XV

OFDT_F

O

D, C, T

3, 4E/L/EX/XL/
XLA/XV, S

OFDT_F_24

O

D, C, T

4XV

OFDT_S

O

D, C, T

4E/L/EX/XL/XLA/
XV, S
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Table A-15
Name

Output

“O”
Input

Architecture

Notes

OFDT_S_24

O

D, C, T

4XV

OFDT_U*

O

D, C, T

4E/L/EX/XL/XLA/
XV, S

OFDTI*

O

D, C, T

4E/L/EX/XL/XLA/
XV, S

OFDTI_24

O

D, C, T

4XV

OFDTI_F*

O

D, C, T

4E/L/EX/XL/XLA/
XV, S

OFDTI_F_24

O

D, C, T

4XV

OFDTI_S*

O

D, C, T

4E/L/EX/XL/XLA/
XV, S

OFDTI_S_24

O

D, C, T

4XV

OFDTI_U*

O

D, C, T

4E/L/EX/XL/XLA/
XV, S

OFDX*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S

OFDX_24

Q

D, C, CE

4XV

OFDX_F*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S

OFDX_F_24

Q

D, C, CE

4XV

OFDX_FU*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S

Fast slew rate;
unbonded pad

OFDX_S*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S

Slow slew rate

OFDX_S_24

Q

D, C, CE

4XV

OFDX_U*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S

OFDXI*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S

OFDXI_24

Q

D, C, CE

4XV

OFDXI_F*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S
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Table A-15
Name

Output

“O”
Input

Architecture

OFDXI_F_24

Q

D, C, CE

4XV

OFDXI_S*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S

OFDXI_S_24

Q

D, C, CE

4XV

OFDXI_U*

Q

D, C, CE

4E/L/EX/XL/XLA/
XV, S

OFDTX*

O

D, C, CE, T 4E/L/EX/XL/XLA/
XV, S

OFDTX_24

O

D, C, CE, T 4XV

OFDTX_F*

O

D, C, CE, T 4E/L/EX/XL/XLA/
XV, S

OFDTX_F_24

O

D, C, CE, T 4XV

OFDTX_S*

O

D, C, CE, T 4E/L/EX/XL/XLA/
XV, S

OFDTX_S_24

O

D, C, CE, T 4XV

OFDTX_U*

O

D, C, CE, T 4E/L/EX/XL/XLA/
XV, S

OFDTXI*

O

D, C, CE, T 4E/L/EX/XL/XLA/
XV, S

OFDTXI_24

O

D, C, CE, T 4XV

OFDTXI_F*

O

D, C, CE, T 4E/L/EX/XL/XLA/
XV, S

OFDTXI_F_24

O

D, C, CE, T 4XV

OFDTXI_S*

O

D, C, CE, T 4E/L/EX/XL/XLA/
XV, S

OFDTXI_S_24

O

D, C, CE, T 4XV

OFDTXI_U*

O

D, C, CE, T 4E/L/EX/XL/XLA/
XV, S

OMUX2

O

D0, D1, S0

4EX/XL/XLA/XV, S

ONAND2

O

F, I0

4EX/XL/XLA/XV, S

ONOR2

O

F, I0

4EX/XL/XLA/XV, S
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Table A-15
Name

“O”

Output

Input

Architecture

Notes

OOR2

O

F, I0

4EX/XL/XLA/XV, S

OR2

O

I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

OR3

O

I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

OR4

O

I3, I2, I1, I0 3, 4E/L/EX/XL/
XLA/XV, 5, S

OR5

O

I4, I3, I2, I1, 3, 4E/L/EX/XL/
I0
XLA/XV, 5, S

OR12

O

I11, I10, I9, 5
I8, I7, I6, I5,
I4, I3, I2, I1,
I0

OR16

O

I15, I14,
5
I13, I12, I11,
I10, I9, I8,
I7, I6, I5, I4,
I3, I2, I1, I0

O

3

F8M,
F500K,
F16K,
F490, F15

4E/L/EX/XL/XLA/
XV, S

OSC5*

OSC1,
OSC2

5

No delay

OSC52*

OSC1,
OSC2

C

5

No delay

O

F, I0

4EX/XL/XLA/XV, S

O

F, I0

4EX/XL/XLA/XV, S

OSC*
OSC4

*

OXNOR2*
OXOR2

*

No delay

An asterisk (*) next to a primitive name indicates that you must instantiate it.

A-32

Xilinx Development System

XSI Library Primitives

Table A-16
Name
PULLDOWN

Output
*

PULLUP*

“P”
Input

Architecture

Notes

O

4E/L/EX/XL/XLA/
XV, 5, S

No delay; used for
IOBs or BUFTs

O

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

No delay; used for
IOBs or BUFTs

An asterisk (*) next to a primitive name indicates that you must instantiate it.

Table A-17 “R”
Name

Output

Input

Architecture

RAM16X1

O

D, A3, A2, A1, A0, 4E/L/EX/XL/XLA/
WE
XV

RAM32X1

O

D, A4, A3, A2, A1, 4E/L/EX/XL/XLA/
A0, WE
XV

RAM16X1S

O

D, A3, A2, A1, A0, 4E/L/EX/XL/XLA/
WE, WCLK
XV, S

RAM32X1S

O

D, A4, A3, A2, A1, 4E/L/EX/XL/XLA/
A0, WE, WCLK
XV, S

RAM16X1D

SPO, DPO

D, A3, A2, A1, A0, 4E/L/EX/XL/XLA/
DPRA3, DPRA2, XV, S
DPRA1, DPRA0,
WE, WCLK

Notes

READBACK* DATA, RIP CLK, TRIG

4E/L/EX/XL/XLA/
XV, 5, S

ROC*

O

3, 4E/L/EX/XL/
XLA/XV, 5, S

ROCBUF*

O

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

ROM16X1

O

A3, A2, A1, A0

4E/L/EX/XL/XLA/
XV, S

Must add ROM
value

ROM32X1

O

A4, A3, A2, A1,
A0

4E/L/EX/XL/XLA/
XV, S

Must add ROM
value

No delay

An asterisk (*) next to a primitive name indicates that you must instantiate it.
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Table A-18
Name
S_FLAG

“S”

Output

Input

*

Architecture

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

STARTBUF*

GSROUT,
GTSOUT,
Q2OUT, Q3OUT,
Q1Q4OUT,
DONEINOUT

GSRIN,
GTSIN,
CLKIN

4E/L/EX/XL/XLA/
XV, 5, S

STARTUP*

Q2, Q3, Q1Q4,
DONEIN

GSR, GTS,
CLK

4E/L/EX/XL/XLA/
XV, 5, S

Notes
Save signal;
treat it as
external
connection.

An asterisk (*) next to a primitive name indicates that you must instantiate it.

Table A-19 “T”
Name
TCK

*

TDI*

Output

Input

Architecture

Notes

I

4E/L/EX/XL/XLA/
XV, 5, S

Input pad for BSCAN

I

4E/L/EX/XL/XLA/
XV, 5, S

Input pad for BSCAN

4E/L/EX/XL/XLA/
XV, 5, S

Output pad for BSCAN
Input pad for BSCAN

TDO*

O

TMS*

I

4E/L/EX/XL/XLA/
XV, 5, S

TOC*

O

4E/L/EX/XL/XLA/
XV, 5, S

TOCBUF*

O

I

4E/L/EX/XL/XLA/
XV, 5, S

An asterisk (*) next to a primitive name indicates that you must instantiate it.
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Table A-20
Name
VCC

“V”

Output

Input

Architecture

VCC

Notes

3,4E/L/EX/XL/XLA/
XV, 5, S

Table A-21 “W”
Name
WAND1

*

Output
O

WOR2AND* O

Input

Architecture

Notes

I

4E/L/EX/XL/XLA/
XV

No pull-up resistor

I1, I0

4E/L/EX/XL/XLA/
XV

No pull-up resistor

An asterisk (*) next to a primitive name indicates that you must instantiate it.

Table A-22 “X”
Name
X_FLAG

Output

*

Input

Architecture

I

3, 4E/L/EX/XL/
XLA/XV, 5, S

XOR2

O

I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

XOR3

O

I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

XOR4

O

I3, I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

XOR5

O

I4, I3, I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S

XNOR2

O

I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S, V

XNOR3

O

I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S

XNOR4

O

I3, I2, I1, I0

3, 4E/L/EX/XL/
XLA/XV, 5, S
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Table A-22
Name
XNOR5

Output

“X”
Input

O

I4, I3, I2, I1, I0

Architecture

Notes

3, 4E/L/EX/XL/
XLA/XV, 5, S

An asterisk (*) next to a primitive name indicates that you must instantiate it.

Understanding Virtex-Specific Cell Names
The following sections list Virtex-specific suffixes, primitives, and
RAM cell names.

Virtex-Specific Primitives Table
The following table describes the Virtex-specific XSI primitives.
Table A-23 Virtex-Specific Primitives
Name

Output

Input

Notes

BSCAN_VIRTEX

TDI, DRCK1,
TDO1, TDO2
DRCK2, SEL1, SEL2,
RESET, UPDATE,
SHIFT

BUFE

O

I, E

Tri-state buffer;
active-low tri-state

BUFCF

O

I

Fast-connect buffer

BUFGP

O

I

Clock buffer using
dedicated pad

BUFGDLL*

O

I

CLKDLL with dedicated clock pad

CAPTURE_VIRTEX
*

CAP, CLK
CLK0, CLK90,
CLK180, CLK270,
CLK2X, CLKDV,
LOCKED

CLKIN, CLKFB,
RST

Clock delay-lock
loop

CLKDLLHF*

CLK0, CLK180,
CLKDV, LOCKED

CLKIN, CLKFB,
LOCKED

High-frequency
version of CLKDLL

FD

Q

D, C

CLKDLL

A-36

Xilinx Development System

XSI Library Primitives
Table A-23 Virtex-Specific Primitives
Name

Output

Input

Notes

FD_1

Q

D, C

FDCP

Q

D, C, CLR, PRE

FDCP_1

Q

D, C, CLR, PRE

FDCPE

Q

D, C, CLR, PRE,
CE

D flip-flop with
clock enable and
asynchronous clear
and preset; clear
overrides preset.

FDCPE_1

Q

D, C, CLR, PRE,
CE

D flip-flop with
clock enable and
asynchronous clear
and preset; clear
overrides preset.

FDE

Q

D, C, CE

FDE_1

Q

D, C, CE

FDP_1

Q

D, C, PRE

FDR

Q

D, C, R

FDR_1

Q

D, C, R

FDRE

Q

D, C, R, CE

FDRE_1

Q

D, C, R, CE

FDRS

Q

D, C, R, S

FDRS_1

Q

D, C, R, S

FDRSE

Q

D, C, R, S, CE

D flip-flop with
clock enable and
synchronous clear
and set; clear overrides set.

FDRSE_1

Q

D, C, R, S, CE

D flip-flop with
clock enable and
synchronous clear
and set; clear overrides set.

FDS

Q

D, C, S
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Table A-23 Virtex-Specific Primitives
Name

Output

Input

Notes

FDS_1

Q

D, C, S

FDSE

Q

D, C, S, CE

FDSE_1

Q

D, C, S, CE

IBUFG

O

I

KEEPER*

O (bidirectional pin)

LDCP

Q

D, G, CLR, PRE

D latch with gate
enable and asynchronous clear and
preset; clear overrides preset.

LDCP_1

Q

D, G, CLR, PRE

D latch with gate
enable and asynchronous clear and
preset; clear overrides preset.

LDCPE

Q

D, G, GE, CLR,
PRE

D latch with gate
enable and asynchronous clear and
preset; clear overrides preset.

LDCPE_1

Q

D, G, GE, CLR,
PRE

D latch with gate
enable and asynchronous clear and
preset; clear overrides preset.

LDE

Q

D, G, GE

LDE_1

Q

D, G, GE
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Table A-23 Virtex-Specific Primitives
Name

Output

*

Input

Notes

SLR16

Q

A0, A1, A2, A3,
CLK

SLR16_1*

Q

D, A0, A1, A2, A3, Variable length 16CLK
bit (max) shift
register with clock
enable.

SLR16E*

Q

CE, D, A0, A1, A2, Variable length 16A3, CLK
bit (max) shift
register with clock
enable.

SLR16E_1*

Q

CE, D, A0, A1, A2, Variable length 16A3, CLK
bit (max) shift
register with clock
enable.

STARTBUF_VIRTEX

GTSOUT

GSRIN, GTSIN,
CLKIN

STARTUP_VIRTEX

Variable length 16bit (max) shift
register with clock
enable.

GSR, GTS, CLK

An asterisk (*) next to a primitive name indicates that you must instantiate it.

Virtex RAM Primitive Name Suffixes
The following table lists the Virtex RAM primitive names and their
corresponding descriptions.
Table A-24 Virtex-Specific RAM
Name

Output

Input

Notes

RAM16X1D_1*

SPO, DPO

WE, D, WCLK, A0, A1, Negative clock edge
A2, A3, DPRA0, DPRA1, triggered dual ported 16
DPRA2, DPRA3
bit RAM.

RAM16X1S_1*

O

WE, D, WCLK, A0, A1,
A2, A3
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Negative clock edge
triggered 16 bit RAM.
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Table A-24 Virtex-Specific RAM
Name

Output
*

Input

Notes

RAM32X1D_1

O

WE, D, WCLK, A0, A1,
A2, A3, A4

Negative clock edge
triggered dual ported 32
bit RAM.

RAM32X1S_1*

O

WE, D, WCLK, A0, A1,
A2, A3, A4

Negative clock edge
triggered 32 bit RAM.

RAMB4_S1*

DO

WE, RST, EN, EN, CLK,
ADDR

Single port 4096 bit
block RAM.

RAMB4_S1_S1*

DOA, DOB

WE, RSTA, ENA, DIA,
Dual port 4096 bit block
CLKA, ADDRA, WEB, RAM.
RSTB, ENB, DIB, CLKB,
ADDRB

RAMB4_S1_S2*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S1_S4*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S1_S8*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S1_S16*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S2*

DO

WE, RST, EN, EN, CLK,
ADDR

Single port 4096 bit
block RAM.

RAMB4_S4*

DO

WE, RST, EN, EN, CLK,
ADDR

Single port 4096 bit
block RAM.
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Table A-24 Virtex-Specific RAM
Name
RAMB4_S8

*

Output

Input

Notes

DO

WE, RST, EN, EN, CLK,
ADDR

Single port 4096 bit
block RAM.

RAMB4_S16*

DO

WE, RST, EN, EN, CLK,
ADDR

Single port 4096 bit
block RAM.

RAMB4_S2_S2*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S2_S4*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S2_S8*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S2_S16*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S4_S4*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S4_S8*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB
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Table A-24 Virtex-Specific RAM
Name

Output
*

Input

Notes

RAMB4_S4_S16

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S8_S8*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S8_S16*

DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

RAMB4_S16_S16* DOA, DOB

WEA, RSTA, ENA,
Dual port 4096 bit block
ENA, ENA, CLKA,
RAM.
ADDRA, WEB, RSTB,
ENB, ENB, ENB, CLKB,
ADDRB

An asterisk (*) next to a primitive name indicates that you must instantiate it.

Xilinx DesignWare Modules
The following figure illustrates the Xilinx DesignWare (XDW)
module naming conventions. The example shows a comparator
module and contains the four possible components used in naming
the modules. Other module names do not necessarily contain all four
components.
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COMP_LE_UBIN_#
Module Type
Magnitude and Equality
Data Type
Bus Width

X7752
Figure A-1

XDW Module Naming Conventions

The following table gives the XDW naming conventions.
Table A-25 XDW Naming Conventions
Module Type
ADD_SUB:
Adder/Subtracter
COMP: Comparator
INC_DEC:
Incrementer/
Decrementer

Magnitude and
Equality
GE: Greater than or
equal to
GT: Greater than
LE: Less than or
equal to
LT: Less than
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Data Type

Bus Width

TWO_COMP: Twos #: Bus width can be 6, 8,
complement
10, 12, 14, 16, 20, 24, 28,
32, or 48 (and 64 for
UBIN: Unsigned
COMP only).
binary
Use <(#–1):0> to translate bus width to bus
notation. For example, if
Bus A has a bus width of
6, then the correct bus
notation is A<(6–1):0> or
A<5:0>.
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The following table maps XDW modules to X-BLOX Modules and
provides inputs and outputs.
Table A-26 XDW Modules
DesignWare Module
ADD_SUB_TWO_COMP_#

X-BLOX
Module
ADD_SUB

ADD_SUB_UBIN_#
COMP_GE_TWO_COMP_#

Inputs

Outputs

C_IN, ADD_SUB,
FUNC<(#–1):0>
B<(#–1):0>, A<(#–1):0>
C_IN, ADD_SUB,
FUNC<(#–1):0>
B<(#–1):0>, A<(#–1):0>

COMPARE B<(#–1):0>, A<(#–1):0> Z

COMP_GE_UBIN_#

B<(#–1):0>, A<(#–1):0> Z

COMP_GT_TWO_COMP_#

B<(#–1):0>, A<(#–1):0> Z

COMP_GT_UBIN_#

B<(#–1):0>, A<(#–1):0> Z

COMP_LE_TWO_COMP_#

B<(#–1):0>, A<(#–1):0> Z

COMP_LE_UBIN_#

B<(#–1):0>, A<(#–1):0> Z

COMP_LT_TWO_COMP_#

B<(#–1):0>, A<(#–1):0> Z

COMP_LT_UBIN_#

B<(#–1):0>, A<(#–1):0> Z

INC_DEC_TWO_COMP_#

INC_DEC

INC_DEC_UBIN_#

INC_DEC, A<(#–1):0> FUNC<(#–1):0>
INC_DEC, A<(#–1):0> FUNC<(#–1):0>

Post-Configuration Initialization States
The following tables show the initialization states after configuration
for the XC4000 and XC5200 families.
Table A-27 Initialization State After Configuration (XC4000
Family)
Initializes to 0*

Initializes to 1

FDC

ILFFX_M*

OFDTX_U

FDP

ILFFXI_M*

OFDTXI_F

FDCE

ILFLX_F*

OFDT_F

FDPE

ILFLXI_1F*

OFDTXI_S

IFD

ILFLX_M*

OFDT_S

IFDI

ILFLXI_1M*

OFDTXI_U

IFDX

ILFLX_1F*

OFDT_U

IFDI_F

LDPE*

OFDXI

IFDX_F

ILFLX_1M*

OFDX

IFDI_U

LDPE_1*

OFDXI_F

IFDX_U

LD*

OFDX_F

IFDXI

LDP_1

OFDXI_S
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Table A-27 Initialization State After Configuration (XC4000
Family)
Initializes to 0*

Initializes to 1

IFD_F

LDCE*

OFDX_FU

IFDXI_F

OFDI

IFD_U

LDCE_1*

OFDX_S

IFDXI_U

OFDI_F

ILDX_1

LDC_1

OFDX_U

ILDI_1

OFDI_S

ILDX_1F

LD_1

OFD_F

ILDI_1F

OFDI_U

ILDX_1U

OFD

OFD_FU

ILDI_1U

OFDTI

ILD_1

OFDT

OFD_S

ILDXI_1

OFDTI_F

ILD_1F

OFDTX

OFD_U

ILDXI_1F

OFDTI_S

ILD_1U

OFDTX_F

ILDXI_1U

OFDTI_U

ILFFX_F*

OFDTX_S

ILFFXI_F*

OFDTXI

OFDXI_U

An asterisk (*) indicates 4000XE/XL/XV only.
Table A-28 Initialization State After Configuration (XC5200
Family)
Initializes to 0

Initializes to 1

FDC

FDPI

FDCE

FDPEI

FDC_1

FDPI_1

FDCE_1

FDPEI_1

LD
LD_1
LDC
LDCE
LDC_1
LDCE_1
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Appendix B

Targeting Virtex Devices
Generally, you target a Virtex device no differently than the way you
target a non-Virtex device. However, you use Virtex-specific settings,
such as .synopsys_dc.setup options, that only apply to Virtex. This
appendix outlines only the major differences you encounter when
targeting a Virtex device. For topics not covered here, equivalent
instructions for a non-Virtex device apply and those instructions exist
earlier in this manual.
Unless otherwise specified, all references to FPGA Compiler also
apply to Design Compiler.
This appendix contains the following topics.
•

“Following General Guidelines.”

•

“Setting FPGA Compiler to Synthesize a Virtex Design”

•

“Synthesizing a Virtex Design into FPGA Compiler”

•

“Setting VSS Simulation for Virtex”

•

“Setting FPGA Compiler II for Virtex”

•

“Synthesizing a Virtex Design in FPGA Compiler II”

•

“Using Clock Delay Locked Loops with Synopsys”

Following General Guidelines
Use these following general guidelines when targeting Virtex
devices.
Virtex XSI uses an EDIF-based synthesis flow with FPGA Compiler
and FPGA Compiler II.
For I/O cells with a specific type of input delay, and current drive in
the FPGA Compiler flow, instantiate the desired IBUF, OBUF, IFD,
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and other primitives. Refer to the “XSI Library Primitives” Appendix
for the exact I/O library cell name and pin names. For I/O cells in
FPGA Compiler II, you can infer the desired type of input delay, pullup or pull-down, and current drive using the FPGA Compiler II
implementation GUI.
Do not use the Ungroup –all –flatten command when synthesizing a
Virtex design with FPGA Compiler.
A software bug exists in the DesignWare Compiler and the uniquify
command can build incorrect operators in a module uniquified
before the operator expanded to Virtex components. Compile all
modules with operators in them prior to running the uniquify
command. Do not set the Synopsys variable
hdlin_replace_synthetic=true to expand the operators while reading
in the HDL design code. Doing so can result in less-than-optimal
designs because the compiler cannot make appropriate trade-offs.
Compile designs with hierarchy that include a twice-used module
before running the uniquify command. Use the following commands
for such a design, selecting the appropriate level (low, medium, or
high).
current_design alu compile –map_effort \
[low|medium|high]
current_design top uniquify compile –map_effort \
[low|medium|high]

You can use two types of simulation when simulating a Virtex design
with either Verilog or VHDL, RTL simulation and post-NGDbuild
simulation.

Setting FPGA Compiler to Synthesize a Virtex
Design
Use the following procedure to set FPGA Compiler for Virtex design
simulation.
1.

Set your Xilinx and Synopsys software environments.
For instructions about setting up this current release of Xilinx
software, please refer to the A1.5 Install Guide. For instructions
about setting up Synopsys products, refer to the Synopsys installation guide.
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2.

Copy the file $XILINX/synopsys/examples/
template.synopsys_dc.setup_fc into a directory.

3.

Run synlibs to get the correct synthesis libraries into the
.synopsys_dc.setup file. Execute the following command in the
same directory that contains the .synopsys_dc.setup file for
Virtex.
synlibs xfpga_virtex-3>>.synopsys_dc.setup

4.

Check that your system administrator compiled the XDW A1.5
XSI libraries.
By default, these DesignWare libraries are compiled for Synopsys
v1997.01. If using a version of Synopsys newer than v1997.01,
compiler these libraries for the version of Synopsys you use.
Check with your system administrator to determine the version
of Synopsys installed and in use.

5.

Determine if you need to compile the A1.5 XDW libraries for
Virtex and have privileges to write to $XILINX.
If you do not have privileges to write in $XILINX, copy the
contents of $XILINX/synopsys/libraries to a local directory and
then follow steps 2–4, except use the following procedures in the
local copy of $XILINX/synopsys/libraries.
a) Change directories to the $XILINX/synopsys/libraries/dw/
src/virtex area.
b) Inside the previous directory, type the following and press
Enter.
dc_shell –f install_dw.dc
To synthesize the Virtex A1.5 XSI XDW Virtex libraries you
must have a license to compile VHDL with Synopsys. If you
do not have a VHDL license, check the Xilinx WWW site
(www.xilinx.com) for a compiled version of the XSI XDW
Virtex A1.5 XDW libraries.
c)

Compile the XSI XDW A1.5 libraries only once. You need to
recompile only when upgrading to a new version of
Synopsys.
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Synthesizing a Virtex Design into FPGA Compiler
Use the following procedure to synthesize a Virtex design into FPGA
Compiler.
1.

Set up the .synopsys_dc.setup file.

2.

Synthesize the A1.5 XDW libraries.

3.

Create a WORK directory in the same directory that contains the
.synopsys_dc.setup file.

4.

Create the run script, as shown in the following example.
/*Basic Virtex FPGA Compiler Compile script
read –f
read –f
read –f
. . .
read –f
/*
/*
/*
/*
/*
/*
/*
/*
/*
/*

*/

verilog file1.v
verilog file2.v
verilog file3.v
verilog top.v

Set design constraints
Use the following commands if you want
Synopsys to infer I/O. It is recommended
for the Virtex flow that I/O be
instantiated.
set_port_is_pad “*”
set_pad_type -no_clock all_inputs()
set_pad_type -exact BUFGP -clock \
find(port,”CLK”)
insert_pads

*/
*/
*/
*/
*/
*/
*/
*/
*/
*/

compile
/*
/*
/*
/*

Use analysis reports to evaluate quality
of results.
report_area
report_timing

*/
*/
*/
*/

write_script > design.dc
sh dc2ncf -w design.dc
write –hierarchy -format db –o “top.db”
write –hierarchy -format edif –o “top.edif”
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Setting VSS Simulation for Virtex
Use the following procedure to set VSS simulation for Virtex devices.
Note: To compile the simulation libraries, you must have root access
because you modify files in the $XILINX tree. As with the XDW
libraries, you must compile these libraries if using a version of
Synopsys newer than v1997.01. If you need to compile these libraries,
you must have write privileges to the $XILINX area. If you do not,
copy the $XILINX/synopsys/libraries/sim to a local directory.
1.

Change to the $XILINX/synopsys/libraries/sim/src/unisims
directory.

2.

In the previous directory, run the C-shell script analyze.csh.

3.

Change to the $XILINX/synopsys/libraries/sim./src/simprims
directory.

4.

In the previous directory, run the C-shell script analyze.csh.
You need do the previous three steps only once. However, if you
upgrade to a new version of Synopsys, you must recompile these
libraries again.
If simulating in Verilog, ignore the previous three steps.

5.

Copy the file $XILINX/synopsys/examples/
template.synopsys_vss.setup file into a directory where you
perform VSS simulation.

6.

Rename the file template.synopsys_vss.setup to
.synopsys_vss.setup.

7.

Create a WORK directory.
You can now start simulating with VSS.

Setting FPGA Compiler II for Virtex
You can use FPGA Compiler II to synthesize a Virtex design. When
creating an implementation in FPGA Compiler II, select Virtex as a
family/die-pkg-spd grade. For more information on FPGA Compiler
II, refer to the documentation which comes with your FPGA
Compiler II software from Synopsys.
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Synthesizing a Virtex Design in FPGA Compiler II
The design procedure you use to target a Virtex device with FPGA
Compiler II mimics the procedure for targeting a XC3000A/
XC4000X/Spartan device with FPGA Compiler II. For more information about FPGA Compiler II, refer to the documentation which
comes with your FPGA Compiler II software from Synopsys.

Using Clock Delay Locked Loops with Synopsys
You can simulate and implement the clock delay loops DLLs
CLKDLL and CLKDLLHF in HDL code. To use these DLLs for
synthesis, change the following two types of attributes.
•

DUTY_CYCLE_CORRECTION (default is true)

•

CLKDV_DIVDE— (default is 2)

To changes these default values in FPGA Compiler, use the Set
Attribute command. To change the value of
DUTY_CYCLE_CORRECTION and CLKDV_DIVIDE, you must
know the instance name of the instantiated CLKDLL/CLKDLLHF.
For example, if you have instantiated the CLKDLL in your top-level
VHDL file, the VHDL code can appear as the following.
MYDLL: CLKDLL port map(CLKIN=>REFCLK,CLKFB=>signal1,.);

In Verilog, the code can appear as follows.
CLKDLL MYDLL (.CLKIN(REFCLK), .CLKFB(signal1),.);

In both cases, the instance name is CLKDLL. To change the values of
DUTY_CYCLE_CORRECTION and CLKDV_DIVIDE, use the Set
Attribute command in the run script. Use the Set Attribute command
before writing out the EDIF file from FPGA Compiler, as shown in
the following example.
set_attribute “MYDLL” “DUTY_CYCLE_CORRECTION”\
–type string “FALSE”
set_attribute “MYDLL” \
“CLKDV_DIVIDE “ –type string “3.0”

To change the defaults of CLKDLL and CLKDLLHF in FPGA
Express, use the constraints GUI in FPGA Express.
To simulate CLKDLL and CLKDLLHF with Verilog, use the functional simulation model that exists in the UNISIM libraries included
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in the A1.5 software. If you changed the default values of
DUTY_CYCLE_CORRECTION and CLKDV_DIVIDE, specify these
changes in the functional simulation by using a ‘define macro to
override the DUTY_CYCLE_CORRECTION and CLKDV_DIVIDE
parameters.
To simulate CLKDLL and CLKDLLHF with VHDL, use the functional simulation model that exists in the UNISIM libraries included
in the A1.5 XSI software. If you changed the default values of
DUTY_CYCLE_CORRECTIO and CLKDV_DIVIDE, specify these
changes in the functional simulation by using generics when instantiating the CLKDLL/CLKDLLHF.
Note: Generics for DUTY_CYCLE_CORRECTIOIN and CLKDLLHF
do not allow you to change the default values for synthesis. Use the
Set Attribute command to do this, or the GUI of FPGA Express.
The following example shows how to use generics to change the
default values of the CLKDLL for functional VHDL simulation.
MYDLL: CLKDLL generic
map(DUTY_CYCLE_CORRECTION=>FALSE, \
CLKDV_DIVIDE=>3.0) port map(CLKIN=>..);

For more information about CLKDLL and CLKDLLHF, please refer
to the Databook or the Libraries Guide.
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